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Chapter 1

Introduction

1.1 About LimitState:RING

LimitState:RING 4.0 is a rapid analysis tool for masonry arch bridges. The software is designed
to analyse the response of masonry arch bridges (building on the ’limit analysis’ methods originally
pioneered by Heyman 1982), and has numerous features, some of which are unique, including:

• Multi-span and multi-ring arch capabilities

• Multiple load case facility

• Facility to model support movements

• Facility for modelling the presence of arch backing material

• Fully user-definable geometry

• Local material properties can be specified

• Automatic effective bridge width computations

• Automatic identification of the critical failure mode in multi-span bridges, even if this involves
only a single span

• Failure modes involving sliding are identified if critical

• Automatic detection of earth pressures, allowing deep arch and multi-span arch problems in-
volving passive pressures to be analysed without difficulty

• Original version validated by academia and industry (e.g. see Gilbert & Melbourne 1994,
Melbourne & Gilbert 1995 and Melbourne et al. 1997); new features are informed by ongoing
active research.

1.2 Glossary

Masonry arch bridges are very different to the steel and concrete bridges that are often constructed
in their place today. As the terminology used to describe different parts of masonry arch bridges can
appear obscure to the non-specialist, common terms are given in Figure 1.1:
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Figure 1.1: Masonry arch bridge terminology

1.3 LimitState:RING terminology

LimitState:RING 4.0 idealizes a bridge as a series of blocks separated by contacts (where sliding /
crushing / hinging can occur), with the effects of fill modelled by live load dispersal and horizontal
forces exerted by backfill elements. The annotated image displayed in Figure 1.2 highlights the most
important objects the user will encounter when using LimitState:RING 4.0.

Upon solving, LimitState:RING 4.0 determines the critical failure mode, with hinges often forming
as sections of the arch push against backfill elements (principally designed to replicate the effect of
the passive restraint offered by the fill). Finally, the thrust zone at collapse is also shown. This gives
a visual indication of both the position of the line of compressive force and the minimum amount of
material needed to support it.
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Figure 1.2: The main objects encountered in LimitState:RING 4.0

1.4 About LimitState

LimitState specializes in the development of powerful yet easy-to-use software applications that use
unique technology to rapidly identify critical collapse mechanisms and associated margins of safety.
This allows engineers to move beyond simple ‘automated hand calculations’ and predefined mech-
anisms - but without the need to resort to significantly more complex and potentially cumbersome
techniques (e.g. non-linear finite element analysis).

LimitState co-founder Prof. Matthew Gilbert is a Chartered Civil Engineer who has been involved in
masonry arch bridge assessment and research since 1990, developing the first version of RING as a
research tool in the early 1990s.

1.5 Using ‘Help’

The software includes an online help facility, which is largely based on this User Manual. Pressing
F1 at any time will display the help system.

1.6 System requirements

LimitState:RING is designed to ruin on the Windows 10 and 11 operating systems. Other Windows-
based operating systems may be compatible, but are not tested. Support for Mac and Linux operating
systems is available on request, subject to demand.

Recommended minimum system specifications are as follows:

• Intel, AMD or equivalent processor (i3 / Ryzen 3 or better recommended)

c© LimitState Ltd
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• 350Mb+ free hard disk space

• 4Gb+ RAM

• Graphics (onboard or card) capable of running OpenGL 3.2

Note that the use of virtualization platforms, such as VMware or VirtualBox, is not officially sup-
ported.

1.7 Program limits

The program uses a ‘Single Document Interface’, which means that only one bridge project file can
be open in LimitState:RING at a given time. However, several instances of LimitState:RING can be
opened simultaneously if required and each of these may contain a separate bridge project file.

Previous versions of the software (e.g. RING 1.5) imposed limits on the number of rings, blocks etc.
that could be modelled. In LimitState:RING 4.0 problem size is limited only by available computer
power. However, where problem size is likely to detrimentally affect the solve time, LimitState:RING
4.0 introduces a ‘Maximum problem size’ parameter, which can be set to prevent the accidental
triggering of very computationally intensive solves.

1.8 Contact details

1.8.1 Sales

To request information on pricing, a formal quotation, or to purchase the software please contact
LimitState Ltd, at sales@limitstate.com.

1.8.2 Software support

Software support for LimitState:RING is available to all users with valid support and maintenance
contracts. All queries should be directed to support@limitstate.com, including any relevant files or
steps to reproduce an issue, where appropriate.

1.8.3 Website

For the most up-to-date news about LimitState:RING, please visit the LimitState:RING website:
limitstate.com/ring.
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Chapter 2

What’s new

LimitState:RING 4.0 includes a wide range of new features and enhancements. The following sections
introduce some of the main ones, whilst a full list is available on the LimitState website.

2.1 Permissible Limit State (PLS) mode

Evidence suggests that masonry arch bridges are far more susceptible to damage due to the repeated
action of service loads rather than to collapse due to overloading by a single vehicle. The CIRIA C800
guidance document (Gilbert et al. 2022) presents calculations for the Permissible Limit State (PLS)
for masonry arch bridges. The PLS is the point beyond which progressive load-induced degradation
occurs under service loads during the intended life of the bridge. LimitState:RING 4.0 provides the
ability to undertake a PLS analysis directly in the software by including:

• a new PLS analysis mode;

• a partial factor set reserved specifically for PLS analyses; and

• the capability to specify horizontal backfill pressures tailored for PLS analyses.

Find out more about the new PLS analysis capability in Section 19.

2.2 Upgraded loading workflow

A new Scenario Manager replaces the vehicle loading dialog of previous versions, making problem
set-up and solution quicker, easier and far more flexible, including:

Loading scenarios Previous versions of LimitState:RING were set up to work best with a ‘single
scenario’; that is, one load vehicle located either in a static position, or defined to be located
at set spacings across a structure. LimitState:RING 4.0 allows the definition of multiple sce-
narios within the same file, automatically identifying the critical case from these and making
comparisons much easier.
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Automatic analysis Quickly determine the critical loading position of any vehicle using the Auto
load case functionality. With this, the software will intelligently seek out the most onerous
loading positions to analyse, based on the trajectory of the adequacy factor value at that
location. No need to set up a series of individual load cases, or manually search for the vehicle
position that corresponds to the lowest adequacy factor, as the software can do this for you.

Vehicle directions Replacing the Mirror? setting of previous versions, the vehicle Direction param-
eter makes it clear as to the direction of travel of any vehicle in a loading scenario, especially
important for load vehicles with asymmetric axle spacings. Coupled with the addition of a
vehicle direction indicator in the viewer, there’s now no doubt as to which way a vehicle is
facing.

Find out more about automatic bridge analysis in Section 18.3.1.

2.3 ‘Adequacy Factor’ plot

Gain a deeper understanding of how the resistance of a bridge structure changes with different
loading vehicles positioned at different locations with the Adequacy Factor plot. The critical
loading position across all scenarios is highlighted alongside all locations where the adequacy factor
is within 1% of being critical. Easily identify areas of interest in the structure and set the viewer to
display load cases of interest by clicking the corresponding data point in the graph.

Find out more about the Adequacy Factor plot in Section 25.1.

2.4 Improved geometry modelling in the wizard

The New Bridge Wizard includes a range of enhancements over previous versions, making it easier
to faithfully model the bridge geometry:

Offset springing heights Spans can start at different heights at each side of a pier, with full control
over the way in which the offset pier element is constructed.

End abutments End abutments can be included in the model with or without the presence of
backfill behind them.

Pier head blocks Improved geometry creation and checking prevents inside-out blocks and other
malformed object issues.

Interpolated profiles Enhanced interpolation algorithm for closer shape fitting, while maintaining
the shape of spans in existing files.

Oviform spans The requirement for an increasing x value has been removed, allowing the creation
of oviform and other span shapes (e.g. when modelling masonry tunnels).

Find out more in Section 12.1.
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2.5 CAD geometry input

For more complex bridge geometries that fall outside the scope of the New Bridge Wizard, the
ability to create a model from a DXF CAD file has been introduced. Create closer to life models and
understand how geometric intricacies affect structural behaviour.

To find out more about DXF-defined geometries, see Section 15.

2.6 Template files

Use an existing file as the template for a new analysis. Bring across important parameters, such as
partial factors and material properties, and then specify the bridge geometry from scratch.

Template files are particularly useful when assessing a number of structures to the same code of
practice. As an example, we’ve included templates for CS454 / CIRIA C800 with the software.

To find out more about template files in LimitState:RING, see Section 12.2.

2.7 Command line interface

Modify and solve LimitState:RING 4.0 files from the command line. Useful for scoping analyses, or
e.g. assessing a group of existing bridges on a route using a new vehicle.

Commands can be combined in a batch file for large-scale, unattended assessment of bridges.

Find out more in Section 27.1.

2.8 Helpful insights

From problem setup, throughout the analysis and in the output, LimitState:RING 4.0 provides a
wealth of valuable information to enhance the user experience:

Helpful graphics Enhanced reference images to aid understanding of the geometrical inputs.

Diagnostic feedback Pre-solve checks will provide invaluable information on the problem setup,
warn when a setting may not be as intended and prevent a solve from occurring when a setting
is clearly erroneous.

Colour blocks and contacts according to property Quickly acquire an overview of block and
contact material properties by utilizing colour coding based on their magnitudes. Identify
and rectify any discrepancies prior to solving, ensuring the correctness of the problem setup
from the outset.

Adequacy Factor An easy-to-understand indicator of structural safety; in LimitState:RING 4.0 the
adequacy factor is conveniently coloured to provide a quick overview of the analysis outcome.
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Tooltips on plots and charts Post-solve diagrams and the adequacy factor plot will display the
numeric information when hovered over with the mouse cursor. Rapidly interrogate the values
of forces, moments and adequacy factor without having to select individual contacts or load
cases beforehand.

Horizontal and vertical contact forces In addition to the shear and normal forces acting on con-
tacts, the output now provides the horizontal and vertical components too. This makes deter-
mination of e.g. support reactions a much more straightforward process.

Fill and backing arrows In addition to bar elements, fill and backing forces can be represented as
arrows, scaled according to their magnitudes.

Improved report The report output has been upgraded to include more information about the
problem setup and results. It can be saved in ODT file format, making it compatible with e.g.
Microsoft Word.

2.9 User-defined block forces

Specify forces and moments that act on a block outside of that imposed by any live loading. Useful
for situations such as modelling the presence of external props.

Find out more in Section 18.7.

2.10 Shear bond strength

Inter-block shear bond strength (adhesion) can now be modelled, facilitating more in-depth explo-
ration of the behaviour of e.g. multi-ring arch problems.

Find out more in Section 17.1.

2.11 Expanded vehicle database

The built-in database of highway and rail vehicles has been expanded for LimitState:RING 4.0 and
now includes CS454 and CS458 load vehicles, as well as a number of additional sets of vehicles from
codes such as BD21 and Indian Railways’ guidance.

Find out more about the standard vehicles included with LimitState:RING 4.0 in Appendix D.

2.12 Enhanced user interface

The styling of the user interface has been enhanced for LimitState:RING 4.0. Toolbar buttons
are now colour-coded and rendering of bridges displayed in the viewer has been improved. Other
improvements to the user experience, such as the ability to cut and paste span profile and surface
fill level data to and from external applications (e.g. Microsoft Excel), have also been implemented.

c© LimitState Ltd



Chapter 3

Getting started

3.1 Installation & licensing

Further details on installation and licensing are provided in the separate Installation manual distributed
with the software and available from the LimitState website.

3.2 Starting LimitState:RING

To start LimitState:RING 4.0 on a Windows 10 or 11 system:

1. Open the Start menu (left-click the Windows icon on the taskbar, or press the Windows button
on your keyboard).

2. If the LimitState:RING 4.0 icon appears in the Pinned list of apps, click this to start the
software.

3. If the LimitState:RING 4.0 icon does not appear in the Pinned list of apps, type ‘ring 4.0’
in the search field and LimitState:RING 4.0 should appear in the Best Match list - click the
entry to start the software.

A few seconds after starting LimitState:RING 4.0 the Startup dialog shown in Figure 3.1 should
appear:
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Figure 3.1: LimitState:RING welcome screen

You then have three options:

1. Create a new bridge project - select this option and click OK to bring up the New Project
dialog.

2. Open an existing bridge project - select this option and click OK to open a previously saved
project or example.

3. Open a recently accessed bridge project - select this option, choose a file from the list and
click OK to return to a recent project.
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Quickstart tutorial

This Quickstart tutorial is designed to help the user become familiar with the key functions and
processes in LimitState:RING 4.0. It is a step-by-step guide to defining a problem, solving and
interpreting the output. Steps for the user to undertake are presented in blue, as follows:

� This is an instruction to follow

The easiest way to get started using LimitState:RING 4.0 is to select Create a new bridge project
and click OK. The New Project dialog will then be displayed (Figure 4.1):

There are three options:

• Wizard: Define an entirely new model using the New Bridge Wizard.

• Template: Define a new model using material, partial factor and other settings obtained from
a template file.

• DXF: Define a new model using geometry imported from a DXF file.

� Select the Wizard option to bring up the Project Details tab (Figure 4.2). Alternatively, click

the New icon in the File toolbar, .

Figure 4.1: New Project dialog
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Figure 4.2: Wizard - General Problem Settings

4.1 Introduction - Using the ‘New Bridge Wizard’

The New Bridge Wizard is designed to help the user quickly prepare the model of their structure
and prescribe the analysis settings. It guides the user through the process of defining the bridge:

• Geometry (see Section 4.3)

• Materials (see Section 4.5)

• Partial safety factors (see Section 4.4)

• Applied loading (see Section 4.6)

Further explanation of all editable parameters is given elsewhere within this document. All dialog
pages displayed as part of the wizard are also accessible from the Tools menu (Section 23.3.5).

It should be noted that, at any point during the Wizard process, it is possible to click Finish. In
doing this, LimitState:RING 4.0 will automatically fill in any information that has not been explicitly
supplied by assuming default values and using information already provided up to that point.

In most cases, the Wizard process involves entering information in a sequential manner, clicking
Next> after each step. However, it is possible to move backwards through the various steps by
using the <Back button. The left-hand pane of the Wizard dialog serves as a reference point, with
the icon for the current section being highlighted in blue.
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4.2 Step 1 - General project settings

Many of the fields in the Project Settings tab are optional. However, those at the top of the dialog
define the fundamental type of model you will build, as well as specifying several other important
parameters.

Firstly, you should specify the Bridge Type to be analysed. This can be either a Highway or Railway
(underline) bridge. The selection here will determine the types of vehicle that are available to load
the bridge, as well as how that loading is treated (i.e. whether axle loads are distributed between
sleepers, or applied directly to a road surface). You can switch from one type of bridge type to the
other at any point in the modelling process.

� Select ‘Highway’ as the type of bridge to analyse.

Secondly, an effective bridge width should be provided. This is the transverse width of masonry
arch that resists the applied loading. It is an important parameter to get correct, as the calculated
adequacy factor is directly proportional to this value. The value of this parameter will be affected
by the depth of fill and load distribution through the fill, as well as by physical aspects of the bridge
that may curtail the spread of load (e.g. longitudinal cracks in the barrel or the proximity of a vehicle
to the parapets). More information on how best to determine the effective bridge width is provided
in Loading Chapter, Section 8).

LimitState:RING 4.0 allows the user to provide a fixed (Specified) bridge width, or let the software
determine an Auto-computed value based on the fill depth and load spread parameters (which can
be accessed by clicking the More... button).

� Select the ‘Auto-computed’ bridge width option.

� Click the More... button and examine how the load is spread transversely through the different
bridge parts.

� Click OK to accept the default values.

The remaining fields in the General tab are optional, but are useful for reference and will also be
used in the Report output, once a solution has been achieved.

� Click Next> to move on to the Geometry specification.

4.3 Step 2 - Geometry

The next stage in the Wizard process is to model the various aspects of the bridge (Figure 4.3). This
includes data about the abutments, spans, piers and fill. More information is provided in Section 15.

The tabs along the top of the Geometry Dialog move from left to right across the bridge, starting
with the Left Abutment, moving on to Span 1, through any additional Piers and spans, before
ending on the Right Abutment and finally the Fill Profile.

The option to include Backing over abutments and piers is available in the corresponding tabs.
Backing is treated as a special implementation of the backfill. It is assumed to have the same unit
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Figure 4.3: Wizard - bridge geometry

weight as the backfill, but possess a much higher (5MPa by default) lateral resistance. In this way,
arches can be ‘linked’ together via the backing, with transfer of compressive forces from one span
to an adjacent span. The backing level is compared to the mid-height positions of blocks on either
side. Any blocks with a mid-height position at or below the defined level will be assigned a ‘backing’
element in preference to a ‘backfill’ element.

� For the Left Abutment, specify a backing height of 1000mm.

In most situations, the end (left and right) abutments can be considered as being supported at the
springing point of the adjacent arch and, in such cases, it is not necessary to model anything below
this level. However, on occasion, it may be necessary to include these additional parts of the bridge
geometry (e.g. in the case of freestanding end piers, or in the presence of a retaining wall with
materials or measurements that may be of concern). Ticking the Explicitly Model (see Section
14.2.2) check box will allow the user to provide such details. Further information on these options
is provided in the modelling end abutments Chapter, Section 7.5).

� Click Next> to move on to the Span profile specification. (Figure 4.3)

There are many different options available when defining the geometry of a Span. However, the
basic options are:

• if the span in question consists of one or multiple arch rings (Type);

• the general shape of the arch profile, including the span and rise (Profile);

• the number of blocks in each arch ring, along with their associated thicknesses (Details table).

Here, we will assume that the arch barrels of the bridge consist of a single, 400mm thickness of
masonry (either stone blocks or well bonded brickwork). The first span profile takes the shape of a
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Figure 4.4: Wizard - Pier Geometry

segment of a circle (Segmental), with 6500mm span and 2500mm rise at the intrados face of the
crown.

� In the Details group, set the Span to 6500mm and the Midspan rise to 2500mm.

� Set the Ring thickness to 400mm.

The default Number of units for all arch rings is 40. This value has been found to strike a good
balance between accuracy and computational efficiency. It is generally advised that this number is
used unless there is a good reason to modify it.

On the Span tab, there is also the option to insert additional spans into the model. If you wish to
do this during the Wizard process, simply check the Insert Right or Insert Left button to insert a
new span and intermediate pier.

� Familiarize yourself with the default span profile specification.

� Click Insert Right to add a duplicate span to the right of the current one.

Several new tabs will now be created; one for the new span and one for the intermediate pier. The
Pier tab will be automatically selected (Figure 4.4).

The Pier tab includes a number of options. First in the list is the option to include an offset between
the springing heights of the two spans that meet at the selected pier.

� Select the Right side higher option for the Springing Offset.

A number of additional fields will then be displayed.

� In the Pier Geometry group, set the Height of the pier to 3000mm and the thickness at both
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ends to 1200mm

� Set the Height of offset to 1500mm and the number of blocks to 5

� Set the Backing height to 1500mm

� Click Next> to move on to Span 2

On the second Span tab, you will notice that the properties of the first span have been duplicated.
This is useful in situations where the arch geometry is repeated a number of times across the bridge.
However, the information can also be modified where necessary.

In this example, the profile of the second span of the bridge is constructed from multiple segments
of circles. It has a 5000mm span, 1750mm rise at the crown and 1400mm rise at the quarterspans:

� In the Profile group, select Used defined (multi-segment) from the dropdown. A table will
appear in the Details group

� Enter the span details, as given in Table 4.1

x (mm) y (mm)
0 0

1250 1400

2500 1750

3750 1400

5000 0

Table 4.1: Span 2 profile coordinates

A new blank row is added to the bottom of the profile table whenever the previous last row is edited.
This allows the table to remain responsive to changes in the number of profile data points. If a row
requires deleting from the table, simply right-click a cell in that row and select Delete row from
the context menu. Profile data can also be copied and pasted from/to a spreadsheet program (e.g.
Excel).

Should an entire span require deleting, simply select the correct tab of the Wizard and click the
Delete Span button. Where appropriate, a dialog will appear to query which of the two supporting
piers should also be removed. Note that the Fill Profile may subsequently require alteration to align
properly with the underlying structure.

� Click Next> to move on to Right Abutment

� For the Right Abutment, specify a backing height of 1000mm

� Click Next> to move on to Fill Profile

The surface profile of the fill is defined in terms of the distance from the left springing of the first
span. By default, a flat (horizontal) surface is assumed, with a depth of 500mm. As part of the first
pass through the Wizard dialogs, the depth of fill will be adjusted to ensure that the surface level lies
above the extrados crown level of the highest span (e.g. here, a height of 4200mm to the bottom of
the 500mm deep surface layer will be set).
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Figure 4.5: Wizard - Fill Profile

Any number of data points and surface layer depth readings may be provided (Figure 4.5). At the
ends of the bridge, the current slope of the surface will be maintained.

� In row 2 of the Surface profile table, add a second data point at x = 10,000; y = 4300. Set the
surface depth to 500mm.

� Click Next> to move on to the Partial Factors

Note:

1. It is not possible to delete the last remaining bridge span or the abutments.

2. For more detailed information on editing the geometry of the bridge, see Section 15.

4.4 Step 3 - Partial factors

The Partial Factors tab provides a number of fields corresponding to partial safety factors (load
multipliers, or strength divisors) at the Ultimate Limit State (ULS) and Permissible Limit State
(PLS).

Where the values in the fields are not unity (1.0) the field is highlighted in yellow to indicate that
these can have an effect on the analysis.

By default, the ULS Axle load factor (γf,l) is set to 1.5 and the PLS Masonry strength factors
(γm,ms and γm,ma) are set to 2.0 (see Figure 4.6):
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Figure 4.6: Wizard - Partial Factors

Here we will set up the problem to solve a ULS analysis with (UK) CS454 partial safety factors (i.e.
a factor of 1.8 applied to axles and an additional factor of 1.8 applied to the heaviest axle in the
load vehicle, to account for impact.

� Set the ULS Axle load factor to 1.8

� Set the ULS Dynamic / impact factor to 1.8

� Click Next> to move on to the Materials

Notes:

1. The corresponding axle(s) also need to be set properly for impact safety factors to be applied.

2. For more detailed information on editing the Partial Factors, see Section 16.

4.5 Step 4 - Materials

The Materials section allows the Masonry, Backfill and Surface Fill (or Track / Ballast) prop-
erties to be set. To enable a solution to be obtained in cases where some of this information is not
known, default material properties are provided that are realistic and likely to lead to credible results.

On the Masonry tab (Figure 4.7), by using the Specify properties for drop-down menu, it is
possible to specify the following:

1. The same properties for all the masonry in the bridge (All Masonry).
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Figure 4.7: Wizard - material properties

2. Different sets of properties for the spans, skewbacks and piers / abutments (Spans — Piers
and Abutments — Skewbacks and Offsets).

3. Different properties for each span, pier and abutment in the bridge (All bridge parts).

In the majority of cases, the All Masonry option is selected, with any localized modifications being
made manually via the Property Editor, once the model has been created.

� Set the Unit Weight to 19.5

� Set the Compressive strength to 3.4

Note that the compressive strength of the masonry is taken as the combined strength of both the
blocks and (if present) the mortar.

� Click Next> to move on to the Backfill tab

Basic properties for both the backfill soil and backing material (if present) are presented at the top
of the Backfill tab, including:

1. Soil unit weight

2. Soil angle of friction

3. Soil cohesion

4. Backing compressive strength (zero tensile strength is assumed)

� Set the Angle of friction to 34.5
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Checking the Advanced... box will bring up a further set of parameters relating to advanced soil
and soil/structure interaction properties, including:

• Live load dispersion through the fill

• Soil-arch interface properties

• Active and passive pressures in the spandrel zones

� Check the Advanced... box and inspect (but not change) the available parameters

� Click Next> to move on to the Surface Fill tab

The Surface Fill tab will be shown when the Bridge Type is set to Highway. For railway under-
bridges, this tab is replaced by one displaying the various properties of the ballast and track.

� Click Next> to move on to the Loads section.

Note:

1. For more detailed information on editing the backfill properties, see Section 17.2.

2. For more detailed information on editing the bridge materials, see Section 17.

4.6 Step 5 - Load vehicles

Load vehicles for a problem are specified in LimitState:RING in the following way (see Figure 4.8):

1. Add vehicles into the project using the Vehicle Database.

2. Select project vehicles to use in individual scenarios using the Scenario Manager.

3. Modify the scenarios such that the load position(s), direction of travel and axles subject to
dynamic (impact) factors are as needed.

� Open the Vehicle Database...

� In the Library Vehicles column, expand CS454 - Single Axle and select Max. weight single axle
vehicle (CS454)

� Click the [>] button to move the selected vehicle into the Project Vehicles table

� Repeat the above process to add the [M] 18t Vehicle (CS454) vehicle from CS454 - Appendix
B

Note:

1. Information about the Project Vehicles, when selected, is provided in the Vehicle Details
table.
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Figure 4.8: Wizard - Scenario Manager and Vehicle Database

2. Vehicles included with the installation of LimitState:RING can’t be edited, but copies can be
made and these are editable.

3. New vehicles can be defined and added to the Vehicle Database in a number of ways (see
Section 18.1 for more information)

� Click OK to return to the Scenario Manager

Vehicles have now been added to the project, but must be added to scenarios before an analysis can
take place. Note that the LimitState:RING Default 100kN Single Axle vehicle is already present in
the project. Here we will replace it with the CS454 vehicles.

� Click on the Vehicle dropdown and select Max. weight single axle vehicle (CS454).

� In the Dynamic Axles column, click the [...] button to bring up the Dynamic Axles dialog.

� Check Axle 1 to specify that this axle will be subject to the 1.8 partial safety factor for dynamic
/ impact axles (as well as the blanket 1.8 factor for all axles).

� Click OK.

� Ensure that the Type is set to Auto and the Direction is Left to right.

� Click OK.

The first scenario has now been set up.
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Figure 4.9: Wizard - finished model

� Click on the New... tab to create a second scenario.

� Click on the Vehicle dropdown and select [M] 18t Vehicle (CS454).

� In the Dynamic Axles column, click the [...] button to bring up the Dynamic Axles dialog.

� Check Axle 2 to specify that this, the most heavily loaded axle, will be subject to the 1.8 partial
safety factor for dynamic / impact axles.

� Click OK.

� Ensure that the Type is set to Auto and the Direction is Left to right.

� Click OK.

Both scenarios have now been set up. In each case, the vehicle will move from left to right across
the bridge and the loading positions will be automatically determined in order to determine the worst
case (lowest Adequacy Factor).

� Click Finish to display the completed model in the Viewer Window (Figure 4.9)

Using the Vehicle Database (see Section 18.1), specify the vehicles to be used in the current project
as shown in Figure 4.8:

Note: for more detailed information on editing the bridge loading, see Section 18.
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Figure 4.10: Block and Contact Colouring icons in the show toolbar

4.7 Step 6 - Pre-solve

The model is now set up. However, before solving, it is prudent to undertake a number of final
pre-solve checks, including:

• a visual check on the model geometry;

• a visual check on material properties; and

• a Diagnostics check for unseen issues.

� Examine the geometry of the model as presented in the Viewer, to ensure that it looks credible.

LimitState:RING models are often complex, containing many blocks and contacts. As the software is
designed to make localized modifications easy to achieve, a final check of material properties, prior to
solving, is recommended. This can be done through the Contact Colouring and Block Colouring
icons, as highlighted in Figure 4.10.

Selecting any of the non-Default options from the two Material Colouring dropdown icons will
cause the corresponding objects to be coloured according to the magnitude of the selected property.
If all the objects have the same value, they will be displayed in the same colour (blue). If the objects
have different values, the colour will range between blue (maximum) and red (minimum); helping to
easily differentiate objects of differing strength or weight.

� Examine the material properties of the Blocks and Contacts using the Colouring icons.

� Set the Colouring icons back to their Default states.

There are many settings and situations that may affect the outcome of an analysis. The Diagnostics
are designed to assist the user in ensuring that they understand what is being analysed and help
mitigate any issues that may lead to unexpected results. A Diagnostics check will run a set of tests
to determine setup information about the model and report useful findings as a set of categorized
messages. There are three levels of message:

1. Information - Useful details about the type of analysis being undertaken and settings (e.g.
partial safety factors being applied).

2. Warning - Details of problem specifics that could be unintentional or lead to unexpected
results, but that are not severe enough to prevent a solve from continuing.

3. Error - Details of issues with the problem setup that would lead to severe issues if a solve were
allowed to progress.
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By default, a Diagnostic check will be undertaken automatically before any solve. However, again
by default, only Warnings and Errors will be displayed. If everything is OK, no dialog will appear
on solve. The Diagnostics can, though, be accessed manually through the Analysis menu.

� Open the Analysis menu and select Diagnostics...

� Observe the informative messages that are displayed regarding the analysis type and partial safety
factors.

� Click OK to return to the main window.

4.8 Step 7 - Solve

The problem is now at a stage where it can be solved. Solving is triggered by pressing the Solve

button or via the F5 key on your keyboard.

There are three types of analysis that can be undertaken:

• ULS - Ultimate Limit State analysis

• PLS - Permissible Limit State analysis

• Move Support(s) - Move one or more supports

� Ensure that a ULS analysis is selected and click Solve.

The problem will now be analysed. The entire process should take no more than 30 seconds (machine
dependent). You will notice a number of events occurring on screen:

• Steps to set up the loading (Auto Move) and problem (Pre-Solve)

• Tabulated output for the solutions to different scenarios and load positions in the Output
window

• A corresponding plot of Adequacy Factor vs Load Position for both scenarios

The Adequacy Factor is the value by which the applied loading must be multiplied in order to cause
a mechanism (collapse state) in the structure. After solving, the critical case (that corresponds to
the lowest value of Adequacy Factor over all the cases examined) is displayed in the Viewer (Figure
4.11):

In this case, the Adequacy Factor is above 1.0 and the result is displayed in green. This indicates
that the (factored) loads in this model can be resisted by the structure. Where the value of the
Adequacy Factor is below 1.0, the loads in the model can’t be resisted by the structure and the
result is displayed in red.

Note: for more detailed information on performing an analysis, refer to Section 24.
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Figure 4.11: Wizard - solved problem

4.9 Step 8 - Post-solve

Following an analysis, a range of useful information and functionality becomes available, including:

• Chart - An interactive chart of Adequacy Factor vs Load Position (for problems involving
multiple load positions).

• Force diagrams - Interactive normal, shear and bending moments at the contacts.

• Property Editor data - Information on individual contact, block and fill element forces.

• Report output - A comprehensive analysis report that can be saved in a number of formats.

4.9.1 Chart

� Hover the mouse cursor over the data points of the chart to see that the position and associated
Adequacy Factor are displayed as a tooltip.

� Click one of the data points. The model in the Viewer Window will move to the associated
position (Figure 4.12).

4.9.2 Force diagrams

� Click the Show / Hide Normal Force Diagram icon .

� Hover the mouse pointer over the diagram. Notice that a tooltip displays the normal force values
for the contacts at either end of the section (Figure 4.13).
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Figure 4.12: Clicking a data point in the chart will switch the viewer to that solution

� Click the Show / Hide Normal Force Diagram once more, to toggle off the display of the
diagram.

For more on the force diagrams (see Section 25.2.1).

4.9.3 ‘Property Editor’ data

� Use the mouse to select the lowest contact on the pier (between the green support block and the

bottom pier block; you may need to zoom in to the viewer using the Zoom icons ( ), or the mouse
wheel).

� Look to the Property Editor and expand the Output section.

� Examine the various Properties and Values. Note that the forces on contacts are available as
Horizontal and Vertical values (Figure 4.14).

4.9.4 Report output

Analysis information can also be output as a comprehensive report, including all the problem details,
input data, critical failure mechanism, adequacy factor chart and object forces. The report can be
saved in a number of formats for subsequent viewing (PDF) or editing in word processing applications,
such as Microsoft Word (ODT).

� On the Analysis menu (see Section 23.3.6) click Report...

� Examine the information included in the report.
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Figure 4.13: Clicking a data point in the chart will switch the viewer to that solution

Figure 4.14: Selecting objects will display their associated attributes and output data in the Property
Editor
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Figure 4.15: Report output from the solved problem
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� Save the report as a PDF.

Note: for more detailed information on outputting results, see Section 26.

4.10 Modifying properties with the ‘Property Editor’

The Property Editor allows viewing and, in many cases, permits modification of the properties of
any object within the problem. Try the following:

� Unlock the project by clicking on the padlock icon .

� Click on a block (press and hold the CTRL key to select several blocks). Selected items will
change colour to bright pink.

� Navigate to the Property Editor and use the drop-down menu.

� The properties of the selected blocks will now be shown - try changing their unit weight.

The bridge will reset so that a new analysis can take place that will account for any changes that
have been made.

� Click the Solve button and see the change in adequacy factor.

Note: for more detailed information on the Property Editor, see Chapter 22.
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Chapter 5

Theoretical basis of LimitState:RING

5.1 Background

Masonry arch bridges are statically indeterminate compression structures that resist external applied
loads primarily as a result of the thickness of the masonry and their inherent self-weight. They
tend to be resilient to small support movements, with these typically transforming a structure into
a statically determinate form. Cracks that might accompany support movements are therefore not
normally of great concern, making the notion of crack widths or other conventional serviceability
criteria not applicable. Consequently, engineers are generally primarily interested in guarding against
the ULS (i.e. structural collapse) condition. This typically occurs when a sufficient number of hinges
or sliding planes are present between blocks to create a collapse mechanism.
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5.2 Analysis methods

LimitState:RING 4.0 idealizes a masonry arch bridge structure as an assemblage of rigid blocks and
uses computational limit analysis methods (also known as ‘plastic’ or ‘mechanism’ methods) to:

1. analyse the Ultimate Limit State, determining the amount of live load that can be applied
before structural collapse;

2. permit investigation of the mode of response when supports undergo small movements.

Limit analysis techniques were originally developed for steel components and structures, but it has
since been shown that these can be applied to masonry gravity structures, such as piers and arches
(Heyman 1982). To help understand why limit analysis theory is applicable, compare and contrast
the response of a steel column with uniform plastic cross-section and a weakly mortared masonry
pier, both subject to a horizontal load F , as shown in Figure 5.1.

Figure 5.1: Laterally loaded (a) steel column; (b) masonry pier; and (c) idealized response curves

It can be deduced that:

• Whilst the tensile and compressive strength of the steel column endow it with a finite plastic
moment of resistance, Mp, the absence of tensile strength means that the masonry pier does
not possess a comparable moment capacity derived from material strength.

• However, the thickness and self-weight of the pier mean that there is some resistance against
overturning and the masonry pier could conceptually be considered as possessing a moment
capacity, albeit one that varies with height (moment capacity equal in magnitude to the normal
force at a given cross-section multiplied by half the pier thickness).

• Furthermore, provided pier displacements do not become large, the resistance of the masonry
pier against overturning at a given cross-section will remain broadly constant.

• Hence, the response of the pier can be considered ‘ductile’, an important requirement in order
for limit analysis theory to be applicable.
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As already indicated, in masonry structures the moment of resistance effectively varies continuously,
and consequentially this can make conventional bending moment diagrams difficult to interpret. It is
normally more useful to plot the eccentricity of the compressive force, or thrust, at each cross-section
(where eccentricity = moment / thrust). Figure 5.2 shows the resulting lines of thrust at collapse
for two different configurations of masonry blocks and loading types:

Figure 5.2: Thrust line at collapse: (a) masonry pier; (b) masonry arch

In Figure 5.2 it can be seen that the lines of thrust lie entirely within the masonry, and also that
hinges form at locations where the lines of thrust touch the exterior faces of the blocks. Formation
of a sufficient number of hinges (and / or planes of sliding) leads to collapse.

In the case of the masonry pier shown in Figure 5.2(a), the structure is statically determinate and
statics alone may be used to uniquely determine the position of the thrust line, both prior to, and at,
ultimate failure. In contrast, the masonry arch shown in Figure 5.2(b) is statically indeterminate and
there are many possible positions of the thrust line prior to failure. Therefore, the actual position
can only be uniquely determined at the point of ultimate failure.

In addition to basic equilibrium considerations, in the context of masonry gravity structures, the
following conditions may be used to test for ultimate collapse (assuming both hinging1 and sliding2

failures at masonry joints are considered possible):

1. The yield condition, which may be deemed to be satisfied providing the line of thrust both lies
entirely within the masonry and does not cross any joint at a subtended angle (θ) of less than
tan−1(µ), where µ is the coefficient of friction.

2. The mechanism condition, which may be deemed to be satisfied providing the line of thrust
either touches exterior faces of the masonry blocks and/or crosses sufficient joints at an angle
(θ) of tan−1(µ) to create the releases required to transform the structure into a mechanism.

Thus, if a line of thrust satisfies the equilibrium and yield conditions, then the true plastic collapse
load cannot be less than the applied load – i.e. it is a lower bound.

1Initially assuming that the masonry possesses infinite compressive strength, the line of thrust can be transmitted
through a hinge point lying on an exterior face of the arch.

2 Initially assuming that sliding failures follow a ‘sawtooth friction’ model (i.e. obey an associative flow rule, where
sliding is accompanied by dilatancy).
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Similarly, if a line of thrust satisfies the equilibrium and mechanism conditions, then the plastic
collapse load cannot be higher than the applied load – i.e. it is an upper bound.

It is possible to perform limit analysis by hand. For example, an upper bound hand analysis could be
carried out by:

1. choosing a likely mechanism of collapse;

2. using equilibrium (or a work method) to calculate the collapse load;

3. trying other likely collapse mechanisms until the critical one is found.

However, even in the case of a single-span, single-ring arch, the curved geometry makes such a hand-
based procedure extremely laborious and liable to human error. LimitState:RING 4.0 effectively
automates this process. However, rather than adopting a trial and error procedure to find the
mechanism associated with the absolute minimum collapse load, LimitState:RING 4.0 uses rigorous
mathematical optimization techniques to quickly and accurately determine the correct solution (refer
to Appendix A.1) for details of the mathematical problem formulation).

Furthermore, whilst the above discussion has implied that masonry possesses infinite compressive
strength, this is clearly not the case in reality. In fact, the presence of finite strength masonry means
that the line of thrust mentioned previously is better thought of as a zone of thrust, which should
have sufficient thickness at any point to carry the compressive force, with the required thickness
depending on the crushing strength of the masonry. Clearly, this consideration would add extra
complexity to an already tedious hand calculation. However, if a finite masonry crushing strength
is specified by the user then this thickness is automatically computed by LimitState:RING 4.0. It
is assumed that the thrust is carried by an area of material under a uniform level of stress (i.e.
assuming a rectangular stress block, in accordance with a rigid-plastic idealization of the masonry
crushing response).
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5.3 Output

5.3.1 Identification of the ‘Adequacy Factor’

Although, for sake of simplicity, the previous section considered a case where a collapse load (e.g.
Fp) was computed, it is generally more useful to compute the factor that would, when applied
to some specified pattern of live loads, lead to collapse. This factor (or ‘multiplier’) is commonly
termed the ‘Adequacy Factor’ and its determination for a given bridge is the principal goal of a
normal LimitState:RING 4.0 analysis. When appropriate, partial factors are included in the model,
this adequacy factor must be greater than 1.0 for a safe structure3.

For example, if a 1kN single axle load is specified and LimitState:RING indicates a computed adequacy
factor of, for example, 154, this means that the load that would cause collapse is 154kN. Alternatively,
if a 100kN single axle load was specified, the adequacy factor computed would be 1.54 (1.54×100
= 154kN).

When the applied load comprises a series of axle loads, the adequacy factor is the multiplier, which,
when applied to all axle loads, simultaneously leads to collapse. For example, if a 1400kN rail
vehicle comprises four 200kN axles and four 150kN axles and LimitState:RING indicates a computed
adequacy factor of 3, this means that the loading at failure comprises four 600kN axles and four
450kN axles (3×200 = 600kN; 3×150 = 450kN).

Full details of the mathematical formulation are provided in Appendix A.1.

5.3.2 Bridge behaviour when subjected to support movements

Although the usual (‘standard analysis’ mode) goal of a LimitState:RING 4.0 analysis is to identify the
adequacy factor, LimitState:RING 4.0 can also be used to model the effects of support movements.
Movement of a support will lead to the formation of hinges and/or sliding failures in the same way
as when excessive loading is applied by a highway or railway vehicle.

When in ‘support movement analysis’ mode, vehicle loads (if present) can be pre-factored by the
user and the critical arrangement of hinges and/or sliding failure planes are identified by finding the
energy associated with moving the supports. The line / zone of thrust is also identified. Figure 5.3
shows the result of a support movement analysis. Full details of the mathematical formulation are
provided in Appendix A.2.

3The adequacy factor may need to be commensurately greater than 1.0 for a safe structure if dynamic and/or other
factors have still to be applied following completion of a LimitState:RING analysis.
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Figure 5.3: Modelling the effects of support movement at the base of a pier
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5.4 Range of applicability

5.4.1 Span length

When the adequacy factor is sought, LimitState:RING 4.0 is most suited to the analysis of single and
multi-span masonry arch bridges with short to medium-span lengths, where foreseeable live loadings
are typically non-negligible in comparison to structural self-weight.

For spans longer than 20 to 30m, foreseeable live loadings are often essentially negligible and other
considerations become more important, such as long-term masonry creep effects (due to persistent
moderately high stresses). Additionally, in the case of very long-span bridges, the presence of high
compressive stresses may give rise to non-negligible, second-order deformations, making the adequacy
factors computed by LimitState:RING 4.0 potentially non-conservative.

5.4.2 Block shape / rubble arches

LimitState:RING 4.0 provides a realistic model of bridges comprising single or multi-ring arch barrels
constructed using regular stone blockwork or brickwork. Since in LimitState:RING 4.0 the constituent
blocks are assumed to be rectangular by default, the software provides a less realistic model of random
rubble stone masonry arches. Nevertheless, given that it is unfeasible to model the actual layout
of stones in a random rubble arch, the software may be applied to such arches provided suitably
conservative smeared properties for the masonry are adopted.

5.4.3 Stress-related failures

In common with other limit analysis (or ‘mechanism’) programs, LimitState:RING 4.0 may not
accurately predict the ultimate strength of a bridge if either of the following apply:

1. The bridge comprises a long (e.g. > 20 - 30m) and/or flat arch (e.g. span/rise > ≈6, or the
arch contains very flat sections, for example in the case of an elliptical arch) and it can be
expected that elastic deformations prior to collapse will significantly change the arch geometry.

2. A brittle response of some part of the structure may be expected to prevent the formation
of a ductile collapse mechanism (e.g. abrupt failure of the bond between rings; brittle hinge
formation).

However, even in these cases LimitState:RING 4.0 can provide an invaluable upper bound estimate of
the likely strength of the bridge, which can be used as a benchmark for alternative analysis methods.
Such alternative methods may comprise: in the case of (i) a geometrically non-linear elastic analysis;
in the case of (ii) a non-linear elastic analysis incorporating a masonry material model respecting
fracture mechanics principles (e.g. using Hillerborg’s cohesive crack theory, Hillerborg 1976).

Alternatively if in the case of (ii) the brittle response stems from shear failure at masonry joints, it
may alternatively be assumed that the initial bond strength at these joints is zero, and that only
compressive and frictional forces may be transmitted. In this case, LimitState:RING 4.0 may be used
and can normally be expected to provide lower bound (conservative) results.
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Unfortunately the decision as to when cases (i) and (ii) might apply is complicated by the fact that
both are dependent on stress levels. If stresses are very low in comparison to the elastic modulus
and/or bond strength of the masonry, then brittle fracture of the bond between rings, for example,
is unlikely to be an important issue. Since it can be shown that stresses increase with the size of
the structure being considered 4, this implies that brittle fracture of the bond between rings may not
be of great concern in the case of very short-span bridges. Readers are referred to Section 7.8.2 for
further discussion on modelling multi-ring arch bridges.

5.4.4 Fill depth

Additionally, since LimitState:RING 4.0 has been calibrated in situations when fill depths are relatively
small in comparison to the arch span, for bridges with relatively small fill depths at the crown (or
with no fill) LimitState:RING 4.0 can be expected to provide reasonable results. Conversely, when
the fill depth at the crown is large (e.g. > span/2) results from the program should be treated as
being very approximate. In such cases the predicted load-carrying capacity may be in excess of the
bearing capacity of the arch fill material (i.e. is unattainable in practice).

5.4.5 3D effects

In general, spandrel walls at the edges of a bridge can stiffen the arch prior to failure and, depending
on their end restraint conditions, may also enhance the ultimate limit strength. Studies of the
influence of spandrel walls on the carrying capacity of full-scale single and multi-span laboratory
bridges are detailed elsewhere (Melbourne & Gilbert 1995 and Melbourne et al. 1997).

However, if a bridge is wide in comparison to its span then the effects of the spandrel walls on the
central section of the bridge may be quite minimal. Furthermore, a common defect observed in
masonry bridges is detachment of the spandrel walls (this is evident by the presence of longitudinal
cracks running close to the edges of the bridge). For these reasons spandrel walls are not modelled
in LimitState:RING 4.0.

Since the software idealizes the arch in two-dimensions, it is most suited for assessing masonry arch
bridges that span squarely between abutments; readers are referred to Section 7.3 for further advice
on modelling skew bridges.

By default, LimitState:RING 4.0 utilizes a user-specified fixed bridge width in the analysis. However,
an effective width that varies according to simple user-defined transverse distribution rules can al-
ternatively be used; readers are referred to Section 8.1.4 and Section 8.2.2 for further guidance on
choosing an effective bridge width.

5.4.6 Range of collapse modes identifiable

The general problem formulation and rigorous mathematical solvers employed mean that Limit-
State:RING 4.0 can identify numerous potential failure mechanisms. Figure 5.4 shows a selection of

4Consider, for example, the stresses at the base of two geometrically similar solid masonry piers. If the second pier
is n times as large, in all dimensions, as the first then its volume and hence self-weight will be n3 larger. However
the area at the base of the pier will only be n2 times larger, so it follows that the gravity stresses at the base (and
elsewhere) in the second pier will be n3/n2 = n times larger.
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those mechanisms that have been observed whilst using the program to assess real bridges.

The ability of LimitState:RING 4.0 to identify hitherto unknown failure modes has led to some
interesting findings. For example, it has previously been suggested that a multi-span bridge can safely
be analysed as a series of separate single spans if the piers are ‘stocky’ (i.e. thick in comparison to
their height). However, this is, in general, not the case. For example, the adequacy factor associated
with the mechanism shown on Figure 5.4(f) is actually much lower than that computed if the outer
spans are omitted from the analysis - indicating that the presence of stocky piers (and backing in this
case) is no guarantee that the structure can be safely idealized as a series of separate single spans.
In general, users should avoid using such rules of thumb and should where possible model as much
of the structure as is practicable (refer to Section 7.4 for further advice on modelling multi-span
bridges).

5.5 Use of reinforcement

The key assumptions made when modelling bridges containing reinforcement using LimitState:RING
4.0 are as follows:

• The masonry (or concrete) arch and the reinforcement are assumed to behave in a rigid-plastic
manner. This means that at a ‘failing contact’ the reinforcement is assumed to yield at the
specified force if it is located away from the neutral axis. This idealization means that the
software is likely to be most suitable when sections are lightly reinforced using ductile steel
bars.

• Shear failures in reinforced sections can be modelled by specifying a limiting shear force.

• Anchorage failure of the reinforcement is not considered.

For details on how to specify reinforcement in a bridge model, see Chapter 21.
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Figure 5.4: Selection of potential failure modes identifiable using LimitState:RING 4.0
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5.6 Finite masonry strength

In LimitState:RING 4.0 it is assumed that in the vicinity of hinges the thrust in the arch is transmitted
across joints, either:

1. through an infinitely thin strip of material lying on an exterior face, or, if a finite material
strength is specified;

2. through a rectangular stress block located adjacent to an exterior face.

For both cases, moment vs. normal force failure (yield) envelopes for a contact can be plotted, as
shown on Figure 5.5:

Figure 5.5: Contact surface moment vs. normal force failure envelopes for: (i) infinite; (ii) finite
masonry crushing strengths

It is evident from Figure 5.5 that the envelope for case (i) is defined by linear constraints whereas in
the case of (ii) these are non-linear. In LimitState:RING 4.0 the envelope for case (ii) is approximated
using sufficient linear constraints to ensure that any deviation from the true non-linear yield envelope
is negligible. To achieve this, linear constraints are adaptively added using an iterative procedure
that is described in Appendix A.3. (The procedure ensures that converged solutions are obtained
more rapidly and reliably than was the case with RING version 1.x.)
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5.7 Sliding failures

Unlike many other masonry arch bridge analysis programs, LimitState:RING 4.0 does not rule out
the possibility that sliding failures might occur. A ‘saw tooth’ model for friction is used (also referred
to as ‘associative friction’). This means that separation is assumed to accompany sliding. The main
advantage of using a ‘saw tooth’ model is that the linear character of the problem is preserved.

Whilst it can be shown that the use of a ‘saw tooth’ model for friction can lead to non-conservative
adequacy factors being obtained if sliding is involved in the critical failure mode (Drucker 1954),
when previously applied to multi-ring brickwork arch bridges reasonably good agreement between
experimental and numerical results were obtained (in fact it was found that the numerical multi-ring
model always under-estimated the experimentally observed carrying capacity).
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5.8 Backfill

5.8.1 General

The vertical dead weight of backfill material effectively pre-stresses the masonry in an arch, thereby
increasing its load-carrying capacity (provided the constituent masonry has sufficient compressive
strength). The backfill also has two other beneficial effects as shown in Figure 5.6:

1. It disperses live loads.

2. It can restrain movement of the arch when the latter sways into the fill. This is often termed
‘passive’ restraint.

Figure 5.6: Masonry bridge soil-structure interaction

Each of the above effects has the potential to significantly enhance the carrying capacity of a masonry
arch bridge. However, whereas the constituent masonry blocks of a bridge are modelled explicitly in
LimitState:RING 4.0, the backfill is presently modelled indirectly according to the simplified model
described in the following sections.

5.8.2 Dispersion of live loads

The vertical live load pressures on the back of an arch are assumed by LimitState:RING 4.0 to be
either:

1. uniformly distributed, the intensity being governed by the depth of fill under the centre of a
given axle and the specified limiting dispersal angle; or

2. dispersed according to a Boussinesq type distribution, with a limiting distribution angle specified
by the user.

The Boussinesq distribution model generates a suitable ‘bell shaped’ distribution of load, which
laboratory tests have indicated better approximates reality than uniform pressure distributions, and
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that also models the effects of overlapping dispersed loads more appropriately. This is therefore the
default distribution model in LimitState:RING 4.0 (except for the surface layer, if present, where a
uniform distribution is adopted). A default cutoff angle of 30◦ is used to prevent excessive distribution.
Further details of the Boussinesq model are provided in Appendix B.1.

5.8.3 Passive restraint

One-dimensional bar elements, for convenience hereafter termed ‘backfill elements’ (Figure 5.7(a))
are used to model the passive restraint experienced by sections of the arch moving into the fill
material.

Backfill elements compress at constant force (e.g. σh× vertical projected area) where σh is the
horizontal stress, but have no tensile capacity (Figure 5.7(b)). The use of these elements ensures
that pressures are mobilized in the correct sense. For example, in Figure 5.7(c) the backfill elements
only apply a force to the non-loaded side of the bridge. Note that in LimitState:RING 4.0, active
pressures on the loaded side of the bridge, which are usually relatively small, are ignored by default
(though can be included if desired).

Figure 5.7: (a) Arch restrained with uniaxial backfill elements; (b) backfill element response; (c)
LimitState:RING 4.0 representation of backfill elements

Classical lateral earth pressure theory developed originally for vertical retaining walls is often used in
masonry arch analysis to estimate the amount of horizontal passive restraint that can be realized.
This approach is also used in LimitState:RING 4.0.

According to vertical retaining wall theory, the horizontal passive restraining stress σh applied to the
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back of a smooth wall is:

σh = Kpσv +Kpcc (5.1)

where Kp =
1+sinφ
1−sinφ = tan2 (45 + φ/2), σv is the vertical stress, Kpc = 2

√
Kp, and where φ is the

effective angle of friction of the fill material, and c is the cohesion of the fill material. For a frictional
backfill, drained strength properties φ′ and c′ would be used.

In LimitState:RING 4.0, equation 5.1 is used in the modified form:

σh = mpKpσv +mpcKpcc (5.2)

where mp and mpc are modification factors designed to account for additional effects not represented
by the simple vertical retaining wall theory:

Determination of mp

Consider a wall that retains a frictional soil. In the case of a vertical wall that rotates at failure, full
passive pressures will not be mobilized until rotations are very large (Figure 5.8(a)). In practice, a
reduced earth pressure coefficient is often used to limit rotations to acceptable levels (Figure 5.8(b)).
If the wall is actually curved (i.e. part of an arch) then the coefficient can be assumed to be further
reduced (Figure 5.8(c)).

Figure 5.8: Commonly used horizontal earth pressure coefficients: (a) large wall rotation; (b) small
wall rotation (≈0.5%); (c) arch segment rotation into surrounding fill

It has been found that taking mp = 1/3 gives rise to a restraint force that is approximately equal
to that measured in laboratory tests (at least for backfills with relatively high angles of friction).
Hence this value is used as the default in LimitState:RING 4.0. i.e. when the user inputs the angle
of friction for a granular backfill this is used to compute a Kp value, which in turn is multiplied by
the vertical stress, σv, and the mp modification factor (default = 0.33) to compute the horizontal
restraining stress σh.

Determination of mpc

The cohesive strength of clayey backfill materials may enhance the load-carrying capacity of short-
span bridges. However, limited experimental evidence is available at present and a conservative
default modification factor on Kpc of mpc= 0.05 is therefore currently used in LimitState:RING 4.0.
(This has been increased from the default value of 0.01 utilized in LimitState:RING 2.0 in the light of
additional experimental and numerical data.) It should be noted that this value may be inappropriate
for very soft, low stiffness clay backfills. However, these are unlikely to be encountered in practice.
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Once equation 5.2 has been used to determine a value of the horizontal restraining stress σh applied
to a given block, this is checked to see whether it exceeds the magnitude of horizontal stress that can
be applied without causing the strip of backfill acting on the block to slide. If so, then the reduced
horizontal stress associated with the sliding failure is used (this can be overridden if a user-defined
pressure is specified). Further details are given in Appendix B.2.

Finally, it should be appreciated that there are several important simplifications inherent in the way
LimitState:RING 4.0 treats passive (and active) restraining horizontal pressures. For example: (i)
backfill pressures are assumed to be mobilized by infinitesimal structural movements; (ii) the failure
mode is assumed not to influence the magnitude of peak pressure mobilized. Further background
information on these assumptions is provided in Appendix B.3 and Appendix B.4.

5.8.4 Backing

LimitState:RING permits the modelling of backing material above the piers and around the abutments
(see Chapter 15).

The backing model is a special implementation of the horizontal ‘backfill element’, where the com-
pressive strength is set to a high value (5MPa by default). This allows the software to account for
the transfer of compressive forces between (or away from) spans where strong material is present.

If desired, the resistance offered by the backing can be tailored on an element-by-element basis,
allowing the software to represent differing bridge backing conditions. Details on how to achieve this
are provided in Section 17.2.3.

Where backing exists over a pier, two backing elements will be associated with a block (one element
from each of the two associated spans). The allowable force that the backing is permitted to assume
in these cases is the average of the two values. Note that, when two adjacent spans have identical
heights and numbers of blocks, the two backing elements between corresponding blocks may lie on
top of each other in the viewer. Click selecting will pick the topmost of the two and display the
limiting force as appropriate.
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Chapter 6

Preliminary bridge assessments

Increasingly, assessment codes and other guidance documents advocate a multi-level approach to
bridge assessment (e.g. see Gilbert et al. 2022). A preliminary (or ‘Level 1’) assessment might
traditionally be performed using a semi-empirical assessment procedure (e.g. the MEXE method). If
this assessment procedure indicates that the bridge is safe then in the past the assessment engineer
has typically not been required to study the bridge further (i.e. does not need to undertake a ‘Level
2’ or ‘Level 3’ analysis).

However, there are increasing concerns over the reliability of existing semi-empirical assessment
procedures, and consequently, their range of recommended application is being successively reduced
by the relevant regulatory bodies. For example, CS454 Section 7.13 (National Highways 2022) allows
only a narrow range of bridges to be assessed in this way. The large number of bridges that need
to be assessed therefore means that a rapid means of conservatively assessing bridge load-carrying
capacity is required.

Reflecting this, LimitState:RING 4.0 has been designed so that it can be used with default settings
to perform a preliminary and generally conservative assessment of load-carrying capacity rapidly,
with many dialogs in the program being simplified. For example, refer to Figure 6.1 that shows the
‘Backfill’ page of the New Bridge Wizard. In a preliminary assessment default backfill parameters
can be used, Figure 6.1(a). If the bridge proves to have insufficient load-carrying capacity then a
follow up assessment can be performed using more realistic values (e.g. informed by trial pit or
penetrometer investigations). In a second level assessment it may very occasionally be necessary to
also adjust other details of the ring soil model, Figure 6.1(b).
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Figure 6.1: Backfill dialog of New Bridge Wizard

Note that before LimitState:RING 4.0 is used to perform a series of preliminary analyses it is advisable
to review the default parameters, and to check that these are reasonable for the type of bridges being
assessed. As an example, although the default values are normally conservative, in an area where
bridges are constructed using very soft red bricks and lime mortar the default masonry crushing
strength of 5MPa may be non-conservative.
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Chapter 7

Detailed bridge assessments

7.1 Analysis parameters

The first step in an analysis is typically to identify sensible values for the analysis parameters. Default
parameters are shown in Appendix C. However, it should be borne in mind that some of the default
values proposed may be quite conservative and more accurate values should be used where possible.

Additionally, in order to save computational effort a default value of 40 is often given for the number
of blocks per arch ring (rather than the actual number of units). This may lead to a very small
overestimate (up to 2 or 3%) of the predicted carrying capacity of a given bridge if the real structure
contains more than 40 blocks.

7.1.1 Partial factors of safety

In order to facilitate limit state analysis of bridges, values for the partial factors of safety shown in
Table 7.1.1 can be specified.

Some assessment codes use a global condition factor. A global condition factor should not normally be
applied to LimitState:RING 4.0 analysis output because the effects of defects such as ring separation,
low strength masonry and the influence longitudinal cracks on the ability of a given bridge to distribute
the load transversely can all be accounted for directly.

7.2 Modelling the shape of the arch

In LimitState:RING 4.0 the arch shape can be modelled using one of the following profiles:

Segmental The arch profile is formed from a single segment of a circle, constructed using the crown
rise and span measurements.

User-defined (multi-segment) The arch profile is formed from multiple segments of circles that
fit a series of user-defined data points.
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Partial Factor Symbol ULS PLS Notes
Vehicle Loads (multipliers on vehicle loading)
Axle load γf,l 1.5 1 Applied to variable load from vehi-

cle axles

Dynamic / impact γf,dyn 1 1 Applied to axles where a ‘Dynamic
/ impact’ (see Section 18.3.5) fac-
tor has been set

Load effects γf,3 1 1 Takes account of uncertanties in
modelling the effects of loads in the
model (eqivalent to a model fac-
tor), applied to the vehicle loading

Material Loads (multipliers on material unit weights)
Surface fill / ballast unit weight γf,sf 1 1 Load factor - applied to permanent

load from surface fill / ballast

Masonry unit weight γf,m 1 1 Load factor - applied to permanent
load from masonry

Fill unit weight γf,f 1 1 Load factor - applied to permanent
load from backfill and backing

Track load γf,t 1 1 Applied to permanent load from
track

Material Strengths (divisors on material strength)
Masonry compressive strength γm,ms 1 2 Material factor - applied to ma-

sonry crushing strength

Masonry shear bond strength γm,ma 1 2 Material factor - applied to ma-
sonry shear bond strength (adhe-
sion)

Masonry friction γm,mf 1 1 Material factor - applied to ma-
sonry friction coefficients

Table 7.1: Default Partial Factor values, symbols and meanings
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User-defined (interpolated) The arch profile is formed from a spline interpolation of user-defined
data points. (This is the most powerful and flexible profile type, suitable for use when many
user-defined data points are specified.)

Three-centered (pseudo-elliptic) The arch profile is (near) elliptical in shape, being formed from
segments of three circles using the crown rise and span measurements.

Pointed The arch profile is pointed and is formed from segments of two circles using the quarterspan
rise, crown rise and span measurements. This can therefore represent a ‘gothic’ arch.

It is the shape of the arch, in relation to the pattern of loadings applied to it, which governs stability.
Hence it is of paramount importance that due care is taken when recording and entering the shape
into LimitState:RING 4.0. All too often this is ignored, with the default ‘Segmental’ arch shape
regularly being used without careful forethought1. When transverse cracks are present it follows that
the arch profile must differ from that originally constructed, and this makes it even more important
to perform an accurate survey of the bridge prior to analysis, to ensure that the true shape of the
arch is modelled.

To obtain an indication of the influence of arch shape on carrying capacity, refer to Figure 7.1,
which shows the effect on the computed adequacy factor of simultaneously modifying the quarter
and three-quarter point rises of Bolton Bridge 3-1 (see Appendix G.1). In this case the maximum
computed adequacy factor approximately corresponds to the segmental arch shape, and it is evident
that quite significant reductions in adequacy factor are observed as the shape deviates from this
(span and crown rise fixed but critical load position allowed to vary).

Figure 7.1: Influence of varying 1/4 and 3/4 point rises (as ratio of midspan rise)

It is also important to note that if the arch shape is asymmetrical (i.e. if the quarter and three-quarter
point rises differ) then carrying capacity can be significantly reduced.

1Indeed it can be considered just as important to accurately record the arch shape and thickness as it would, for
example, to accurately measure the overall depth, flange thickness etc. of a steel I-beam prior to assessing its ability
to span a given distance.
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7.3 Skew bridges

Since LimitState:RING 4.0 is 2D analysis software, it is most suitable for the analysis of bridges that
span squarely between abutments. Skew bridges tested in the laboratory (Melbourne & Hodgson
1995) have exhibited distinct 3D failure modes that cannot be replicated using a 2D analysis tool.

However, given the comparative computational expense and lack of availability of mainstream 3D
analysis tools, some codes of practice pragmatically permit the use of 2D analysis methods for skew
bridges, and LimitState:RING 4.0 can be used in such cases. If doing so, it is generally advised
to consider the skew span rather than the square span and ensure that the loading model is still
appropriate (i.e. that the pattern of axle loading in the software is representative of the pattern
being experienced at the structure in practice).

7.4 Multi-span bridges

Multi-span bridges are modelled in LimitState:RING 4.0 in exactly the same way as single-span
structures (i.e. in essence, as assemblages of interacting rigid blocks and backfill elements). Using
LimitState:RING 4.0 the most critical failure mode will automatically be identified, whether this
involves a single or multi-span failure mode. Multi-span failure modes typically, although not always,
involve two adjacent spans2. The following points are particularly relevant to the analysis of multi-
span arch bridges:

• For a viaduct comprising a large number of identical spans, only two representative adjacent
spans need normally be modelled initially.

• Large railway viaducts frequently had large ‘king piers’ at frequent intervals (e.g. every 6
spans). These are typically sufficiently massive to ensure that no interaction occurs between
the two spans abutting a ‘king pier’.

• For a bridge comprising spans of different geometries, ideally all spans between ‘king piers’
should be modelled.

• Full-scale laboratory tests indicate that significant backfill pressures can be mobilized above
the piers between adjacent spans, enhancing carrying capacity (Melbourne et al. 1997).

• Alternatively, backing or internal spandrels are often present between spans, and this can play
an important role in propping apart adjacent spans.

• In some cases the presence of strong fill or backing above a pier may mean that adjacent spans
can interact in the failure mechanism without movement of the intermediate pier (e.g. see
Figure 5.4(f)).

• In cases where intermediate piers are very slender, the user should consider separately perform-
ing other local checks (e.g. so that elastic instability will not limit the vertical load that can
be applied; no such check is currently done by LimitState:RING 4.0).

2Note though, that for a bridge with slender piers, initial failure of one or two spans is likely in practice to quickly
precipitate failure of neighbouring spans because of the out-of-balance thrusts, which then act at the tops of piers
supporting these.
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7.5 End abutment blocks

Abutment blocks at the ends of a bridge can be included in the model. However, soil pressures are
not applied behind end abutment blocks. Hence if end abutments are used to model soil-backed
abutments there is the potential for the resulting failure mode, and adequacy factor, to be unrealistic
(e.g. the skewback may be observed to slide when only a small load is applied to the bridge whereas
in reality such movement would be restrained by soil).

In LimitState:RING 4.0, distributed load that falls beyond an end abutment is assumed to be ‘lost’
(in the same way as distributed load that falls on or beyond a fixed support is ‘lost’). Note that this
differs from RING 1.x behaviour.

7.6 The influence of infill material

Except in the case of relatively shallow arches, the passive restraint offered by infill material (soil and
/ or backing) behind an arch can lead to very significant increases in carrying capacity. The problem
for the assessment engineer lies in determining, for the purposes of analysis, what level of restraint
is likely to be available.

In the case of a bridge with apparently insufficient load-carrying capacity, it may be necessary to
perform appropriate intrusive investigations (e.g. dig trial pits, perform penetrometer testing etc.).
These investigations can furnish soil strength parameters for use in LimitState:RING 4.0. Such
investigations can also be useful in identifying unexpected beneficial construction details (e.g. the
presence of generous concrete backing).

If internal hollow spandrel walls are encountered then these may be approximately modelled in Lim-
itState:RING 4.0 by:

1. specifying backing above the piers and abutments; and

2. using an averaged unit weight for the fill, which takes account of both the solid and voided
regions of the spandrel.

Finally, if there is evidence to suggest that the distribution of the live load is more limited than usual
(e.g. due to pulverization of the fill material) then the distribution cutoff angle should be reduced
below the default value of 30o.

7.7 Modelling the mechanical properties of masonry

In many cases the mechanical properties of the masonry are of secondary importance when ascertain-
ing the load-carrying capacity of a masonry arch bridge. Indeed, in some cases reasonable accuracy
can be obtained even when it is assumed that the masonry possesses infinite compressive strength.
This is most likely to be the case when the span is relatively short and when the constituent masonry
is relatively strong. However, in other cases it is prudent to specify a finite masonry crushing strength
in LimitState:RING 4.0.
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Masonry is a composite material, comprising masonry units (stone, brick, concrete etc.) and mortar
joints. The mechanical properties of the units and the joints together give rise to composite material
properties that are generally quite different to those of either the masonry unit or masonry joint parent
materials. An important point to realize is that the crushing strength specified in LimitState:RING
should be that of the composite masonry material. This will typically be lower than that of the
masonry units but higher than that of the mortar in the joints.

Note also that in LimitState:RING 4.0 different strengths can be allocated to the spans and piers (or
even to localized areas of a span or pier).

Masonry typically fails in compression due to tensile splitting of the masonry units. Since tensile
splitting is a quasi-brittle phenomenon, the compressive stress-strain characteristics of masonry do
not exhibit the long flat plateau assumed in rigid-plastic theory, and also in LimitState:RING. As an
example of this, the experimental compressive stress-strain loading responses of the masonry used
in the Bolton test bridges discussed in Appendix G.1 are shown in Figure 7.2. To account for the
potential lack of ductility, it is possible to factor down experimentally recorded values for the ultimate
strength of the masonry. However, this refinement may not be deemed necessary in practice because:

1. the bridge load-carrying capacity is often relatively insensitive to the precise value of the spec-
ified crushing strength;

2. the eccentric loading regime found in masonry arch bridges (in the vicinity of hinges) appears
to permit the realization of higher stresses at the edge of a cross section compared with those
in a specimen that has been uniformly loaded.

Figure 7.2: Bolton masonry compressive stress-strain loading responses (masonry: solid engineering
bricks and 1:2:9 cement:sand:lime mortar)
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7.8 Modelling bridge defects

The majority of masonry arch bridge stock was constructed more than a century ago and, in most
cases, the passage of time will have led to a variety of material and / or structural defects. These
defects can often have a bearing on the load-carrying capacity of the bridge and it is therefore
important that they are modelled as accurately as possible.

7.8.1 Missing mortar and/or localized spalling of masonry units

Localized areas of missing mortar or occasional spalled masonry units are inevitable in old masonry
structures, and need not be considered a cause for concern. However in cases when mortar loss
and/or spalled units are more widespread, and the effective thickness of the arch barrel is considered
to be tangibly reduced, then this should be accounted for in the analysis. In LimitState:RING 4.0
localized regions of arches and/or piers may be readily selected and the effective thickness reduced
as required (Figure 7.3).

It should be noted that the influence of missing mortar / spalled units on carrying capacity depends
not only on the depth of missing material but also on location within an arch barrel or pier. In certain
locations a considerable reduction in effective thickness may be found to have little or no influence
on overall carrying capacity.

Figure 7.3: Mortar loss in a LimitState:RING 4.0 model
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7.8.2 Ring separation in multi-ring brickwork arches

Various bonding styles are used in the arch barrels of masonry arch bridges (Figure 7.4).

(a) stone voussoir
(1 ring)

(b) brick: header
(1 ring)

(c) brick: stretcher
(3 rings)

(d) brick: hybrid
(2 effective rings)

Figure 7.4: Typical masonry arch bonding patterns

A powerful feature of LimitState:RING 4.0 is the ability to model an arch barrel that comprises a
number of separate rings (Figure 7.5).

Figure 7.5: LimitState:RING 4.0 model of multi-ring arch

It is usually satisfactory to assume that a brickwork arch with a bonding pattern of the form shown
in Figure 7.4(b) effectively behaves as a single-ring voussoir arch (i.e. as in Figure 7.4(a)). However,
if very weak bricks are present, headers may shear through and the arch should then be modelled as
if composed from separate rings (e.g. see Figure 7.6 for a real-world example of this).
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(a) view of edge of barrel (b) view through core hole showing separation
of bottom layer of brickwork

Figure 7.6: Arch barrel containing headers that have sheared through

However, even when inter-ring cracks are not evident, the circumferential mortar joints present in
the multi-ring bonding patterns shown in Figure 7.4(c) and Figure 7.4(d) form potential surfaces
of weakness and careful consideration should be given to modelling bridges constructed with these
types of barrels.

In fact, when multi-ring brickwork arch bridges are assessed, the general question arises: should, for
the purposes of analysis, the individual rings in the arch barrels of these bridges be assumed to be
adequately adhered together or not? From the Bolton work referred to in Appendix G.1 the following
was observed:

• Two 5m span arch bridges containing 440mm thick arch barrels, in which individual rings had
been properly mortared together, suffered ring separation whilst being load tested to collapse.
This separation prevented the bridges from reaching the collapse load they otherwise would
have achieved (the sudden onset of ring separation was estimated to have reduced carrying
capacity by up to approximately 55%).

• A similarly constructed 3m span arch bridge containing a mortar bonded 215mm thick arch
barrel did not suffer ring separation when loaded to collapse.

In addition to the in-situ mechanical properties of a given joint (the above bridges were constructed
using a 1:2:9 [sand:cement:lime] mortar), scaling effects will also be important in governing the
likelihood of ring separation. Essentially, by almost doubling the span, rise etc., the internal stresses
will also be almost doubled; for this reason, very short-span bridges are likely to be less susceptible
to ring separation than bridges with longer spans. This can be taken into account in the analysis
(e.g. a 2m span multi-ring brickwork arch in good condition may justifiably be analysed with fully
bonded rings. However, this is unlikely to be an appropriate idealization for a geometrically similar
20m span bridge, as the higher stresses mean it would be likely to suffer ring separation were the
bridge to be loaded to collapse).
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7.8.3 Cracking in the arch barrel

Macro cracks

There are several distinct types of macro cracks observed in masonry arch bridges, including longitu-
dinal, transverse and diagonal. The potential influence of longitudinal cracks on the effective bridge
width and hence, on ultimate carrying capacity, will be briefly discussed in Section 8.1.4 and Section
8.2.2. Transverse cracks may be caused by small movements of the supports (e.g. due to slight
outward spreading following removal of the centering). In an arch, the identification of transverse
cracks indicative of a three-hinge formation is not necessarily of concern provided the abutments are
sound. This is simply the statically determinate form of an arch. However, if the location of the
crown region crack/hinge is observed to change under the action of normal traffic loading then this
can be problematic, with subsequent fatigue failure of the structure a possibility.

Less frequently, transverse cracks may be identified that are indicative of the partial formation of
hinges due to excessive live loading at some point in the past. In general, when sufficient releases
(hinges and/or sliding planes) to form a mechanism are identified, this should be considered to be
potentially very serious. Whilst it is theoretically possible that additional reserves of strength might
exist, for example, because of the potential for increasing passive soil restraint to be mobilized as
structural movements increase, in this case the large structural deformations required are such that
the structure will still fail to meet any meaningful serviceability criteria.

It may be feasible to point up transverse cracks, but if this is not done, a conservative LimitState:RING
4.0 analysis may be performed simply by locally reducing the arch thickness at the position of the
crack; Figure 7.7. (It should be noted that LimitState:RING 4.0 is not capable of modelling the
presence of cracks that close up completely after finite movement.)

(a) crack (b) crack closing under loading (c) crack opening under loading

Figure 7.7: Modelling an existing crack in an arch using the mortar loss feature

In square spanning bridges diagonal cracks are often caused by abutment settlements. Whatever
the cause, when diagonal cracks are present the arch profile should be surveyed at several positions
across the width of the bridge, with an analysis being performed for each profile.
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Micro cracks

Isolated fine cracks may be present in masonry joints or within masonry units. When numerous cracks
are concentrated in parts of the structure, this can be indicative of a major problem, especially if
there are signs of recent cracks. This is because masonry tends to fail in compression due to
tensile splitting of the masonry units. Therefore, widespread micro-cracking may indicate that the
compressive capacity of the masonry has been almost exhausted (note that rough calculations of the
stresses within a masonry pier can be misleading because the pier may be hollow or rubble filled).
The cracks may continue to propagate due to long-term creep effects or due to the effects of repeated
(fatigue) live loading. Masonry compression failures, although rare, will generally have catastrophic
consequences and thus, the assessment of a bridge with such symptoms should be carried out with
extreme care; a simple LimitState:RING 4.0 analysis alone is highly unlikely to be appropriate in such
a case.

7.9 Modelling flooded masonry arch bridges

Masonry arch bridges typically derive the majority of their load-carrying capacity from self-weight
effects. In flood situations, buoyancy reduces these effects and hence, also potentially the load-
carrying capacity. According to Archimedes’ principle, the ratio of normal to flooded bridge load-
carrying capacities may be postulated to lie between the buoyancy ratios (ratio of dry to submerged
weight) of the backfill and masonry, typically 1.6 to 1.8. This has recently been confirmed by a series
of tests on small-scale model arch bridges (Hulet et al. 2006).

When using LimitState:RING to assess an un-waterproofed masonry arch bridge subject to flooding,
buoyant unit weights should be specified for the masonry and backfill materials. This enables the
modelling of a bridge that is flooded up to road / rail level - the most severe flooding scenario.
When a bridge is waterproofed and flooded from below it is conceivable that the deleterious effects
of flooding on load-carrying capacity will be even more severe. This scenario can be modelled using
LimitState:RING, although the hydrostatic pressures have to be entered manually (Hulet et al. 2006).
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Chapter 8

Load models

8.1 Loading from railway vehicles

8.1.1 Railway loading models

For convenience, a Library containing common railway load models is distributed with LimitState:RING
4.0. Alternative loading models may also be defined by the user.

Some standard loading models contain components of distributed loading. Given the origins of such
load models (typically determined from influence lines for simply supported or continuous beams),
it is debatable how appropriate their use is for masonry arch bridges. Nevertheless, as they are used
by some authorities they are listed for completeness. However, two practical issues must be borne in
mind:

1. The length of distributed loading may be variable, and in this case, it is the responsibility of
the user to determine the length of distributed loading that proves to be most onerous.

2. The distributed loading part of a model can be introduced by adding an appropriate number
of extra axles.

8.1.2 Distribution of rail loads through the track

In LimitState:RING 4.0 it is assumed that a sleeper is always located under an axle load. Half of
the load is then distributed to the adjacent sleepers (such that the loading follows a 25%, 50%, 25%
pattern). The specified sleeper spacing governs the location of the adjacent axles (e.g. see Figure
8.1).
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Figure 8.1: Dispersal of twin-axle loads through track

8.1.3 Longitudinal distribution of load through ballast and fill

After distributing the rail loads through the track, LimitState:RING 4.0 computes the live load
pressure at the underside of the sleepers. By assuming a simple uniform distribution model this is
then spread through the ballast (default spread 15◦ approx. corresponding to 4:1, vertical:horizontal
as per UIC 774 2R, International Union of Railways 1994). Live load is then spread through the fill
according to a user-specified model (uniform or modified Boussinesq distribution; refer to Section
5.8.2). Figure 8.2 shows a graphical view of how the loading from a single axle is, by default, assumed
to be dispersed using LimitState:RING 4.0, showing different distribution angles through the ballast
and backfill.

Figure 8.2: Longitudinal dispersal of a railway axle load through sleepers, ballast and fill, also showing
default dispersion angles

c© LimitState Ltd



CHAPTER 8. LOAD MODELS 83

8.1.4 Transverse distribution and effective bridge width

LimitState:RING 4.0 is a 2D analysis program, therefore appropriate assumptions are required in
order to determine the effective bridge width that may be assumed to support an axle loading.
Unfortunately, this is an area for which there is little real evidence on which to base rational rules.

By default, a fixed effective bridge width of 2500mm is used. This can be changed by the user or
alternatively, an automatically computed effective bridge width can be used, which is computed as
follows:

effective width = specified sleeper width + amount of load spread at the loaded sleeper with
minimum fill depth + extra distance to account for distribution within the arch

The effective width computed using the default railway bridge parameters is shown in Figure 8.3(a).
However, the automatically computed effective bridge width may not be reasonable; the user should
check, for example, whether longitudinal cracks in the arch barrel, the proximity of adjacent track or
the edge of the bridge will limit the effective width (illustrated in Figure 8.3(b) and Figure 8.3(c)).
To address this, a maximum ‘cutoff’ value can be specified. When this is set, the effective width will
be equal to the lesser of the automatically calculated value and the specified cutoff value.

Refer to Section 13.1.2 for details on how to set the bridge width. In addition, the vertical effects
of nosing and centrifugal action may mean that one rail is more heavily loaded than the other. A
concentrated wheel loading may therefore become the critical case, meaning a reduced effective width
should be selected. Users are referred to Section 8.1.6 for further guidance.

8.1.5 Impact (dynamic) effects

Underline bridges must be capable of carrying a given live train load at a given train speed. Train
speed is important because certain dynamic effects are speed dependent (e.g. due to the effects of
track irregularities, excitation of the bridge by the rail vehicle etc.). Thus a so-called ‘impact’ or
‘dynamic’ factor is applied to constituent loads in a load model.

However, most railway administrations stipulate that the Dynamic Factor is applied to all loads
simultaneously. Since the pattern of loading remains unchanged, this means that dynamic effects
can be considered after a LimitState:RING 4.0 analysis has been completed.

In cases when different dynamic factors are applied to different axles, the pattern of loading changes.
This therefore, needs to be taken into account in a LimitState:RING 4.0 analysis. It is the responsi-
bility of the user to apply the Dynamic Factor to axles in turn, to determine which loading pattern
is the most onerous. Note that, to have any effect, the Dynamic / impact partial factor must also
be set to an appropriate value (by default it is set at unity).
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(a) Automatically computed effective width using default parameters based on sleeper width & minimum
loaded sleeper ballast/fill depth

(b) Possible reduced user-specified effective width due to longitudinal cracks

(c) Possible reduced user-specified effective width due to proximity of adjacent track and edge of bridge

Figure 8.3: Transverse dispersal and effective bridge widths (railway)
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8.1.6 Other effects

Nosing and centrifugal forces

On curved track the vertical effects of nosing and centrifugal actions can lead to one rail being more
heavily loaded than the other. Both actions are speed dependent.

Nosing forces are caused by side contact of the wheel flange on the rail. Since the forces are generally
assumed to act perpendicular to the rail, on canted track there will be a small vertical component
to consider (applied to one rail only).

When one rail is more heavily loaded than the other, due to either effect, it is usually considered
prudent to consider the single rail load case separately, to determine whether or not it is critical. In
LimitState:RING 4.0 this requires the use of a suitably reduced effective width (see Section 8.1.4).
However, since the pattern of loading is unaffected then this special load case can normally be
considered retrospectively (i.e. after an analysis has been performed, by modifying the adequacy
factor to account for the use of a different effective width and live load intensity).

Traction/braking forces

LimitState:RING 4.0 does not currently apply horizontal forces at rail level (e.g. to model trac-
tion/braking forces). However, it is possible to apply user-specified horizontal forces (as pressures)
directly to blocks within arches and/or piers (see Section 22.1.3).

8.2 Loading from highway vehicles

8.2.1 Highway loading models

For convenience, a Library containing common highway load models is distributed with Limit-
State:RING 4.0 (see also Appendix D). Alternative loading models may also be defined by the
user. Of the loads listed in Appendix D, the most onerous loading pattern for the majority of small
to medium-span masonry arch highway bridges will be that comprising a single point load.

LimitState:RING 4.0 assumes that the load from an axle is spread through the surface fill (default
spread 26.6◦, corresponding to 2:1, vertical:horizontal as per e.g. Department of Transport 2001,Na-
tional Highways 2022). Live load is then spread through the fill according to a user-specified model
(uniform or modified Boussinesq distribution; refer to Section 5.8.2). Figure 8.4 shows a graphical
view of how the loading from a single axle is assumed to be dispersed using LimitState:RING 4.0,
showing different distribution angles through the surface fill and backfill.
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Figure 8.4: Longitudinal dispersal of a highway axle load through surface fill and underlying backfill,
also showing default dispersion angles

8.2.2 Transverse distribution and effective bridge width

LimitState:RING 4.0 is a 2D analysis program. Thus, appropriate assumptions are required in order
to determine the effective width of the bridge, which may be assumed to support an axle loading.
Unfortunately, this is an area for which there is little real evidence on which to base rational rules.

By default, a fixed effective bridge width of 2500mm is used. This can be changed by the user or
alternatively, an automatically computed effective bridge width can be used, which is computed as
follows:

specified axle width + amount of load spread at axle with minimum fill depth + extra distance to
account for distribution within the arch

The effective width computed using the default parameters for a highway bridge is shown in Figure
8.5(a). However, it is important to remember that the automatically computed effective bridge width
may not be reasonable and the user should check, for example, whether longitudinal cracks in the
arch barrel, the proximity of adjacent lane or the edge of the bridge will limit the effective width
(illustrated in Figure 8.5(b) and Figure 8.5(c)). To facilitate this, a maximum ‘cutoff’ value can be
specified. When this is set, the effective width will be the lesser of the automatically calculated value
and the specified cutoff value.

Refer to Section 13.1.2 for details on how to set the bridge width. In addition, centrifugal effects
may mean that one wheel in an axle is more heavily loaded than the other. A concentrated wheel
loading may therefore become the critical case, hence a reduced effective width should be selected.
Users are referred to Section 8.2.4 for further guidance.
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8.2.3 Dynamic / impact effects

To account for the anticipated effects of the dynamic nature of loads applied to highway bridges,
some assessment codes suggest the use of a ‘dynamic factor’, to be applied to one or more of the axle
loads. When a Dynamic Factor is applied to all loads simultaneously the pattern of loading remains
unchanged, and hence dynamic effects can, if necessary, be considered after a LimitState:RING 4.0
analysis has been completed.

Some assessment codes refer to an ‘impact factor’ rather than a ‘dynamic factor’, largely designed
to take into account the effect of a vehicle travelling on an uneven road. This can be considered as
a Dynamic Factor, though one that is generally only applied to one of the axles of a vehicle. In this
case, the pattern of loading changes, which needs to be taken into account in a LimitState:RING
4.0 analysis.

It is the responsibility of the user to apply the dynamic / impact factor to axles in turn to determine
which loading pattern is the most onerous.

Note that to have any effect, the Dynamic / impact partial factor in LimitState:RING 4.0 must
also be set to an appropriate value (by default it is set at unity).

8.2.4 Other effects

Centrifugal forces

On a curved road the vertical effects of centrifugal actions can lead to one wheel being more heavily
loaded than the other. This action is speed dependent.

When one wheel is more heavily loaded than the other it is usually considered prudent to consider
the single wheel load case separately, to determine whether or not it is critical. In LimitState:RING
4.0 this requires the use of a suitably reduced effective width (see Section 8.2.2). However, since the
pattern of loading is unaffected, this special load case can, if necessary, be considered retrospectively
(i.e. after an analysis has been performed, by modifying the adequacy factor to account for the use
of a different effective width and live load intensity).

Traction / braking forces

LimitState:RING 4.0 does not apply horizontal forces at road level (e.g. to model traction/braking
forces). However, it is possible to apply user-specified forces (as pressures) directly to blocks within
arches and/or piers (see Section 22.1.3).

Axle lift-off

If the vertical road alignment is very sharply curved (e.g. in the case of a ‘hump back’ bridge) then
there is also a need to consider the possibility of ‘axle lift off’. This means that the axles that remain
in contact with the bridge apply greater loading than normal. In this scenario, standard vehicles can
be renamed and individual axle loads edited as appropriate by the user.
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(a) Automatically computed effective width using default parameters based on axle width; minimum fill
depth below axle and load distribution parameters

(b) Possible reduced user-specified effective width due to longitudinal cracks

(c) Possible reduced user-specified effective width due to proximity of adjacent lane and edge of bridge

Figure 8.5: Transverse dispersal and effective bridge widths (highway)
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Investigating other bridge behaviour

9.1 Identifying the causes of observed cracks using the ‘Support
Movement’ feature

The option to model support movements in LimitState:RING 4.0 opens up a range of possibilities,
including the capability to investigate the likely causes of observed cracks in an existing bridge
structure. By imposing support movements and comparing the actual and modelled deformed shapes,
it is possible to get a sense of the various possible underlying causes of the cracking; e.g. to see
whether these are consistent with vertical, horizontal or perhaps angular settlement of one or more
of the piers or abutments (Figure 9.1).

The observed response of a settled bridge can also be used to verify the model idealization. A settled
bridge can be considered to be of almost the same value as a load test to collapse. This is because
when a bridge undergoes settlements, many of the same modes of resistance are mobilized as when
a bridge is subjected to excessive live loading. Therefore it is very useful to try to correlate actual
and modelled behaviour (e.g. if it is necessary to include backing in the numerical model in order to
replicate the observed mode of response, then this strongly indicates that backing, or very strong fill
material, is present in the real structure - and potentially also in similarly constructed structures in
the area. This can then be included in subsequent load factor analyses).

9.2 Exploring load paths under service loads

Masonry arch bridges are multiply statically indeterminate structures, and true load paths are there-
fore typically difficult to ascertain. It is tempting for the engineer to undertake an elastic analysis
to investigate service load behaviour. However, the solutions gained will only be accurate if the
initial stress conditions and elastic properties are established. Otherwise, misleading indications of
the bridge response can be obtained.

Alternatively, using the support movement feature in LimitState:RING 4.0, various limiting scenarios
can be investigated. Vehicles can be run across a bridge with imposed support movements to
investigate load paths, and to see whether the hinge positions move (if they are predicted to move
significantly in the model under traffic, and if secondary stiffening elements such as securely attached
spandrel walls are not present in reality, then this might be a cause for concern; continual opening
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and closing of joints may lead to incremental damage to the structure).

One limiting scenario that is likely to be of interest is that which follows the removal of the centering
following initial construction. It is at this point that many bridges appear to ‘bed down’ to a statically
determinate (or near-statically indeterminate) state. This state can be approximately replicated by
moving the supports appropriately in LimitState:RING 4.0. (e.g. moving the supports of a single-span
bridge outwards). Again, vehicles can then be introduced and load paths established. If necessary
an adequate margin of safety can be ensured by applying a suitable partial factor to the axle loads,
with the software indicating whether or not the structure remains stable.

Figure 9.1: Identifying the causes of pre-existing cracks using the support movement feature

9.3 Modelling bridge spans with intermediate supports

Assessment engineers are sometimes required to analyse a masonry arch bridge containing spans that
have been propped. Whilst such propping is not in general recommended as a remedial measure, if
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these are present then LimitState:RING 4.0 can model the likely effects. For example, suppose that
the crown of an arch was propped, this can be modelled by specifying that one or more blocks at
the crown are restrained in the vertical (y) direction. The failure mechanism is altered accordingly
(Figure 9.2).

Figure 9.2: Using LimitState:RING 4.0 to mimic the effect of a midspan prop
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Chapter 10

Interpreting output

10.1 ‘Adequacy Factor’

The output from a standard LimitState:RING 4.0 analysis is the Adequacy Factor (AF ) (see Section
5.3.1). Considering a ULS analysis, possible outcomes are indicated in Table 10.1.

In some circumstances, an apparently adequate structure will be found to either be unstable under
its own self-weight, or to have a very low computed adequacy factor (i.e. outcomes (i), (ii) or (v)).
In such a case, the input parameters used for the analysis should be carefully reviewed and revised if
necessary; changes to some input parameters (especially the arch profile) can have a major influence
on the computed adequacy factor.

Alternatively, it is possible that features not included in the model are, in reality, significantly altering
the load-carrying capacity of the structure. In this case, recourse to an alternative analysis procedure
may be necessary. If outcome (iv) is obtained then it is generally worthwhile to re-run the analysis
with finite masonry crushing strength so that a solution can be found.

10.2 ‘Adequacy Factor’ chart

For analyses containing multiple scenarios and / or ‘Auto’ load case designations, the calculated
ULS or PLS Adequacy Factor will be accompanied by a chart outlining the numeric result plotted
against the position of the leading axle of the primary vehicle. For example, see Figure 10.1:
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Outcome Scenario Explanation
(i) AF < 0 Structure unstable under the action of dead

loads (it would require the applied live loads
to be negative [i.e. acting upwards] to stand)

(ii) 0 ≤ AF ≤ 1.0 Bridge stable under own self-weight but un-
able to carry the specified applied live loads
(able to carry AF× applied load)

(iii) 1.0 ≤ AF Bridge able to carry specified applied live
loads (able to carry AF× applied load)

(iv) AF could not be deter-
mined (‘locked’)

Structure ‘geometrically locked’ (e.g. for
a very thick arch with infinite crushing
strength)

(v) AF could not be deter-
mined (‘unstable’)

Structure unstable under action of dead loads
(e.g. for a very thin or distorted arch)

Table 10.1: Computed ULS Adequacy Factor (AF): possible scenarios

Figure 10.1: Chart of Adequacy Factor plotted against vehicle Load Position for a multiple scenario
analysis

The chart is interactive and can for example be employed to visually determine whether different
loading conditions might result in similar bridge responses or highlight parts of the structure where
overloading from any vehicle may be problematic.
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10.3 Mode of response

LimitState:RING 4.0 provides the user with a valuable visual representation of the predicted mode
of response of the structure, either at failure or when support movements are imposed.

A mechanism is mobilized when sufficient releases in the structure are made. In the case of a single-
span, single-ring masonry arch, the structure has three degrees of redundancy. This means that 3 +
1 = 4 releases are required for a ‘complete collapse mechanism’ (e.g. four hinges; three hinges and
one sliding plane; etc). Multi-span and multi-ring arches have greater degrees of redundancy and so
generally require more releases. However, it is also possible for either fewer releases to be required
(giving rise to an ‘incomplete collapse mechanism’) or for a greater number of releases to be present
(giving rise to an ‘overcomplete collapse mechanism’). In any event, the user should satisfy themself
that the postulated mechanism is achievable in practice.

Features of failure mechanisms:

• For a given adequacy factor the mechanism of failure is not necessarily unique (i.e. there may
be two or more failure mechanisms that correspond to the same adequacy factor).

• Since the analysis is based on small displacement theory, scaling the displacements too much
will lead to distortion (Figure 10.2(a)).

• When the mechanism includes sliding, the ‘sawtooth’ friction model will ensure that sliding
is accompanied by dilatancy (i.e. visible separation of the blocks; Figure 10.2(b)). This is
perfectly normal.

(a) hinging (b) sliding

Figure 10.2: Scaled deformation, leading to distortion: a) due to small displacement theory; b) due
to ‘sawtooth’ friction

In some cases it will be observed that the critical failure mechanism identified cannot occur in practice
(e.g. there might, in reality, be some obstructing element that prevents a pier from rotating in the
manner indicated in the failure mechanism). In this case, the model should be modified as appropriate
and the analysis re-run.
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10.4 Zone of thrust / internal forces

At the point of failure the internal forces are (just) in static equilibrium with the applied dead and
live loads. The most useful visual indicator of how the compressive force is transmitted through the
masonry is the line of thrust. This will always stay within the masonry in order to satisfy one of
the stipulated yield conditions. Additionally, forces are also transmitted through contacts between
inter-ring boundaries, if present.

It is often useful to examine forces at specific locations in the bridge, for example, to facilitate
subsequent checks that the abutments can withstand the thrust from the arch.

Note that the distribution of internal forces is only uniquely determined in parts of the structure that
are at the point of collapse. Thus, although details of a distribution of internal forces for the entire
structure will be displayed, it must be borne in mind that, remote from the zone of failure, this is
simply one of many possible distributions.
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Chapter 11

The Graphical User Interface (GUI)

11.1 Introduction

The LimitState:RING 4.0 Graphical User Interface (GUI) is designed to give the user maximum
flexibility over defining the problem and setting problem parameters. The default LimitState:RING
4.0 screen is divided into a number of areas as shown in Figure 11.1.

Figure 11.1: Areas utilized in LimitState:RING 4.0

The areas shown by default are as follows:

• Title bar

• Menu bar area

• Top toolbar area
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• Left hand toolbar area

• Viewer pane

• Property Editor

• Output pane

• Status bar

In addition, the Chart will be displayed by default for problems involving one or more load cases.

A brief overview of each area is given in the following sections. A fuller description is given in later
chapters. A full list of toolbar and menu items may be found in Chapter 22.

Additional items not shown by default are the:

• Calculator

• Block explorer

• Contact explorer

• Vehicle explorer

• Scenario explorer

11.2 Title bar

The buttons Minimize, Restore Down and Close may be accessed by left-clicking the relevant
icons at the right end of this bar or the program icon at the right. These functions, as well as Move,
Maximize and Resize may also be accessed via the context menu by right-clicking anywhere on the
bar.

11.3 Menu bar

Menu bars may be expanded by left-clicking on the relevant icon. There is no right-click functionality
on this bar.

11.4 Toolbars

Toolbar buttons may be activated by left-clicking on them. Right-clicking on any part of a toolbar
brings up the explorer and toolbar selection context menu, as depicted in Figure 11.2. Tooltips
are available by hovering the mouse over any button for a short period. Further description of the
toolbars may be found in Section 23.4.
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Figure 11.2: Explorer and toolbar selector

Some toolbar icons are accompanied by a dropdown arrow (e.g. the Select icon Figure 11.3). In
these cases, clicking on the arrow will bring up a selection of options to choose from (e.g. Click,
Rectangle or Lasso select).

Figure 11.3: The expanded Select dropdown menu

11.5 Viewer pane

This pane displays the current problem geometry. It provides access to user-editable geometry objects.
Properties may be edited using the mouse or keyboard or both depending on their nature.

Specific geometry objects (e.g. Contacts or Solids) may be selected by left-clicking with the mouse.
The properties of the objects are then displayed in the ‘Property Editor’ (Section 11.6).

Right-clicking the mouse in the Viewer pane brings up the viewer context menu. From here, amongst
other options, it is possible to modify the way in which objects are selected and manipulate the image
(e.g. pan, zoom or rotate in 3D space).
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Figure 11.4: The Viewer pane context menu

11.6 ‘Property Editor’

The Property Editor provides core access to problem parameters in a direct and intuitive way. In
general, the properties of any material or geometry object may be displayed simply by selecting it
in the Explorer or the Viewer pane. In addition, global project level parameters may be displayed
at any time by left-clicking on an empty part of the Viewer pane with the mouse. The Property
Editor is shown in Figure 11.5.

Single-clicking on any item in the Property column of the Property Editor gives an expanded
explanation of the parameter in the window at the base of the Property Editor.

A symbol next to an item in the Property Editor indicates a collapsed tree and that there

are additional sub-parameters relating to that item that may be viewed. Click on the symbol
to expand the tree and access these. Left-clicking on a value in the Property Editor allows you
to modify it by typing or selecting your choice (unless it is read only). For specific parameters, a
clickable button may also appear in the field that gives access to a further dialog to provide additional
functionality.

The Calculator may be accessed in any numeric data entry cell.

Right-clicking on items that have been selected, brings up a context menu relevant to that item.

Further information about properties that can be edited is given in Section 22.1.
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Figure 11.5: Project properties displayed in the Property Editor

11.7 Output pane

Full details of the analysis results are provided in the Output pane (e.g. see Figure 11.5).

c© LimitState Ltd



104 CHAPTER 11. THE GRAPHICAL USER INTERFACE (GUI)

c© LimitState Ltd



Chapter 12

‘New Project’ types

When starting a new project , a number of options are available (Figure 12.1):

Figure 12.1: The New Project dialog

Wizard Create a new project from scratch, using a geometry and properties that you define yourself.

Template Create a new project using analysis and material settings loaded from an existing file.

DXF Create a new project with a geometry that has been defined in a DXF file.

12.1 Wizard

Using the built-in ‘New Bridge Wizard’ is the primary method for defining a new model. Here, the
user is guided, step-by-step, through the different aspects of the model and prompted to provide
details to build up the problem, such that it is ready to solve at the end.

The framework of the Wizard is also used in the other New Project options. However, in those
cases, some of the information is provided using pre-prepared files.

The main stages of the Wizard are as follows:

Project Details General information about the model (such as the bridge type) along with specifi-
cation of the effective bridge width (or how it should be calculated).
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Geometry Defines the bridge geometry (abutments, spans, piers and fill profile) in a sequential
workflow from left to right.

Partial Factors Specifies the partial factors to use in both Ultimate Limit State (ULS) and Permis-
sible Limit State (PLS) analyses.

Materials Defines the material properties for the masonry, backfill, backing and surface fill (along
with the load dispersion and spandrel zone behaviour).

Loads Add pre-defined load vehicles to the problem, from the built-in library, or define new ones.
Specify one or more loading scenarios for analysis.

Many properties of the bridge may not be known in advance (for instance, it can sometimes be
troublesome to determine the exact nature of backfill material without intrusive and expensive inves-
tigations). For this reason, the Wizard offers default properties and values for all fields. This means
that a solvable model will always result once Finish is clicked. The default properties are chosen to
be realistic, whilst avoiding being either overly conservative or non-conservative. In order to achieve
the best results, it is advisable to ensure that as many parameter values are sourced from first-hand
data as possible and that all fields are checked before solving.

More information about the use and features of the New Bridge Wizard is given in Appendix D.

12.2 Template

Any LimitState:RING file can be used as the template for a new model. This is useful when, for
instance, a large number of structures need to be assessed to the same code of practice.

After selecting the Template option in the New Project dialog, the user is prompted to browse for,
and select, an existing LimitState:RING file. The following properties will then be pre-loaded into
the Wizard:

• Partial safety factors (both PLS and ULS)

• Masonry properties

• Backfill properties (excluding the ‘Advanced’ ULS and PLS properties)

• Surface fill / track properties

The remaining model details (e.g. bridge geometry and loading) are then specified manually.

A number of template files for existing codes of practice (e.g. CS454, CIRIA C800) are installed with
the software and are available to use from the ‘Templates’ folder, which can be found at the top
level in the installation directory. By default, this is:

C:\Program Files \LimitState \RING4.0 \templates
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12.3 DXF

For bridge geometries that are not easily defined using the Wizard, a pre-prepared DXF file can be
used instead. By selecting the DXF option for a new project, the Geometry part of the Wizard is
replaced with a series of dialogs to select and interpret this DXF geometry. The remaining model
details (e.g. bridge type, materials and loading) are then specified manually.

There are a number of important considerations that must be taken into account when preparing
a DXF file for use in LimitState:RING. More information about the use and features of the DXF
Import functionality is given in Section 15.
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Chapter 13

‘Project Details’

To edit the project details, on the Tools menu click Project Details. Alternatively, the command

may be accessed via the keyboard shortcut by pressing Ctrl+1 or by clicking the clipboard icon
on the Properties toolbar. The Project Details Dialog is shown in Figure 13.1:

Figure 13.1: The Project Details Dialog

13.1 Required details

Many of the details that can be specified in the Project Details section are optional. However,
there are three choices that require attention:
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13.1.1 Bridge type

Here the user must specify whether the bridge under consideration is subject to loading from a
highway or a railway. The choice made will determine what information is required / displayed
during modelling and analysis. By default, the Highway option is highlighted.

13.1.2 Effective bridge width

Here the user must specify whether the bridge under consideration is of a fixed width or, alternatively,
if a calculated width will be used.

Loading from vehicles will tend to spread transversely as it passes through the underlying fill material.
This means that a 1.8m wide load on the surface may, for example, be spread across a 3m width at
arch level.

By default, LimitState:RING 4.0 assumes a constant specified effective bridge width of 2500mm.
However, if the user selects the option to Auto-compute, LimitState:RING 4.0 can automatically
calculate the effective width of a bridge according to the width of loading at the base of the fill as
follows:

effective width = specified axle/sleeper width + amount of load spread at the loaded axle/sleeper
with minimum fill depth + extra distance to account for distribution within the arch

By default, the effective bridge widths are calculated assuming a full spread of load to both sides of
the loading vehicle, using the values in Figure 13.2 (see also Chapter 8):

Highway bridge ‘auto-compute’ defaults

The Highway bridge ‘auto-compute’ defaults are given in Figure 13.2:

Figure 13.2: Default values for calculation of Effective Bridge Width (Highway)
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Railway bridge ‘auto-compute’ defaults

The Railway bridge ‘auto-compute’ defaults are given in Figure 13.3:

Figure 13.3: Default values for calculation of Effective Bridge Width (Railway)

13.2 Optional details

Useful details that the user may wish to specify are:

• Bridge name

• Reference No.

• Location

• Map reference

• Assessor name

• Assessor organization

• Comments

These attributes are displayed in the Property Editor (Section 22.1) and also in the Summary
section of the Report output (Chapter 26).
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Chapter 14

Bridge geometry (wizard)

The bridge geometry can be specified in the geometry section of the Wizard (Section 4.3) or by
clicking on Geometry in the Tools menu (Section 23.3.5). Alternatively, the command may be

accessed via the keyboard shortcut by pressing Ctrl+2 or by clicking the Geometry Dialog icon
on the Properties toolbar.

14.1 ‘Geometry Dialog’

The Geometry Dialog is depicted in Figure 14.1:

Figure 14.1: Geometry Dialog box
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14.2 Abutments

To edit the geometry of an abutment, simply click on the relevant tab within the Geometry Dialog
to display the dialog in Figure 14.2:

Figure 14.2: Geometry - abutment properties

14.2.1 Default abutment model

By default, LimitState:RING presumes that all abutments are constructed similarly in that they are
constructed from a single, fixed block with no backing above them.

To specify that an abutment is overlain by backing material, simply enter a suitable value in the
Backing height box (see Section 5.8.4).

14.2.2 Modelling abutments explicitly

To override the default abutment model, check the box labelled Explicitly Model. This will enable
a number of additional fields:

Fill behind abutment Model fill behind the abutment blocks (i.e. assuming a retaining wall). This
is selected by default. Unticking this box will cause the software to omit fill and assume the
presence of a freestanding end pier.

Vertical intrados Takes effect if the top and bottom thicknesses of the abutment are different. By
default, the intrados face of the abutment will be regarded as vertical, with any difference in
thickness occurring at the extrados side. Unchecking this box will cause the model to assume
an even widening or narrowing of the abutment at each side.
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Backing below springing height Where fill is present behind the abutment and a positive backing
height above the springing level is also specified, checking this box will cause that backing to
also extend below the springing.

Fill behind abutment Model fill behind the abutment blocks (i.e. assuming a retaining wall).
Unticking this box will cause the software to omit fill and assume the presence of a freestanding
end pier.

Height The height of the end abutment, measured vertically to the springing point of the span.

Thickness at top The (horizontal) thickness of the abutment block at the top of the abutment.

Thickness at base The (horizontal) thickness of the abutment block at the base of the abutment.

Number of blocks The number of blocks that form the abutment (not including the support or
skewback).

Note: in previous versions of LimitState:RING, fill pressures were assumed not to act behind abutment
blocks, so the explicit abutment modelling option will be unchecked when opening files created in
them.

Masonry backing

To specify that the current section of the bridge has both fill and masonry backing, enter a value in
the Backing height over abutment field.

Backing is modelled by the inclusion of horizontal fill elements in the analysis. These elements are
positioned in the spandrel void area(s) and behind end abutments, and are initially in contact with
every block below the specified backing height. The use of fill elements in the analysis to represent
backing means that:

• vertical fill pressures (from fill self-weight and/or the applied loading) are not affected by the
presence of backing;

• the ‘automatic identification of passive zones’ option must be selected when backing is specified
(this is the default setting in LimitState:RING);

• the precise areas where backing is present can be edited; and

• the crushing strength of the backing material can be modified (a default value of 5MPa is
assumed).

When backing is specified, only masonry blocks that have a vertical centroid below the specified
backing height are (conservatively) assumed to be subject to restraint from the backing. This
restraint is assumed to act in compression only (i.e. one direction), so as not to artificially prevent
an arch from peeling away from the backing material.

Note:

1. The backing idealization described above effectively assumes that relative sliding between the
arch and backing does not occur. Thus, backing should only be safely included where the angle
between the line drawn tangentially to the arch extrados and the horizontal is suitably large.
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2. The unit weight of the backing is assumed to be the same as that of the fill material. If this
assumption is grossly inaccurate, the vertical pressures applied to the back of the arch should
be adjusted.

14.3 Spans

To edit the geometry of a span, click on the relevant tab to display the dialog in Figure 14.3:

Figure 14.3: Geometry - span properties

For all span types, there are options to specify the number of blocks (units) used for the span and
the thickness of the ring.

14.3.1 Number of rings

The Type drop-down offers a choice from three types of voussoir:

Stone voussoir The span is (or acts as if it were) a single ring of stonework masonry.

Bonded brick The span consists of multiple rings of masonry that act as if they were one (e.g. if
the barrel contains ‘header’ bonded brickwork, where certain bricks are laid ‘end-on’ to provide
a mechanical connection between rings).
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Multi-ring The rings of a span are modelled as separate entities, separated by default using only
frictional contacts (this should be used e.g. if ring separation, also known as ‘delamination’ has
occurred). Where a discernible shear-bond strength is evident, which can inhibit separation,
this can be applied globally via the Materials Dialog or individually using the Property Editor.

Note: a multi-ring analysis is often more computationally expensive than a single-ring analysis.

14.3.2 Arch type

As well as the type of voussoir, LimitState:RING 4.0 gives the option to select from several types of
arch shape for each span. These are described below:

Segmental A segmental arch shape assumes that the curvature of the span follows the shape of
a single segment cut from a circle (defined using the span and rise measurements entered by
the user). By clicking on the Advanced button, the user is given the option to specify the
abutment angles. By default, the Auto-calculate feature is selected. By unchecking this box,
measured angles can be entered.

User-defined (multi-segment) A multi-segmental arch shape assumes that the curvature of the
span follows the shape of multiple segments formed from different circles, based on a series of
user-defined points.

User-defined (interpolated) An interpolated arch profile uses an interpolated ‘best-fit’ b-spline
based on a series of user-defined points.

Three-centered (pseudo-elliptic) A three-centered (pseudo-elliptic) arch profile assumes that the
arch profile is formed from segments of three circles using the crown rise and span measure-
ments.

Pointed A pointed (or ‘Gothic’) arch profile is formed using a segment of a circle, determined using
the quarterspan rise, crown rise and span measurements, then mirrored along a vertical line at
midspan.

User-defined profiles

By opting for a user-defined arch profile, non-uniform shapes can be accounted for. When selected in
the drop-down menu, a user-defined option will display a table in which to enter x and y coordinates
of points around the intrados of the arch.

Note: the positions of all points on each arch should be measured relative to point 1 (which will
have coordinates [0,0]). Subsequent points should be entered in order of increasing x distance.

14.3.3 Number of units

Enter the number of masonry units you wish to model in the ring.

Note: sufficiently accurate results can generally be achieved by modelling only a proportion of the
actual physical units in a given ring (e.g. the default of 40 units per ring is often acceptable for
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a medium-span arch); this often reduces run times considerably with only a moderate reduction in
accuracy. However, it should be noted that collapse load predictions obtained using this strategy may
be slightly non-conservative if contact surfaces are not present at, or close to the critical locations.

14.3.4 Ring thickness

Enter the ring thickness in mm.

User-defined rings also have the option to have a non-uniform thickness. By unchecking the Assume
uniform ring thickness box, a further tab is added to the coordinates panel in which extrados ring
points can also be added (using the same method as for the intrados). The ability to turn off the
Bed joints normal to intrados option also becomes available.

For multi-ring spans with non-uniform ring thicknesses, the wizard requires that the coordinates
along the end contact surface (i.e. between the end abutment and the end span blocks) all lie along
a straight line. This requirement is not enforced when a DXF geometry is used as the basis of the
model.

14.3.5 Inserting a span

LimitState:RING 4.0 allows the user to insert new spans into the project without having to build the
whole bridge again from scratch. Simply select the tab of a span adjacent to the place where a new
one is to be inserted and click the Insert Left or Insert Right button. A new span and new pier will
then be added and the focus shifted to the Pier tab. LimitState:RING 4.0 will also automatically
renumber all the existing objects to accommodate these changes. The inserted span will assume
the geometry of the original selection, but this can be adjusted manually. However, the material
properties will retain the default values.

14.3.6 Deleting a span

LimitState:RING 4.0 also allows the deletion of spans. After selecting the span to be deleted in
the Geometry Dialog (by clicking the appropriate tab), and clicking the Delete span button,
LimitState:RING will either choose the associated pier to delete (if the span is connected to an
abutment) or ask the user to decide (where the span is not connected to an abutment). Re-numbering
of the remaining objects will be done automatically.

14.4 Piers

To edit the geometry of a pier, simply click on the relevant tab to display the dialog in Figure 14.4.
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Figure 14.4: Geometry - pier properties

14.4.1 Default pier model (even springing heights)

By default, LimitState:RING presumes that all piers are constructed similarly, in that they:

• are 1000mm high by 1000mm wide (at both the top and the base);

• are constructed from ten blocks;

• have no backing above them; and

• the springing height at the left and right side are at the same level.

14.4.2 Modelling piers explicitly

To override the default pier model, simply enter new values in the relevant boxes of each pier. Aspects
that can be modified include:

• Height

• Thickness at top

• Thickness at base

• Number of blocks

• Backing height (see Section 5.8.4 for more details)
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14.4.3 Uneven springing heights

LimitState:RING 4.0 can also accommodate piers exhibiting uneven (offset) springing heights. To
specify such a geometry, select the appropriate option in the Springing Offset group. Doing this
will bring up a new group in the dialog with a number of additional fields, as shown in Figure 14.5:

Figure 14.5: Geometry - offset pier properties

Height of offset The vertical distance between the top of the lower skewback and the bottom of
the upper skewback block.

Number of blocks in offset The number of blocks comprising the offset (not including the skew-
backs).

Auto-calculate thickness When checked, the thickness of the offset section is determined auto-
matically, based on the top thickness of the underlying pier and the thickness of the adjoining
span.

Height of offset If ‘auto-calculate’ is unchecked, a user-defined value for the thickness of the offset
can be entered.

14.5 Fill profile

To edit the upper and lower profiles of the surface layer, simply click on the Fill Profile tab to display
the dialog in Figure 14.6.

Taking the left springing position of the first arch as the origin, enter the x and y coordinates at a
point on the lower edge of the surface fill (highway) or ballast (railway) and give the depth at that
point.
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x The horizontal distance from the left springing point of the first arch (mm).

y The vertical distance from the level of the left springing to the base of the surface fill (mm).

Surface fill / ballast depth The depth of surface fill or ballast from the top surface to point (x,y)
(mm).

Figure 14.6: Geometry - Fill Profile

Note:

1. The x and y distances are always relative to the left intrados springing of Span 1.

2. User-defined fill profiles are formed from a series of straight lines that intersect the points
specified.

3. The slope of the fill at each end of the structure will be continued for any additional distance
that is automatically added by the software.

4. The depth of the surface layer can be set to zero if required.
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Bridge geometry (DXF)

15.1 Importing a DXF geometry

By selecting the DXF option in the Quick Create dialog, users can define more complex bridge
geometries and structural features than may otherwise be created via the wizard. However, the
geometry of a DXF file must obey a number of conditions. If these conditions are not satisfied, a
successful import of the model is less likely to occur.

After passing through the Project Details Dialog, the user will be presented with a series of tabs.
The first of these tabs is an informational Prep dialog, which graphically outlines the do’s and
don’ts of preparing the DXF file for import into LimitState:RING 4.0. Users should take the time to
familiarise themselves with these rules, as it will help with the workflow in future analyses.

15.1.1 DXF contact creation

Two methods of creating the contacts in the problem are provided, with the option for the software to
choose the most appropriate without the need for user intervention. In both instances, the software
first looks for closed loops of lines in the DXF and creates blocks based on these.

Intersections Contacts are created along edges wherever two blocks meet.

Proximity contacts Contacts are created based on rules regarding the compared lines. If the lines
are within a maximum distance factor (default = 0.1, or 10% of the length of the shortest of
the two lines being compared) and the angle between them is below a predetermined maximum
value (default = 10 degrees), a contact is created. This is useful for interpreting files where
there may be lots of very small overlaps of blocks, which would be too tricky to remove from
the DXF manually.

Auto The software determines the algorithm most likely to result in an acceptable outcome.

The second tab is used to select the DXF file that will be imported and the method of Contact
Creation that is used.
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15.2 Preparing a DXF geometry

An example of a simple, but well-constructed geometry is shown in Figure 15.1. The surface profile
may be omitted if desired - a zero-thickness surface layer will be auto-generated if one is not supplied.

Figure 15.1: Example of a well-constructed DXF geometry that can be read into LimitState:RING

The following sections describe the functionality and outline the best practices when preparing DXF
files for import.

15.2.1 Blocks are formed from closed loops of lines

LimitState:RING generates blocks by identifying closed loops of lines. For example, if the lines
highlighted in green in Figure 15.1 are omitted, the fill block will not be identified and created. The
intersections of overlapping lines can be automatically identified, or considered with their proximity
to each other in mind (see Section 15.1.1).

Open loops are often the main reason for a DXF import failure. Files that have been created quickly,
or without import into LimitState:RING 4.0 in mind, can often include very small gaps that prevent
closed loops from forming. It is recommended that the CAD program’s ‘object snap’ functionality is
carefully applied when preparing the DXF.

15.2.2 Blocks have only a single edge exposed to the fill

Backfill forces are calculated assuming a single edge of a block is exposed to the fill. Where more
than one exposed edge is present, LimitState:RING will determine forces for the edge that has the
largest vertical exposure to the retained fill, and use these in calculations. Files for which this ‘single
edge’ condition has not been obeyed will generally still import and solve, but the backfill forces may
not be calculated correctly.

An example of this is shown in Figure 15.2. Backfill force values on the block with the magenta-
coloured edges will not be reliable (only the force for the edge with the largest vertical exposure to
the fill will be calculated).

c© LimitState Ltd



CHAPTER 15. BRIDGE GEOMETRY (DXF) 125

Figure 15.2: Avoid blocks that have multiple edges that are exposed to the fill

15.2.3 Support blocks must extend to the x-limits of the surface layer

Some automatic modifications to the fill block are made after importing (they are necessary for the
backfill force calculations). These will not be completed correctly if the support blocks at either
end of the bridge do not extend horizontally as far as the extent of the backfill. An example of the
situation to avoid is shown in Figure 15.3 in magenta. Support blocks that extend past the limits of
the surface layer do not cause an issue (green).

Related to this, one cannot apply a single support block that underlies the entire problem. There
should always be separation and two or more supports present in the problem.

Figure 15.3: Support blocks must extend to the extent of the fill

15.2.4 Only one backfill block

Only one backfill block should be provided and, as with other blocks, it must be formed from a
continuous series of lines. Similarly, all masonry blocks must form part of a single connected group.
If this rule is not obeyed, the fill block will not be generated.

A correct geometry is illustrated on the right-hand side of Figure 15.3, with the fill block edges
highlighted in cyan. An incorrect geometry is shown on the left, in which a support block (magenta)
has been divided into two, with a fill line in between them.
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Figure 15.4: Only one backfill block should be specified when importing from DXF and masonry
should form part of a single, connected group

15.2.5 No single vertex connections

No fill-connected masonry block should share only a single vertex with the rest of the masonry blocks.
Files with a similar geometry to that shown in Figure 15.5 will cause problems. If the fill block (A)
surrounds two masonry blocks (B and C) and these share just one vertex, then the fill block will not
be generated.

Figure 15.5: No fill-connected masonry block should share only a single vertex with the rest of the
masonry blocks

15.2.6 Only use lines or polylines

Only lines and polylines should be used in an imported DXF file. While some other features e.g.
arcs may be imported by the software, the fill forces on blocks constructed using them will not be
calculated reliably.

15.2.7 Separate openings with several blocks

In Figure 15.6, the orange object is an opening. The two blocks connected to the opening (above
and below) share disconnected edges (shown in magenta). Attempting to import a file with such a
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geometry will not be successful. Instead, add lines around the opening to simplify the surrounding
blocks and remove disconnected, but shared edges (green).

Figure 15.6: Simplify the structure around openings to avoid two objects containing an enclosed
opening

15.2.8 Layer rules

LimitState:RING is capable of auto-assigning block types (fill, surface, masonry, support) without
the need for user input if the lines from which these blocks are formed are assigned to the correct
layer.

Edges that form part of a block should be assigned onto the appropriately named layer. These are:

• ‘Support’ or ‘Fixed Block’

• ‘Backfill’

• ‘Opening’

• ‘Surface’

• Blocks are assigned as ‘Masonry’ by default, so the layer name is the same for arch, pier, or
skewback blocks.

Where a block of one type shares an edge with a block of another type, the layer to which the edge
should belong depends on the type of the two blocks. Block type assignment obeys the following
rules:

• The block with the most lines on the ‘Fill’ layer is assigned to be a fill block.

• The block with the most lines on the ‘Surface’ layer is assigned to be a surface block, unless
this is the fill block, in which case, the block with the second most lines on the ‘Surface’ layer
is chosen.

• Blocks with edges on the ‘Support’ and ‘Opening’ layers are required to have at least three
edges on that layer before being assigned as that type.

• All remaining blocks are assigned as ‘Masonry’.
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Following these rules, the layer setup should typically look like that shown in Figure 15.7, where:

• Cyan = Fill

• Orange = Surface layer

• Green = Supports

• Black = Masonry

Figure 15.7: Appropriately named DXF layers will be auto-assigned upon import

15.3 Importing a DXF geometry

Once a geometry has been prepared in the correct manner, it is a simple process to import it into
LimitState:RING:

1. After opening the software, or after selecting File >New, select the DXF option in the New
Project dialog.

2. After setting the project details, click Next> until the Geometry tab is selected. Click
Browse... and select the DXF file that you wish to import.

3. After the file has been imported, the Imported Layers dialog will open. If edges have been
assigned to layers for automatic block type assignment, check that each layer corresponds to
the correct block type. If necessary, these can be reassigned by double-clicking on a field under
the Imported Objects column. Click Import when finished.

4. After importing, drag the wizard to a position that allows the bridge to be seen and ensure
that all blocks have been generated correctly. If blocks are missing, then there is some problem
with the geometry (see Section 15.2).

5. Once you are satisfied that the geometry has been imported correctly, click Next> on the
wizard to move onto the Objects tab. Here, the types of individual blocks can be reassigned.
Click Select to assign the blocks to that particular type. Click Clear to clear the type of all
blocks belonging to the currently assigned type.
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Partial factors

Partial factors are multipliers and divisors that are applied to loads and / or material properties
in advance of analysis. With a set of partial factors specified, the adequacy factor computed by a
LimitState:RING 4.0 analysis merely needs to be 1.0 or above to indicate that the model is considered
compliant with the code of practice being used.

LimitState:RING 4.0 has been designed to be ‘code agnostic’. That is, the assignment of partial
factors on load, material strengths etc. is left entirely up to the user. However, the defaults are
set such that ULS and PLS analyses are broadly aligned with the requirements of codes such as the
UK code for highway bridges, CS454 (National Highways 2022) and also CIRIA C800 (Gilbert et al.
2022).

The available partial factors are detailed in Table 16. They can be overridden via the Partial Factors

Dialog :
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Partial Factor Symbol ULS PLS Notes
Vehicle Loads (multipliers on vehicle loading)
Axle load γf,l 1.5 1 Applied to variable load from vehi-

cle axles

Dynamic / impact γf,dyn 1 1 Applied to axles where a ‘Dynamic
/ impact’ (see Section 18.3.5) fac-
tor has been set

Load effects γf,3 1 1 Takes account of uncertainties in
modelling the effects of loads
(equivalent to a model factor), ap-
plied via the vehicle loading

Material Loads (multipliers on material unit weights)
Surface fill / ballast unit weight γf,sf 1 1 Load factor - applied to permanent

load from surface fill / ballast

Masonry unit weight γf,m 1 1 Load factor - applied to permanent
load from masonry

Fill unit weight γf,f 1 1 Load factor - applied to permanent
load from backfill and backing

Track load γf,t 1 1 Applied to permanent load from
track

Material Strengths (divisors on material strength)
Masonry compressive strength γm,ms 1 2 Material factor - applied to ma-

sonry crushing strength

Masonry shear bond strength γm,ma 1 2 Material factor - applied to ma-
sonry shear bond strength (adhe-
sion)

Masonry friction γm,mf 1 1 Material factor - applied to ma-
sonry friction coefficients

Table 16.1: Default Partial Factor values, symbols and meanings
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Material properties

The properties of all project materials can be found and modified within the Materials Dialog (click
Tools >Materials).

Alternatively, the command may be accessed via the keyboard shortcut (Ctrl+4 where a project is

already defined) or by clicking the Materials Dialog icon on the Properties toolbar.

Any of these actions will open the dialog shown in Figure 17.1.

Figure 17.1: Material properties dialog box
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17.1 Masonry

17.1.1 ‘Specify properties for’

The Specify properties for: drop-down box on the Masonry tab allows the user to change the
properties of different masonry features within the project:

All Masonry

This is the default option and changes made here will affect the material properties of all masonry
objects. The tab for All Masonry remains on show, whichever option is chosen in the drop-down.
This allows the user to get an overview of the project and make wholesale changes if this is required.

Spans — Piers and Abutments — Skewbacks and Offsets

Selecting this option generates three further tabs in the properties box:

1. All spans - alterations made here affect all spans in the project.

2. All piers - alterations made here affect all piers in the project.

3. All skewbacks - alterations made here affect all skewbacks in the project.

Note: versions of LimitState:RING prior to 4.0 provided a third option to specify the properties of All
bridge parts individually. In LimitState:RING 4.0, the inclusion of offset piers and DXF-generated
geometries make this impractical. However, the ability to select and modify individual objects using
the Lasso select means that the workflow for creating a fully bespoke model is quicker and easier
than ever.

17.1.2 Unit weight

Here, it is possible to specify the Unit Weight (in kN/m3) of the masonry features under consider-
ation.

17.1.3 Model crushing

By default, crushing is modelled, with the default crushing strength taken as 5N/mm2. To model
the blocks as being rigid, uncheck the Model crushing? option and enter a compressive strength
for the material under consideration.

Note:
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1. When crushing strength is included in the analysis the problem becomes non-linear, and several
iterations will normally be required before a converged solution is obtained. This means that the
computational effort required to obtain a solution is increased. LimitState:RING uses a highly
robust solution scheme, obviating the need to specify convergence tolerance etc. (required
with LimitState:RING 1.x).

2. In LimitState:RING a moment vs. normal force failure envelope assumes a ductile masonry
response; it is also assumed that a given hinge in the failure mechanism forms at the edge of
a rectangular stress block.

3. If crushing strength is included in the analysis, LimitState:RING will find a solution (though
see note below) even if the structure is found to be ’geometrically locked’ when crushing
strength is assumed infinite (unlike LimitState:RING 1.x, which will provide no solution in such
circumstances).

4. When very low crushing strengths are specified it may be impossible to obtain a solution.

17.1.4 Sliding properties

LimitState:RING 4.0 models potential sliding between blocks, both within piers and rings and between
adjacent rings, though this feature can be switched off if required.

Inter-block sliding

To model sliding between all blocks (except between adjacent arch rings), ensure that the Model
sliding option is checked and enter values for the standard coefficient of friction and shear bond
strength.

Note:

1. LimitState:RING 4.0 models friction by assuming that sliding between adjacent blocks is ac-
companied by separation (so-called ’dilatant’ friction, or ’plastic shearing’). For most arch
problems this assumption has been found not to affect the computed load factor significantly.
However, it should be borne in mind that, strictly speaking, the computed factor is an ’upper
bound’ on the exact load factor (though this ’upper bound’ often coincides with the exact
value). Refer to Gilbert & Melbourne 1994 for more details.

2. In a historic masonry arch bridge, it is often be observed that many radial joints are already
cracked. Thus, it is normally recommended that in the case of radial joints, any shear-bond
strength is neglected.

Inter-ring sliding

To model sliding between rings, ensure that the Model inter-ring sliding option is checked and
enter values for the coefficient of friction and shear bond strength between adjacent rings.

Note:
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1. For problems involving several rings, it has been found that modelling friction by assuming that
separation accompanies relative sliding between rings often leads to reasonable estimates of
bridge strength (e.g. computed strengths are often found to agree well with Bolton arch and
arch bridge strengths - refer to Melbourne & Gilbert 1995). However, it should be borne in
mind that, strictly speaking, the computed factor is an ’upper bound’ on the exact load factor.

2. In LimitState:RING 4.0 it is assumed that the shear bond will fail in a ductile manner, which
is not representative of the quasi-brittle mode of failure observed in practice. Thus it is
recommended that a suitably low ‘effective’ value of shear-bond strength is used in the analysis
to compensate for this.

17.2 Backfill - Standard properties

To edit the backfill properties click on the Backfill tab of the Materials Dialog, as shown in Figure
17.2:

Figure 17.2: Backfill properties tab

17.2.1 Soil properties

Unit weight

Specify the Unit weight (in kN/m3) of the backfill material. This will be applied to all areas of
backfill and backing in the model.

Note: if you wish to model an arch without fill, specify a zero value for the backfill unit weight and
uncheck Model dispersion of live load.

c© LimitState Ltd



CHAPTER 17. MATERIAL PROPERTIES 135

Angle of friction

Specify the angle of friction φ (in degrees) of the backfill material.

Cohesion

Specify the cohesion c (in kN/m2) of the backfill material.

Note: these soil properties are used by the selected backfill numerical model. In the current version
of LimitState:RING, the ‘standard’ model is provided which is backwards compatible with RING 1.5*
and provides good correlation with published experimental data.

(*There is a small difference between how RING 1.5 and later versions of the software model Boussinesq load spreading,

which may have a minor effect on collapse load calculations for a small subset of loading scenarios. The import facility

in LimitState:RING 4.0 will automatically convert RING 1.5 backfill settings to the correct equivalent values so that

identical pressure distributions are modelled in LimitState:RING 4.0. Further details of this process are given in Appendix

B.6.)

17.2.2 Soil effects

Model dispersion of live load

Check this box to specify that the backfill model should include (longitudinal) dispersion of the live
load. When unchecked, loading on the bridge structure will occur over a longitudinal distance equal
to that which it has reached following dispersal through the surface layer.

Where the effective bridge width is set to Auto-compute (see Section 13.1.2), dispersion through
the backfill in the transverse direction is controlled via the Effective Bridge Width parameters
dialog.

17.2.3 Backing properties

Bridge backing is modelled in LimitState:RING as a special implementation of the backfill model
(see Section 5.8). The assumed default properties are as follows:

Unit weight Equal to the unit weight of the backfill (this is likely to be a conservative estimate of
the true unit weight).

Compressive strength 5MPa default (although this can be overridden if desired - see below).

Tensile strength 0MPa (i.e. tensile forces / active pressures are not permitted).

The maximum compressive force for each backing element is calculated as follows:

Max. force = σh,backing× vertical projected block area
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The compressive resistance offered by the backing can be modified for the entire model by changing
the value of σh,backing in the Compressive strength field. Alternatively, the resistance for individual
masonry blocks can be adjusted in the following way:

• Select the Block(s) that correspond to the backing elements that are to be modified.

• In the Property Editor, set Fill forces >Horizontal >Maximum to the desired limiting force.

Where backing lies over a pier, there exists the possibility for two elements to be associated with a
block (one from each of the two associated spans). In such cases, if there is a discrepancy in the
allowable force that the backing is permitted to assume, the lower (more conservative) value will be
adopted. Where the geometry of the two spans is symmetrical, the backing elements from the left
and right span will overlay each other. In such cases, it is necessary to use the Rectangle or lasso
select if both elements need to be selected at the same time.

Should the limiting force of a backing element be reached for any particular analysis, the element
will turn orange in the viewer (in contrast to active backfill elements, which turn blue (ULS) or green
(PLS) at their limiting force).

Model Horizontal pressures

Check this box to specify that the backfill model should include modelling of the Horizontal pres-
sures (see Section 5.8) arising when the arch moves into (or away from) the backfill.

Note: LimitState:RING 3.2 and earlier modelled passive earth pressures only.

17.3 Backfill - Advanced properties

17.3.1 Live load dispersion

Boussinesq

Select this option to specify that the magnitude of the pressure exerted on the back of the arch is
calculated according to the Boussinesq equation. This is the default option.

Normally a cutoff angle will be specified (default: 30 degrees) because experiments have shown that
when arch movements become large (e.g. at failure) a cone of soil under the applied load tends
to punch through. When a limiting distribution angle is specified, the magnitudes of the pressures
calculated using the Boussinesq equation are scaled up so that the integral of the vertical pressures
acting on a length of arch equals the magnitude of the applied force. The length of the arch assumed
to be subject to vertical loading pressures is indicated in Figure 17.3:
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Figure 17.3: Cutoffs used with Boussinesq load dispersion model

Uniform

Select this option to specify that the magnitude of the pressure exerted on the back of the arch is
constant. The length of the arch, assumed to be subject to vertical loading pressures, is controlled
by the specified cutoff angle, as indicated in Figure 17.4:

Figure 17.4: Cutoffs used with uniform load dispersion model

Note: the Uniform option can be used in order to comply with the requirements of some assessment
codes. However, the Boussinesq option is likely to provide a more realistic representation of the
actual distribution of fill pressures as has been indicated by numerical and experimental studies.

17.3.2 Soil-arch interface properties

Friction, multiplier on phi

Specify the multiplier on the soil angle of friction φ that provides the soil-arch interface angle of
friction δ.
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Adhesion, multiplier on c

Specify the multiplier on the soil cohesion c that gives the soil-arch interface adhesion a. This mul-
tiplier will depend on the nature of the arch extrados masonry.

Note:

1. The friction multiplier on φ will depend on the nature of the arch extrados masonry. However,
in many geotechnical codes for retaining walls, δ is a function of the critical state angle of
shearing resistance, which will not necessarily be the value of φ entered for the backfill.

2. In the LimitState:RING ‘standard’ backfill model, the soil-arch interface properties are used
to calculate an upper limit on the magnitude of the horizontal backfill pressures that can be
applied to a given masonry block without causing the strip of backfill on the block to slide.
The specified interface properties are only used for the above purpose, and are not used to
calculate frictional energy dissipation at the backfill/arch barrel interface (e.g. for use in the
work equation).

3. The check on the limiting horizontal backfill pressures that can be applied is overridden when
user-defined horizontal forces / pressures are specified.

17.3.3 ‘Spandrel Zone Parameters’

The Spandrel Zone Parameters group contains two tabs: one that describes the active and passive
response of the backfill at the Ultimate Limit State (ULS), and one that describes the response at
the Permissible Limit State (PLS); Figure 17.5 shows both:
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(a) ULS Spandrel Zone Parameters

(b) PLS Spandrel Zone Parameters

Figure 17.5: The various parameters that control behaviour in the spandrel zones at the (a) Ultimate
(ULS) and (b) Permissible (PLS) Limit States

Ultimate Limit State - Active

The horizontal active stress σh is given by:

σh = maKaσv (17.1)

where σv = γz, where γ is the unit weight of the backfill and z is the depth of fill at the point where
the pressure is being calculated. ma is a user-defined pressure modification factor that is, by default,
set to zero, causing active pressures to be neglected. This is reasonable, as it is typically observed
that the fill material present in a bridge that has been subjected to loading over a prolonged period
is very highly compacted, and, with a small amount of cohesion, is able to stand vertically. However,
ma can be set to 1.0 to ensure that full active pressures are modelled, calculated using lateral earth
pressure theory and the specified backfill angle of friction.

Factor ma

Specify the factor ma for determining the resultant lateral earth pressure derived from the vertical
stress, as defined in equation 17.1. The resultant value of maKa is given in the adjacent box.
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Ultimate Limit State - Passive

In the LimitState:RING ‘standard’ backfill model, soil pressures in the passive zone are determined
using modified lateral earth pressure theory. This idealization is discussed further in Section 5.8.3.

The horizontal stress σh is given by:

σh = mpKpσv +mpcKpcc (17.2)

where mp and mpc are user-defined pressure modification factors.

Factor mp

Specify the factor mp for determining the resultant lateral earth pressure derived from the vertical
stress, as defined in equation 17.2. The resultant value of mpKp is given in the adjacent box.

Factor mpc

Specify the factor mpc for determining the resultant lateral earth pressure arising from the backfill
cohesive strength, as defined in equation 17.2. The resultant value of mpcKpcc is given in the adja-
cent box.

Note:

1. Small changes to the specified Passive zone parameters can lead to large changes in the
computed collapse load. Hence care must be exercised when selecting these values.

2. The horizontal backfill stresses defined above may be reduced by the program if these are
sufficiently high to cause relative sliding between the backfill and the arch barrel (see Section
17.3.2).

3. The values of the backfill pressures calculated here can subsequently be modified if required.
See Viewing and modifying attributes (see Section 22).

4. To specify that horizontal backfill pressures of constant magnitude H will be mobilized when
the arch sways into the backfill, set the Factor mp to zero and the Factor mpc to a suitable
value to generate a resultant mpcKpcc equal to H.

5. These equations are given assuming dry conditions. To model conditions where the arch is
flooded to above fill level, enter buoyant unit weights for both masonry and backfill.

Keep mpKp ≥ 1.0

Checking this box ensures mpKp is always greater than or equal to 1.0. The resultant value of
mpKp can fall below 1.0 for low values of φ and mp, which can be unrealistic. See Appendix B for
further discussion of this point.
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Permissible Limit State - Active and Passive

For the purposes of undertaking a simplified PLS analysis, it can conservatively be assumed that no
soil strength is mobilized under the action of service loads, such that the soil effectively acts as a
dense fluid (after CIRIA C800, Gilbert et al. 2022). Thus, in LimitState:RING 4.0 by default, the
‘active’ and ‘passive’ side pressure coefficients are taken as 1.0 when undertaking a PLS analysis.

Pressure coefficient maKa

Specify the pressure coefficient maKa for determining the resultant lateral earth pressure derived
from the vertical stress, as defined in equation 17.1.

Pressure coefficient mpKp

Specify the pressure coefficient mpKp for determining the resultant lateral earth pressure derived
from the vertical stress, as defined in equation 17.2.

Auto apply horizontal pressures

With this box checked, uniaxial fill elements are to be included in the analysis. These elements
are positioned horizontally in the spandrel void area(s). Elements are initially placed in contact with
every block in the arch extrados.

The elements exhibit the following characteristics:

• The elements are constrained to either stay the same length or to compress.

• The elements exhibit a rigid-plastic response in compression (i.e. they compress at a constant
force. This force is equal in magnitude to the specified fill pressure multiplied by the vertical
height of the extrados face of an arch block).

• For an element positioned above a rigid abutment, the end of the element remote from an
arch block is assumed to be fixed in position.

• For an element positioned above an abutment block, the end of the element remote from an
arch block is assumed to be fixed to a vertical line drawn up from the centroid of the top block
in the abutment. This means that the element will only compress if there is a relative closing
movement between the backfill above the abutment block and the arch block to which the
element is attached (in other words, no horizontal backfill pressures need to be mobilized if
blocks in an arch moves e.g. to the left, provided the skewback on top of the abutment also
slides to the left). This approach effectively assumes that there is no additional backfill, say,
to the left of the abutment block; this is true for the case of an arch span adjacent to a beam
span.

Unchecking the Auto apply horizontal pressures box causes the fill elements to act both in the
‘passive’ and ‘active’ senses i.e. applying pressure to the arch whether this moves towards or away

c© LimitState Ltd



142 CHAPTER 17. MATERIAL PROPERTIES

from the fill. The user can then manually define in which areas of the bridge the pressures will be
applied. This is achieved by editing values in the passive restraint table (see Figure 17.6). Select
‘yes’ to include horizontal pressures and ‘no’ to not include horizontal pressures (vertical pressures
will still be modelled).

Figure 17.6: Backfill - Passive restraint table

For example, for a single-span arch which is to be loaded to the left of the crown, fill pressures
should be specified only to act on the right hand side (RHS) of the arch. However, this approach is
likely to be problematic in many cases (e.g. for multi-spans, multiple load case analyses, deep arches
etc.). Fortunately for the user, if pressures are not mobilized in the correct (i.e. ‘passive) sense, the
computed load factor will be a lower bound on the exact load factor.

Note: some additional computational effort is required when fill elements are included in the analysis.
Thus, in certain situations (e.g. when it is obvious in advance that fill pressures will be mobilized in
a given zone) there may be justification for switching off the automatic detection of fill pressures.

17.4 Surface fill

The final tab in the Materials Dialog concerns the properties of the surface fill material (or ballast
material in the case of railways). This is assumed to be uniform throughout the model and, therefore,
is assigned a uniform dispersion model.

17.4.1 Basic properties

Unit weight

The unit weight (in kN/m3) of the surface fill / ballast material by default, is set to 18kN/m3 for
both highway and railway models.

17.4.2 Angle of dispersion

The angle of load dispersion through the surface fill / ballast material is used to calculate the loading
pressures on the underlying structure using a uniform model.
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By default, this is set to 26.6o (1:2) for highway models and 15.0o (1:3.73) for railway models.

17.4.3 Track properties

For railway models, an additional set of Track Properties are shown (Figure 17.7):

Figure 17.7: Track Properties in a railway model

Parameters include:

Track load per unit area The averaged load imparted the track, ballast, sleeper and rail. Measured
above the base of the sleepers.

Spacing between sleepers The centre-to-centre longitudinal spacing between adjacent sleepers.

Sleeper dimensions Length (transverse), breadth and height. The first two of these parameters
affect the ‘footprint’ of the sleepers and, therefore, influence the load spread. The height
parameter is for display purposes only (note that the weight is accommodated as part of the
‘Track load per unit area’).
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Chapter 18

Loading

The process of adding loads to a model in LimitState:RING 4.0 follows the workflow below:

1. Open the Vehicle Database and select the desired vehicle(s) from the Library.

2. For the first Scenario in the Loading Dialog, select a load vehicle.

3. Specify the loading Type. This can be Auto, a Sequence or a Single load position.

4. Where required, provide additional information on the location(s) on the bridge where the
vehicle is to be positioned (load cases).

5. Specify a Direction of travel.

6. Assign the axles that are to be subject to any additional Dynamic / impact factor.

7. Where appropriate, add a new Scenario and repeat the previous steps.

In LimitState:RING 4.0, a database of loading vehicles can be created and then used in load cases.
Multiple load cases within a single Scenario can rapidly be set up, either by specifying that the
software automatically seeks the critical case, or by copying and repositioning an existing load case
at regular intervals.

On the Tools menu, click Loading to open the Loading Dialog shown in Figure 18.1. Alternatively,

click the Loading icon or press CTRL+5.
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Figure 18.1: The Loading Dialog

18.1 Adding a vehicle to the project

In order to add loading to a bridge, vehicles must be either:

1. imported into the project from the existing database;

2. imported from file;

3. newly defined using LimitState:RING.

In all of these cases, the Vehicle Database... button must be clicked to obtain the Vehicle
Database dialog shown in Figure 18.2:

Figure 18.2: Vehicle Database dialog box
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Information in the dialog is split into three groups:

Library Vehicles These are the vehicles that are available in the Vehicle Database for use in any
project. The list contains both built-in vehicles (defined in a number of common codes of
practice) and any user-defined vehicles that have been exported for general usage. In order to
avoid confusion, the list of vehicles that is displayed is dependent on the type of bridge analysis
being undertaken (highway or railway).

Project Vehicles Library vehicles that have been selected and moved across into the Project Ve-
hicles group are then available for use within the current project and are stored with the other
information when the file is saved.

Vehicle Details When a Project Vehicle is selected, the geometry and load details are tabulated
in this section.

18.1.1 Importing existing vehicles

The current vehicles in the database are categorized by family. Import one of these for use in the
project can be done as follows:

1. Choose a vehicle from the list on the left (by expanding the tree, you will be able to view the
properties for each one before importing).

2. Import the vehicle into the project by clicking on the vehicle and using the [>] button (the
Vehicle Details are displayed in the right-hand window).

3. Click OK.

The vehicle is now available for use in any load case, although it will not have been specifically
allocated to any particular one.

You may also export vehicles (e.g. user-defined) from the project by selecting them and clicking the
[<] button.

18.1.2 Defining a new vehicle using properties saved in a file

Click on Import to import details of a vehicle previously saved in a tab separated variable text (.txt)
file. This type of file can easily be exported from a spreadsheet or can be created using a text editor
such as Windows Notepad. The Notepad text file shown in Figure 18.3 would generate the same
library entry as was entered manually in the dialog above:
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Figure 18.3: Defining a New Vehicle from file

• The first row of the file specifies whether the vehicle is editable or not (enter 0 for an editable
vehicle or 1 for a non-editable vehicle).

• The second and third rows of the file define the name of the vehicle.

• The fourth and fifth rows of the file define the number of axles.

• The sixth row specifies the labels for the vehicle data (this should be copied exactly).

• The remaining rows in the file are the specific data relating to each axle:

Force The force (or load) imparted by the axle in kN.

Position The position (mm) of the axle.

Width The width of the axle.

Loaded length The longitudinal length (mm) of a wheel in contact with the surface (rail or
road).

Dynamic factor Specifies whether the axle is subject to dynamic partial factors, as outlined
in Section 16.

Using a spreadsheet, the same data could be entered as shown in Figure 18.4, and then saved as a
‘Text (Tab Delimited)’ (.txt) file prior to being read in by LimitState:RING 4.0:

Figure 18.4: Defining a new vehicle using a spreadsheet
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Note: in older versions of LimitState:RING, (3.2 and earlier), the spacing of the axles in a vehicle
were measured as positive from left (leading axle) to right (trailing axles). See Section 18.3.4 for
more information.

18.1.3 Defining a new vehicle within the software

To define a completely new vehicle within the software, click on the New vehicle button and enter
the name of the vehicle to be added. Details of the vehicle can then be added to the Vehicle Details
as shown in Figure 18.5:

Figure 18.5: Defining a new vehicle within LimitState:RING

18.1.4 Editing vehicle properties

The name, position and force exerted by the axles of a vehicle can all be changed by modifying the
properties in the right-hand group of the Vehicle Database.

If several vehicles are being used in the project, be sure to use the drop-down box to select the correct
one.

18.2 Vehicle direction

Many loading vehicles possess an irregular spacing of axles. Therefore, it may be necessary to consider
the path across the bridge in both directions - from left to right and from right to left.

To facilitate this, LimitState:RING allows the user to specify the direction of travel when setting up a
scenario. To do this, simply select the desired Direction from the dropdown of the Loading Dialog.

Note: for convenience, the direction of travel of a vehicle is indicated by an arrow at the front
of the leading axle in the viewer (along with the position of the leading axle in relation to the
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leftmost springing point of the bridge). This Direction Indicator can be toggled on and off using

the associated button: .

18.2.1 Renaming a vehicle

To rename a vehicle, double-click on the name in the Project Vehicles group and enter the new
text.

Note:

1. Pre-defined (built-in) vehicles may not be renamed.

2. Renaming a vehicle that is already used in a scenario will cause it to be dissociated and you
will need to re-assign it.

18.2.2 Deleting a vehicle

To delete a vehicle, click on the Delete button. Note that there must be at least one vehicle present
in the model at all times.

18.2.3 Exporting a vehicle to a file

You may wish to save a customized vehicle for use in later LimitState:RING 4.0 projects. To do this,
click on Export to export details of a vehicle to a tab separated text (.txt) file. The contents of this
file may subsequently be imported back into LimitState:RING 4.0, or viewed in a spreadsheet.

18.3 Adding a vehicle to a scenario

Once all of the necessary vehicles have been imported into the project they can be allocated to
scenarios. A scenario defines a set arrangement of vehicles, positions, direction of travel and impact
affected axles.

To add a vehicle to a scenario:

1. Return to the main Loading Dialog.

2. Select a scenario using the tabs at the top of the dialog.

3. Select the dropdown in the Vehicle column. This will present a list of the available vehicles
(Figure 18.6).

4. Choose the desired vehicle.

5. Set the remaining parameters for this scenario (see below for more information).

6. Specify additional scenarios by clicking the New... tab at the top of the dialog.
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Note: as LimitState:RING 4.0 assumes a single lane of traffic, the combination of more than one
vehicle per scenario can result in superimposed loading, which is generally not the desired result.
Where the desire is to analyse the different vehicles separately, new scenarios should be used in each
case.

Figure 18.6: Vehicles available in the current project

18.3.1 Loading type

The Type column is used to describe the number and nature of the loading cases within a scenario.

Three options are presented:

Auto The vehicle is automatically traversed across the bridge from one side to the other. The
software determines the points at each end of the model where the load from the vehicle is just
touching the structure. The distance between these points is split into a number of potential
load case positions (200 by default, but the number can be overridden at the Project level
in the Property Editor). When solving, LimitState:RING uses a slope analysis technique to
determine which unsolved load cases are likely to result in a lower (more critical) adequacy
factor. These are then solved in the next iteration and the process repeated until the critical
case is found.

Sequence The vehicle is traversed from a set point, in a set number of steps, at a specified spacing
distance. For files created in LimitState:RING 3.2 and earlier, any full sets of load cases that
can be classified as a sequence will be automatically set as a Sequence loading type. For files
that contain e.g. disjointed sets of loading sequences, the cases will be read in as individual
Single loads.

Single The vehicle is positioned at a specified point on the bridge.

18.3.2 Loading X position

The X (mm) column is used to denote the position of the leading axle of the vehicle. This may
either be as the starting point of a Sequence or as the absolute point in a Single load case.

18.3.3 Spacing and copies

The Spacing (mm) column is used in a Sequence and denotes the distance moved by the vehicle
between load cases.
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The Copies? column is used in a Sequence and sets the number of times that the vehicle is moved
from the start position. For example, if 10 copies are specified, the total number of load positions
will be 11.

18.3.4 Direction

The Direction column specifies the direction of travel of the vehicle (default Left to right).

Note: in older versions of LimitState:RING, (3.2 and earlier), the spacing of the axles in a vehicle were
measured as positive from left (leading axle) to right (trailing axles). This could result in vehicles
that faced to the left, but that were traversed from left to right across the structure (i.e. moving
backwards). In LimitState:RING 4.0, the positive axle spacing is measured from right (leading axle)
to left (trailing axles). Files saved in older versions of the software will adjust the directions and axle
spacings to work with this new system, while maintaining continuity with the original setup (i.e. the
solutions will be the same). Warnings about this change will be presented on load and in the analysis
Diagnostics.

18.3.5 Dynamic / impact axles

Codes of practice sometimes require the consideration of ‘dynamic’ or ‘impact’ loading when assessing
the capacity of a bridge structure. Often this is implemented via the application of a ‘dynamic load
factor’ to one or more axles (maybe the most heavily loaded) of the loading vehicle.

LimitState:RING 4.0 allows dynamic axle loading to be specified on a per-scenario basis. When used
in an analysis, the load from the selected axle(s) will be multiplied by whatever Dynamic / impact
partial factor is set in the Partial Factors (see Section 16) dialog.

To adjust the axles that will be subject to dynamic / impact loading factors for a particular scenario,
click the [...] button in the Dynamic Axles column and check the boxes next to the axles that you
wish to apply the factor to (e.g. Figure 18.7):
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Figure 18.7: Adding Dynamic / impact factors to a load vehicle in a scenario

Note: when returning to the viewer, any axles that are subject to a dynamic / impact factor will be
highlighted with a red edge (Figure 18.8):

Figure 18.8: A Dynamic / impact factor applied to an axle will be displayed as a red edge in the
viewer
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18.4 Adding and deleting scenarios

18.4.1 Adding scenarios

To add further scenarios click on the New... tab, as shown in Figure 18.9:

Figure 18.9: Adding a new scenario

18.4.2 Deleting scenarios

Various options are available when deleting scenarios:

Single To delete a single scenario, click the X at the right of the appropriate tab (e.g. Scenario 2
shown in Figure 18.10).

Delete all to the LEFT Deletes all scenarios to the left of the currently active tab.

Delete all to the RIGHT Deletes all scenarios to the right of the currently active tab.

Delete all but CURRENT Deletes all scenarios except the currently active tab.

Figure 18.10: Deleting a single scenario

Note: there must always be one scenario in the analysis.
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18.5 Viewing scenarios

The Load Cases toolbar (Figure 18.11) provides the ability to view the individual load positions for
different scenarios.

Scenario dropdown The dropdown allows you to switch between the different scenarios in the
project.

Position spin box The spin box moves the viewer between the various load locations within the
selected scenario. For Auto scenarios, the load positions are not available in advance and,
as such, the vehicle position is fixed at 1250mm until a solve has been undertaken. Once
post-solve data is available, the position can be altered using the spin box.

Figure 18.11: The Load Case toolbar - normally positioned at the top of the viewer

For problems involving multiple load positions, the Chart also provides the ability to switch the
viewer between load cases, simply by clicking on the data point of interest. More about the output
chart is available in ‘Adequacy Factor’ plot (Section 25.1).

18.6 ‘Drag and Solve’ mode

An alternative method of solving is to enable automatic recalculation whenever the load vehicle is
moved in the Viewer pane and enter Drag and Solve mode.

To enable automatic recalculation, go to the Tools >Preferences dialog. Select the option to Solve
automatically after dragging a vehicle and close the dialog.

Now, click and hold the left mouse button over the loading vehicle in the Viewer pane. Drag the
vehicle to a new position using the mouse and release the button. The Scenario dropdown will
read Drag and Solve. The problem will solve automatically with the load at the position you have
specified. This process can be repeated as necessary.

Upon unlocking the problem, the option to save the current vehicle position as a new scenario will
be presented. This allows positions of interest to be stored in the problem and have the software
solve them as part of a general analysis, without altering the already existing loading scenarios. To
store the new scenario, click Save. Otherwise, click Discard to return the viewer to the pre-drag
and solve state.

For a Single load case scenario, the option to Replace the existing load position is also presented.
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18.7 Applying block forces

As well as vehicular loading, LimitState:RING provides the capability to apply external forces to
selected blocks e.g. to simulate the presence of props. These forces are fixed and will not be scaled
as part of the analysis or subject to load-related partial factors.

To add a force or moment to the centroid of a block:

• Select a block (or multiple blocks).

• In the Property Editor, expand the Applied force section.

• Provide values for the forces / moment as required.

Blocks subject to applied forces will display a blue arrow that is scaled according to the magnitude.
When a moment is applied, a blue circle (or sphere, when viewed in 3D) will be displayed at the
block centroid (Figure 18.12):

Figure 18.12: External forces and moment applied to a block
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Standard analysis types

19.1 Ultimate Limit State (ULS) analysis

ULS failure of an arch structure represents the maximum load-carrying capacity and will generally
be accompanied by large deformations of the constituent backfill and some degree of crushing of the
masonry. Calculation of the ULS is the traditional approach to masonry arch bridge analysis and
assessment.

19.1.1 Undertaking a ULS analysis

To undertake a ULS analysis using LimitState:RING 4.0 requires the following:

ULS Partial Factors In the Partial Factors Dialog (Figure 19.1), set appropriate partial factors in
the PLS column. By default, the partial factors (divisors) on masonry compressive and shear
bond strength are set to 2.0. It is generally required that a suitable Dynamic / impact partial
factor is applied to the vehicle load, along with setting the corresponding ‘Dynamic axle’ in
the Loading Dialog.

ULS Spandrel Zone Parameters In the Materials Dialog (Figure 19.2), open the Backfill tab
and highlight the ULS tab in Spandrel Zone Parameters. Provide appropriate values for the
factors ma, mp and mpc, the multipliers on vertical stress that determine the corresponding
horizontal stress in ‘active’ and ‘passive’ zones respectively. By default, both these values are
set to 1.0, in line with CIRIA C800 guidance.

ULS analysis mode With all other settings complete, set the Analysis type dropdown to ULS and
click Solve. The analysis will be undertaken as usual.

19.1.2 Output from a ULS analysis

The primary output from a ULS analysis comprises an Adequacy Factor, a failure mechanism and
other visual output.
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Adequacy Factor The multiplier on the (factored) live loading that is required to cause the collapse
of the structure. LimitState:RING 4.0 will display the loading case associated with the lowest
value of Adequacy Factor out of all the cases, over all the scenarios that have been provided.
If the correct partial factors and dynamic / impact settings have been set, an Adequacy Factor
of 1.0 or above indicates that the structure is safe for the problem presented.

Backfill element colouring In ULS mode, any backfill element that attains the maximum value of
Horizontal force will be coloured blue. Inactive backfill elements (i.e. that have not attained
their limiting value of force) will remain grey.

19.2 Permissible Limit State (PLS) analysis

CIRIA C800 (Gilbert et al. 2022) defines the PLS as the point beyond which progressive load-induced
degradation will occur during the intended life of the bridge. To guard against damage caused by
the effects of service loads it is prudent to undertake a PLS analysis in addition to a traditional ULS
calculation.

As described in CIRIA C800, the limit analysis approach employed by tools such as LimitState:RING
4.0 can be modified so as to also model the PLS. This primarily involves using reduced values for
the soil restraint and masonry strength in the analysis.

19.2.1 Undertaking a PLS analysis

To undertake a PLS analysis using LimitState:RING 4.0 requires the following:

PLS Partial Factors In the Partial Factors Dialog (Figure 19.1), set appropriate partial factors in
the PLS column. By default, the partial factors (divisors) on masonry compressive and shear
bond strength are set to 2.0. It is also generally required that a suitable Dynamic / impact
partial factor is applied to the vehicle load, along with setting the corresponding ‘Dynamic
axle’ in the Loading Dialog.

PLS Spandrel Zone Parameters In the Materials Dialog (Figure 19.3), open the Backfill tab
and highlight the PLS tab in Spandrel Zone Parameters. Provide appropriate values for the
pressure coefficients maKa and mpKp, the multipliers on vertical stress that determine the
corresponding horizontal stress in ‘active’ and ‘passive’ zones respectively. By default, both of
these values are set to 1.0 in line with the CIRIA C800 guidance.

PLS analysis mode With the above parameters set, set the Analysis type dropdown to PLS and
click Solve. A PLS analysis will then be carried out.

19.2.2 Output from a PLS analysis

The output from a PLS analysis is similar to that of a ULS analysis in that it comprises an Adequacy
Factor, an associated mode of response and other visual output.

Adequacy Factor The multiplier on the (factored) live loading that is required to cause the PLS to
be reached. LimitState:RING 4.0 will display the loading case associated with the lowest value
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of Adequacy Factor out of all the cases, over all the scenarios that have been provided. If
the correct partial factors and dynamic / impact settings have been set, an Adequacy Factor
of 1.0 or above indicates that the structure is not prone to damage under working loads for
the problem presented.

Backfill element colouring In PLS mode, any Active backfill element that attains the maximum
value of Horizontal force will be coloured purple. Any Passive backfill element that attains
the maximum value of Horizontal force will be coloured green. Inactive backfill elements (i.e.
that have not attained their limiting value of force) will remain grey.

Figure 19.1: The Partial Factors Dialog, with ULS and PLS partial safety factors set
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Figure 19.2: The Materials >Backfill dialog, showing ULS Spandrel Zone Parameters

Figure 19.3: The Materials >Backfill dialog, showing PLS Spandrel Zone Parameters
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Support movement analysis

20.1 Background

A useful feature in LimitState:RING 4.0 is the ability to model support movements. This opens up
a range of possibilities, for example:

• The likely causes of observed cracks in an existing structure can be investigated by imposing
support movements and comparing actual and modelled deformed shapes (e.g. are these
consistent with vertical, horizontal or perhaps angular settlement of the base of a pier or
abutment?).

• The observed response of a settled bridge can be used to verify the model idealization. A settled
bridge can be considered to be of almost the same value as a load test to collapse; when a
bridge undergoes settlements, many of the same modes of resistance are mobilized as when a
bridge is subjected to excessive live loading. Therefore, it is very useful to try and correlate
actual and modelled behaviour (e.g. if it is necessary to include backing in the numerical
model in order to replicate the observed mode of response, then this strongly indicates that
backing, or very strong fill material, is present in the real structure - and potentially also in
similarly constructed structures in the area. This can then be included in subsequent load
factor analyses).

• Vehicles can be run across a settled bridge to investigate load paths and to see whether the
hinge positions move (if they are predicted to move significantly in the model under traffic,
and if secondary stiffening elements, such as securely attached spandrel walls, are not present
in reality then this might be a cause for concern, as continual opening and closing of joints
may lead to incremental damage to the structure).

• Once the centering is removed many bridges appear to ‘bed down’ to a statically determinate
(or near statically indeterminate) state. This state can be approximately replicated by moving
the supports appropriately. Vehicles can then be introduced and load paths established. If
necessary, an adequate margin of safety can be ensured by applying a suitable partial factor to
the axle loads, ensuring that the structure remains stable.
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20.2 ‘Support Movement Wizard’

The easiest way of imposing support movements is to use the Support Movement Wizard, which
can be accessed via the Tools menu (Figure 20.1):

Figure 20.1: Support Movement Wizard

To use the tool:

1. With the Support Movement Wizard open, click on Pick Support Block.

2. Using the mouse, click on a support block (green) in the viewer window. The wizard will
re-appear, containing details of the selected support.

3. Enter details of the movement of that block in the table.

4. Repeat the first two steps until all the required movements have been entered. If, at any time,
you wish to return to the wizard without selecting a block, click the Escape button.

5. Click OK to return to the main window.

6. Click Clear Table to blank all entries and return to a ‘normal’ analysis.

Note:
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• Distances are measured in mm, with positive vertical movement being upwards.

• Rotations are measured in degrees - anticlockwise about the centroid of the block.

The Analysis Type dropdown will automatically switch to Move Support(s) once support move-
ment has been prescribed. An analysis may then be carried out as normal, with the prescribed support
movement(s) being visible following an analysis.

As a failure mechanism is being created via the introduction of releases in the system (movements)
and not through the increase of some live load on the structure, the output of a support movement
analysis is expressed in terms of energy (Joules), rather than as an Adequacy Factor. As small-
displacement theory is employed, computed energy dissipation will vary linearly with the magnitude
of the prescribed movement.

As an alternative to the Support Movement Wizard, movements may also be applied to selected
Blocks via the Property Editor. To do this:

1. Select a support block in the viewer.

2. In the Property Editor, expand Support >Movement to expose the support movement fields.

3. Enter details of the movement of that block.

4. Note that the analysis type needs to be set to Move support(s) in order for these changes to
have an effect.
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Reinforcement

21.1 Properties

LimitState:RING 4.0 allows the user to include reinforcement in the model, meaning that the software
can also be used to assess a range of reinforced arch bridges (refer to Section 5.5 for advice on the
assumptions made with respect to the reinforcement model).

Up to two layers of reinforcement can be added at 90◦ across any Contact by specifying the distance
measured from an end (A or B) and the limiting tensile and compressive forces1 (i.e. select radial
contacts to assign circumferential reinforcement and vice versa). For example, see Figure 21.1, where
circumferential reinforcement has been added to the bridge model:

Figure 21.1: Reinforcement added to a bridge model

Reinforcement may be added across any Contact. The properties of the reinforcement are displayed
and can be edited in the Property Editor. By selecting one or more contacts and expanding the

1In a pre-release version of LimitState:RING 3.0 only a single limiting force value could be specified. When files
saved with the earlier version are loaded in LimitState:RING 4.0, both the tensile and compressive limiting forces will
be set to this single limiting force value, though can be changed subsequently.
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Reinforcement section in the Property Editor, the parameters outlined in Table 21.1 are shown
below:

Property Details
Depth The depth (mm) to the reinforcement from the contact endpoint

(A = intrados, B = extrados if radial). Note that this must be a
positive value, equal to less than half the contact length.

Comp. limit The maximum compressive force (kN per metre bridge width)
that can be transmitted by the reinforcement nearest the specified
endpoint (A or B).

Tens. limit The maximum tensile force (kN per metre bridge width) that can
be transmitted by the reinforcement nearest the specified endpoint
(A or B).

Shear capacity The limiting shear force (kN per metre bridge width) of the rein-
forced section.

Table 21.1: Reinforcement fields, as displayed in the Property Editor

Note:

1. The ‘Reinforcement force’ is the limiting force per metre width that can be carried i.e. Re-
inforcement force = (area of reinforcement per metre width) x (yield stress) x (any applied
factors).

2. Moments in reinforced sections are calculated around the centroid of the corresponding contact.

3. The Shear capacity is set to a high value by default (1e+20) to ensure that shear failure is
not initially governing.

21.2 Adding reinforcement to the project

There is some flexibility in the way that the user can add reinforcement to the model. Either:

1. select one or more Contacts using the mouse and enter the reinforcement details in the
Property Editor; or

2. use the Contact Select Tool, which can be accessed via the Select menu. This tool helps
the user to add circumferential reinforcement to the entirety of one or more rings or spans by
automatically selecting all the radial contacts of the chosen part.

21.2.1 ‘Contact Select Tool’

The Contact Select Tool can be accessed through Select >Contact Select Tool.... In the dialog
click the name(s) of the bridge part(s) that you wish to select all the contacts of. If more than one
bridge part is required, hold down the CTRL key whilst making the selections (see Figure 21.2):
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Figure 21.2: Contact Select Tool - the radial contacts in the extrados ring of both spans of a
twin-span bridge will be selected to allow circumferential reinforcement to be added

If the end radial contacts in a ring (i.e. those that join the ring to the abutments) also contain
reinforcement, ensure the Include edge contacts box is ticked (this is selected by default).

Once the relevant contacts have been selected, click OK. The contacts will be highlighted (see Figure
21.3):

Figure 21.3: Radial contacts selected using Contact Select Tool

Then, in the Property Editor, specify the reinforcement position (in millimetres), limiting compres-
sive and tensile forces and the reinforced shear capacity (in kN per metre width). On clicking out of
the Property Editor, the reinforcement will be displayed on the model (see Figure 21.4):
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Figure 21.4: Reinforcement added to radial contacts

Note: the Contact Select Tool is not available if the project geometry has been imported from
DXF. In such circumstances, reinforcement can only be applied after manually selecting the relevant
contact surfaces e.g. using the lasso tool.
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Chapter 22

Viewing and modifying attributes

22.1 Using the ‘Property Editor’

The Property Editor feature (Figure 22.1) allows the user to quickly read and / or modify the
attributes of one or more objects within the current project.

Figure 22.1: The LimitState:RING 4.0 Property Editor

The Property Editor is present by default when LimitState:RING is started, but can be toggled on
and off via the View menu (see Section 23.3.4).

Some of the functions in LimitState:RING are only accessible via the Property Editor. These are
described in detail in this section. Other functions and attributes can be accessed and modified from
more than one location, but are also shown for convenience in the Property Editor.

To begin using the Property Editor, first select an area of the model using the methods described
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in Chapter 23.

The drop-down menu in the Property Editor gives the option of viewing and / or editing the
attributes belonging to the different types of object that have been selected.

The following areas and objects within the LimitState:RING environment may be selected to reveal
fields that can be accessed via the Property Editor:

Project (whitespace) Data relating to the project details and settings.

Fill elements Data relating to the applied and limiting forces in the fill / backfill elements.

Block(s) Data relating to the unit weight, forces, support conditions and displacements of blocks.

Contact(s) Data relating to the material properties, forces, failure types, mortar loss and reinforce-
ment at the contact surface(s).

Vehicles Data relating to the vehicle position and direction of travel.

Axle Data relating to the imparted force and geometry of the selected axle(s) as well as the effective
bridge width below.

22.1.1 Project information

Project details

General project details (some of these are also accessible through the Project Details Dialog ):

Bridge name Title of the project (optional).

Bridge Type Highway or railway underbridge. Affects the available load vehicles and layer load
distribution.

Assessor The name of the person undertaking the assessment (optional).

Organization The name of the organization responsible for the assessment (optional).

Reference number The bridge identification number or code (optional).

Location The location of the bridge (optional).

Map reference A map reference or coordinates of the bridge (optional).

Comments Notes about the bridge or analysis (optional).

Effective width

Information regarding the calculation of the effective bridge width and the value at the current load
position (also accessible via Project Details >Effective Bridge Width):
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Auto-calculate If true, the effective bridge width will be independently calculated for each load
position based on the parameters provided. If set to false the effective bridge width will be
fixed at the current value for all load positions.

User-defined (mm) The value of effective bridge width that will be used if Auto-calculate is set
to false (or zero if true).

Value (mm) The value of the effective bridge width that is being used at the current load position.

Display settings

Parameters that affect the display of objects in the viewer. These are only accessible from the
Property Editor:

Backfill arrow scale factor Controls the size of the backfill and backing arrows when displayed.
Can be useful if the arrows are obscuring other features of the model.

Backfill arrow opacity Controls the opacity of the backfill and backing arrows (100 = fully opaque).
Note that opacity is only applied to arrows associated with static blocks (i.e. not moving) in
the critical failure mechanism (i.e. post-solve).

Value (mm) The value of the effective bridge width that is being used at the current load position.

Other details

General project details:

Reinforcement enabled Specifies whether reinforcement, if specified in the project, is considered
during an analysis.

Auto load divisions The number of potential load cases that will be considered for analysis in each
Auto load scenario.

22.1.2 Fill element(s)

Limiting force

The limiting force is the force (kN per metre width) at which the fill (i.e. bar) element yields. This
is a function of the specified soil properties (i.e. the product of the limiting fill pressure and the
vertical block height).

To modify the limiting fill force, you must alter the Fill force (H): max. (see Section 22.1.3) value
of the corresponding block entity.
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22.1.3 Block(s)

Fill force (H): actual

This is the actual horizontal (passive) fill force applied to the block (kN per metre width). This will
be zero:

1. before solving; and

2. in zones where the structure is moving away from the fill.

Fill force (H): max.

This is the maximum horizontal (passive) fill force that can be applied to the block (kN per metre
width). It should be noted that the actual force applied may be lower.

For blocks that are associated with backing elements, the maximum fill force will be calculated
assuming the default backing material properties.

Fill force (H): user-defined

This specifies whether the user is overriding the automatically calculated horizontal force applied to
the block. If this is set to true then subsequent changes to the fill depth, unit weight etc. will not
affect the fill horizontal force magnitude.

Fill force (V)

This is the fill vertical force applied to the block (kN per metre width). This force results from
overlying fill, surface fill / ballast and track self-weight loads

Fill force (V): user-defined

This specifies whether the user is overriding the automatically calculated vertical force applied to the
block. Note that if set to true, then subsequent changes to the fill depth, unit weight etc. will not
affect the fill vertical force magnitude.

Support movement (rotation)

Rotational movement of support blocks can be modelled by entering a value (in radians) in this box.
Rotations are measured in an anti-clockwise direction about the centroid of the block and become
apparent once an analysis has taken place.
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Support movement (x)

To model a horizontal (x direction) movement of a block, enter a value here. Settlement is measured
in mm and shown following an analysis.

Support movement (y)

To model a vertical (y direction) settlement of a block, enter a value here. For a downward movement,
the value entered should be negative. Settlement is measured in mm and is shown following an
analysis.

Note: support movements cannot be specified without the selected block(s) first having restraint in
the appropriate direction. For blocks without the required restraint, should a value be entered in a
Support movement... box, LimitState:RING will give a warning that a restraint will also be added
to the current selection (as well as the option to cancel this action).

22.1.4 Contact(s)

Enabled

This specifies whether the selected contact(s) are active.

Note: if this attribute is set to false, the contact will be assumed to be not present in the analysis
and interpenetration can freely occur.

Mortar loss

Mortar loss can affect the results of an analysis and should, therefore, be modelled as carefully as
possible. In an arch in LimitState:RING, Mortar loss (A) refers to material removed from the
contact on the intrados side of the arch, whilst Mortar loss (B) refers to material taken from the
extrados side. Values for mortar loss are entered in mm.

Permit hinges

This specifies whether hinging failures are permitted at the selected contact(s).

Permit sliding

This specifies whether sliding failures are permitted at the selected contact(s).
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Reinforcement properties

For reinforcement properties, see Chapter 21.

22.2 Using the explorers

In addition to the Property Editor, LimitState:RING 4.0 has several explorers that allow the user
to quickly check and compare the attributes of similar objects in the current project, as shown in
Figure 22.2:

Figure 22.2: The LimitState:RING 4.0 Block explorer

22.2.1 Opening an explorer

To access the explorers, click on the View menu and highlight the Explorers option. There are four
explorers to choose from:

1. Block explorer - displays the attributes of blocks contained in skewbacks, spans and piers.

2. Contact explorer - displays the attributes of contacts in spans and piers.

3. Vehicle explorer - displays the properties of each axle of every vehicle in the project.

4. Scenario explorer - displays the properties of the vehicles according to their scenario (load
case).
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22.2.2 Navigating the explorers

Data in the explorers is presented in a convenient tabulated form, with objects grouped together
in a logical manner. To begin using, simply expand the desired sections of the project tree on the
left-hand side of the explorer window (using the + and - buttons). Some of the columns may not be
visible as the tables can be quite wide; for this reason, you may wish to widen the explorer window.

After using the mouse to select an object, group of objects, or their properties in the explorer, the
corresponding objects will be highlighted in the modeller window. This allows the user to determine
precisely which parts of the bridge are being considered. Similarly, objects selected in the modeller
window will be highlighted in the relevant explorer window.

The columns currently shown on a given explorer can be changed by right-clicking with a mouse on
the explorer title bar, selecting View, and then selecting and deselecting attributes as required.

22.2.3 Editing data

Editing data can be done in one of three ways:

1. by changing individual cells within the explorer;

2. by copying and pasting cells within the explorer;

3. by copying and pasting from a spreadsheet.

1. Changing individual cells

To change the contents of an individual cell in an explorer, double-click with the mouse. If the data
is numerical, you will now be able to enter a new value using the keyboard. Alternately, if the data
is an option (e.g. true / false), a drop-down list will appear containing all the available choices.

2. Copy and paste within an explorer

It is also possible to cut and paste data between several cells whilst within an explorer. To do this:

1. Use the mouse (or keyboard) to highlight the cells that you wish to copy.

2. Right-click to bring up the Explorer context menu (see Section 23.5.3).

3. Select Copy (the copied cells will now have a dashed border).

4. Select the cells that you wish to paste into (the dimensions of the selected area should be the
same as the copied area).

5. Right-click to bring up the explorer context menu.

6. Select Paste (the cells will now be filled with the new data).
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An even quicker way of copying and pasting is to use the Copy / Paste details functions. These
allow entire rows of data to be copied and pasted by selecting only the ID cell. To do this:

1. Highlight the ID cell(s) of the object(s) to be copied.

2. Right-click to bring up the explorer context menu.

3. Select Copy details (the copied rows will now have a dashed border).

4. Select the ID cells that you wish to paste into (the dimensions of the selected area should be
the same as the copied area).

5. Right-click to bring up the explorer context menu.

6. Select Paste details (the rows will now be filled with the new data).

Note:

1. The standard keyboard shortcuts for Copy (CTRL+C) and Paste (CTRL+V) can also be
used.

2. It is not possible to paste numerical data into a cell containing drop-down options (and vice
versa).

3. It is not possible to select, copy or paste data to and from more than one feature at a time
(e.g. in the Block explorer, you cannot copy data from an abutment and a span at the same
time).

4. It is not possible to overwrite object ID’s using the Copy / Paste details functions (although
the standard Copy / Paste will allow this).

3. Copy and paste from a spreadsheet

To change the contents of many cells at the same time, it can be convenient to use a spreadsheet
(such as Microsoft Excel). Firstly, making sure that you have your spreadsheet software open,
highlight all the data that you wish to copy, then Copy (as described above). Navigate to your
spreadsheet and Paste the data. You can then edit the data as required. To move the data back
into LimitState:RING, the reverse process is carried out.

A convenient way to select all the data in the current branch (which is useful for exporting to a
spreadsheet) is to use the Copy all function in a similar manner.
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Display options

23.1 General

23.1.1 Language specific variations

It should be noted that any different language options in LimitState:RING 4.0 can cause the display to
alter according to the prevailing direction of reading. Here, it is assumed that the English Language
version is being used; sections of the LimitState:RING 4.0 window referred to as right and left should
be reversed where appropriate.

23.1.2 Scrollbars

Vertical and horizontal scrollbars allow the display area to be shifted in the vertical and horizontal
sense respectively.

23.1.3 Current mouse position

The coordinates of the mouse are shown in the bottom right-hand corner of the screen. This may
be useful for determining the global position of various parts of a bridge (the datum for all bridges
is the left-hand springing of span 1).

23.1.4 Scrolling wheels

Most mice are equipped with a third button that is used for scrolling. LimitState:RING makes use
of this additional feature by allowing the user to pan and zoom the display:

• To pan, simply press and hold the third button whilst in the display window. Moving the
mouse will now pan the image around the screen.

• To zoom, simply roll the wheel up to zoom out and down to zoom in.
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The pan and zoom functions are also accessible via Table 23.8.

23.2 Viewer pane

In order to better visualize the model and post-analysis failure mechanism, it is possible to manipulate
the view in a number of ways:

23.2.1 Rotating the model

The Rotate tool

The Rotate tool allows the user to quickly and easily manipulate the scene in the Viewer pane by
providing handles to rotate around the major cartesian axes and also freely in 3D.

To access the tool, click the Rotate icon on the Cursor toolbar or open the Viewer pane context
menu by right-clicking the mouse anywhere within the Viewer pane and selecting Rotate > Rotate.
This action will overlay the Rotate tool on top of the Viewer pane (Figure 23.1):

Figure 23.1: The Rotate tool

Now, when hovering in the different areas of the Viewer pane, rotate cursors are displayed:

Rotate x Hovering the cursor in the small circles at the top or bottom brings up the rotate x cursor

. Click with the left mouse button and hold. Moving the mouse up and down the screen
will now rotate the model around the x-axis.

Rotate y Hovering the cursor in the small circles at the left or right brings up the rotate y cursor

. Click with the left mouse button and hold. Moving the mouse left and right across the
screen will now rotate the model around the y-axis.
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Rotate z Hovering the cursor outside the large central circle brings up the rotate z cursor . Click
with the left mouse button and hold. Moving the mouse up and down the screen will now
rotate the model around the z-axis.

Rotate 3D Hovering the cursor inside the large central circle brings up the rotate 3D cursor .
Click with the left mouse button and hold. Moving the mouse in any direction (keeping within
the circle) will now rotate the model freely in any direction.

To exit the Rotate tool select an alternative cursor option in the Cursor toolbar.

Rotate cursors

In addition to the Rotate tool, the model can be rotated by accessing any of the rotate cursors
(rotate x, rotate y etc.) individually. To do this, right-click in the Viewer pane to bring up the
context menu, then select Rotate and choose from one of the four options beneath the horizontal
line (as described above). The cursor will then change to match the chosen option. Clicking and
holding the left mouse button and moving the cursor anywhere within the Viewer pane will rotate
the model in the preferred manner. To exit the Rotate tool select an alternative cursor option in
the Cursor toolbar.

Predefined viewpoints

For quick inspection, it is possible to view the model in the Viewer pane from one of a number of
predefined 3D viewpoints. To change the current view to one of these, right-click the mouse in the
Viewer pane to bring up the context menu, then select View and choose from one of the following
options:

Top View the model from above - in the negative y direction.

Bottom View the model from below - in the positive y direction.

Right View the model from the right - in the negative x direction.

Left View the model from below - in the positive x direction.

Front View the model from the front - in the positive z direction. This is the default view.

Back View the model from the back - in the negative z direction.

Alternately, these functions can be accessed by navigating to the View menu and selecting one of
the options under 3D View.

3D and perspective views

The scene can be quickly set to a default 3D viewpoint by right-clicking in the Viewer pane to bring
up the context menu, then selecting View > 3D View. The model will then appear viewed from
above and to the right (at 45◦) looking toward the origin.
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To view the model in perspective, select the Toggle perspective icon from the View toolbar.
Alternatively, this function can be accessed from the Viewer pane context menu (View > Toggle
Perspective).

Both the 3D View and Toggle Perspective functions can be accessed from the View > 3D View
menu.

23.3 Menus

23.3.1 File menu

The File menu is shown in Figure 23.2:

Figure 23.2: The LimitState:RING File menu

The File menu functions are shown in Table 23.1:

Function Shortcut Description

New... Ctrl+N Create a new bridge project

Open... Ctrl+O Open an existing bridge project

Close Close the current bridge project

Save Ctrl+S Save the current bridge project

Save As... Ctrl+Shift+S Save the current bridge project under a specified name

Open recent file Open one of the 5 most recently accessed files

Exit Ctrl+Q Exit LimitState:RING

Table 23.1: File menu functions
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23.3.2 Edit menu

The Edit menu is shown in Figure 23.3:

Figure 23.3: The LimitState:RING 4.0 Edit menu

The Edit menu functions are shown in Table 23.2:

Function Shortcut Description

Undo Ctrl+Z Step back to the point immediately before the last action was taken

Redo Ctrl+Y Redo a previously undone action

Table 23.2: Edit menu functions

23.3.3 Select menu

The Select menu is shown in Figure 23.4:

Figure 23.4: The LimitState:RING 4.0 Select menu

The Select menu functions are shown in Table 23.3:
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Function Description

Click Select a single object (or multiple objects using CTRL)

Lasso Select multiple objects within a user-defined zone

Rectangle Select multiple objects within a rectangular zone

Filter Select only objects of a specified type, or select all object types together

Contact Select Tool Opens a dialog allowing you to select multiple contacts

Select Contacts Only Select only contact elements

Table 23.3: Select menu functions

23.3.4 View menu

The View menu is shown in Figure 23.5:

Figure 23.5: The LimitState:RING 4.0 View menu
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The View menu functions are shown in Table 23.4:

Function Description

Zoom Zoom in and out in the viewer window, or zoom to the extents

of the model

Property Editor Toggle the display of the Property Editor pane

(default position: right of screen)

Output Toggle the display of the ’Output’ pane

(default position: bottom of screen)

Explorers Toggle the display of the Block / Contact / Vehicle and

Scenario explorers (see Section 22.2)

Toolbars Toggle the display of default and non-default toolbars

3D View Choose from a variety of pre-defined camera viewpoints

Default Contact Colouring Colour the contacts in the default (black) colourway

Colour Contacts by Crushing Strength Colour contacts by the value of their crushing strength

(max = red, min = blue)

Colour Contacts by Coefficient of Friction Colour contacts by the value of their friction strength

(max = red, min = blue)

Colour Contacts by Shear Bond Strength Colour contacts by the value of their shear bond strength

(max = red, min = blue)

Default Block Colouring Colour the blocks in the default (grey) colourway

Colour Blocks by Unit Weight Colour blocks by the value of their unit weight

(max = red, min = blue)

Show / Hide Contacts Toggle the display of the contact surfaces

Show / Hide Blocks Toggle the display of the blocks

Show / Hide Fill Elements Toggle the display of the fill (bar) elements

Show / Hide Backing Elements Toggle the display of the backing (bar) elements

Show / Hide Fill Elements Toggle the display of the fill (bar) arrows

Show / Hide Backing Elements Toggle the display of the backing (bar) arrows

Show / Hide Direction Indicator Toggle the display of the direction indicator and

leading axle location

Show / Hide Thrust* Toggle the display of the thrust zone

Show / Hide Hinges* Toggle the display of the hinges

Show / Hide User Load Indicators Toggle the display of arrows and other indicators

of user-defined block forces

Show / Hide Moment Diagram * Toggle the display of the moment diagram

Show / Hide Normal Force Diagram* Toggle the display of the normal force diagram

Show / Hide Shear Force Diagram* Toggle the display of the shear force diagram

Table 23.4: View menu functions (* = post-solve only)

23.3.5 Tools menu

The Tools menu is shown in Figure 23.6:
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Figure 23.6: The LimitState:RING 4.0 Tools menu

The Tools menu functions are shown in Table 23.5:

Function Description

Project Details Open the Project Details Dialog box

Geometry Open the Geometry Dialog box

Materials Open the Materials Dialog box

Partial Factors Open the Partial Factors Dialog box

Loads Open the Loading Dialog box

Support Movement Wizard Open the Support Movement Wizard

Preferences Modify General / Report preferences

Table 23.5: Tools menu functions

23.3.6 Analysis menu

The Analysis menu is shown in Figure 23.7:

Figure 23.7: The LimitState:RING 4.0 Analysis menu
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The Analysis menu functions are shown in Table 23.6:

Function Shortcut Description

Diagnostics Run the pre-solve diagnostics

Solve F5 Analyse the current problem

Unlock Unlock the project for editing

Report... View the analysis report

Table 23.6: Analysis menu functions

23.3.7 Help menu

The Help menu is shown in Figure 23.8:

Figure 23.8: The LimitState:RING 4.0 Help menu

The Help menu functions are shown in Table 23.7:

Function Shortcut Description

Help F1 Enter the Help system

Update Check for program updates

License Information Open the license information dialog

About Display LimitState:RING version details

Table 23.7: Help menu functions

23.4 Toolbars

23.4.1 Default toolbars

By default, the toolbars listed in Table 23.8 are displayed when you open LimitState:RING 4.0:
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Toolbar Functions

Analysis Solve / Unlock

Cursor Click / Rectangle / Select / Zoom / Pan

Edit Undo / Redo / Delete

File New / Open / Save

Load Cases Load case spin box

Animation Displacement magnification slider

Show Toggle Perspective

Show Contacts / Show Bar Elements / Show Thrust Line

Show Blocks

View 3D View the model in 3D: Top / Bottom / Left / Right / Front / Back

Zoom Zoom All / Zoom In / Zoom Out

Properties Project Details / Geometry / Partial Factors

Materials / Loads

Table 23.8: Default toolbars

23.4.2 Optional toolbars

To access some of the less commonly utilized features of LimitState:RING, it may be necessary to
open a separate toolbar. To do this, click View and select Toolbars. You will now have the option
to open one of the toolbars listed in Table 23.9:

Toolbar Functions

Rotate 3D Rotate the model in 3D: Rotate about x / Rotate about y / Rotate about z

Help Help / About

Table 23.9: Optional toolbars

23.5 Context menus

Depending upon the position of the cursor, right-clicking the mouse within the LimitState:RING
environment will bring up one of several context menus:

23.5.1 Viewer pane context menu

Right-clicking within the Viewer pane will bring up the menu shown in Figure 23.9:

c© LimitState Ltd



CHAPTER 23. DISPLAY OPTIONS 187

Figure 23.9: Viewer pane context menu

From here, you can easily access many of the display-related functions of the toolbars, as well as
several other independent functions listed in Table 23.10:

Toolbar Functions

Exit Exits the context menu

Select Access Select (see Section 23.3.3) menu functions

Pan Pan around the viewing window

Rotate Access the Cursor 3D (see Section 23.4.1) toolbar functions

Zoom Access the View (see Section 23.4.1) toolbar functions

View Access the View 3D (see Section 23.4.2) toolbar functions

Render Change the quality of rendering in the viewer window

Save image Save the current view as an image (png, jpg, ps or tiff )

Table 23.10: Viewer pane context menu options

23.5.2 Toolbar / ‘Property Editor’ context menu

Right-clicking within any toolbar or at the top of the Property Editor (see Section 22.1) will bring
up the following menu depicted in Figure 23.10:
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Figure 23.10: Toolbar / Property Editor context menu

From here, it is possible to toggle the displaying of the Property Editor (see Section 22.1), Output
pane (see Section 11.7), Explorers (see Section 22.2), and Toolbars (see Section 23.4).

23.5.3 Explorer context menu

Right-clicking within any explorer will bring a menu of the type shown in Figure 23.11:

c© LimitState Ltd



CHAPTER 23. DISPLAY OPTIONS 189

Figure 23.11: Explorer context menu

From here you can copy and paste sections of data or, by selecting View, determine which properties
are displayed as columns in the explorer.
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Chapter 24

Analysis

24.1 The solver

A solver is required to find the critical collapse load factor and associated collapse mechanism. The
internal forces in the structure must satisfy all specified yield constraints; these are set up for a
particular problem by LimitState:RING.

The solvers used by LimitState:RING are the simplex solver CLP and the interior point solver Mosek,
both linear programming solvers. In LimitState:RING, problem data is passed to the solvers via
memory for maximum efficiency.

24.1.1 Checks and ‘Diagnostics tool’

During model generation and prior to solving, LimitState:RING runs a number of checks to ensure
the integrity and rationality of the model and file.

Some checks are carried out continuously and result in singular warning or error messages being
displayed to the user. These pertain to issues such as invalid licenses and geometries, and are
provided in Table 24.1.

Other messages are collated and shown at solve-time, or when the user opens the Diagnostics tool
dialog (as shown in Figure 24.1) by going to the Analysis menu and selecting Diagnostics.... These
messages are categorized according to severity as follows:

Information Useful reminders about the problem set-up that require no user action prior to solve.

Warning Messages regarding the problem set-up that may require user action prior to solve, but
which do not prevent solving.

Error Messages regarding the problem set-up that must be resolved by the user prior to solve.
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Check Warning
Check if a file can’t be opened Could not open the file because it is either an unsupported file type or the

file has been damaged.

Check if a file can’t be written to disk Cannot save or create this file. Make sure that the disk you want to save
the file on is not full, write-protected, or damaged.

Check if an error occurs during file
save

Error while saving file.

Check if a zero or invalid support
movement has been specified

One or more blocks with zero specified support movement have been de-
tected. These will be removed.

Check if a support block already has
movement applied

This block has already been added to the table.

Check if the bridge type has been
changed

When the bridge type was changed the effective width parameters were
reset to the default values.

Check if a vehicle is locked, but the
user is trying to edit it

This vehicle is locked - its properties cannot be edited!

Check if a vehicle with the specified
name already exists in the database

A vehicle with the same name already exists.

Check if a deleted vehicle is present
in existing load scenarios

You have deleted a vehicle. All instances of this vehicle used in the project
will be replaced by the default vehicle.

Check if a RING 2.0 file is loaded and
warn the user about possible geome-
try corruption

A LimitState:RING 2.0 project has been imported. However, due to a prob-
lem with the way LimitState:RING 2.0 stores user-defined profile points,
some points displayed in the Geometry Dialog may be invalid.

Check if the points entered won’t cre-
ate a valid arch profile

Warning: you have entered some data which is invalid. Please change
current points to continue.

Check if the points entered share an
x coordinate

Two or more entries have identical x co-ordinates, please amend.

Check if the points entered are not
sequential

The span could not be constructed using the points provided: The x co-
ordinates are not sequential.

Check if the points entered do not
form a convex curve

Cannot fit a convex profile through the specified points.

Check if insufficient span points have
been provided for the specified shape

The span could not be constructed using the points provided: Please enter
at least X points.

Check if no span points have been
provided

You must enter at least one point / depth! This will be used to generate
a horizontal fill plane.

Check if there are too many crown
points in the span

The span could not be constructed using the points provided: The maxi-
mum y coordinate is shared by more than one point.

Check if the points entered do not
allow a multi-ring barrel to be created

Cannot create a ring from the profiles entered. Tip: This is most likely
because there is some overlap between the intrados and extrados profiles
of one or more rings.

Check if the backfill is lower than the
top of the structure

Detected areas where the top of the backfill is lower than the arch rings.
Please check the Fill Profile / arch dimensions and amend where necessary.

Check if the solution presented po-
tentially contains numerical inaccura-
cies

Warning: detected numerical inaccuracies in the part of the solution re-
quired to display the collapse mechanism. This means that the displayed
mechanism may not be accurate.

Check if a license was held then lost The connection to the network license server or hardware dongle was lost.
You need to restart the application to be able to solve again.

Check if license does not have per-
mission to solve for certain features

Cannot solve as the following feature(s) in this project are not supported
by this <LICENSE TYPE >license:’

Check if the start position for an
‘Auto-load’ scenario can’t be deter-
mined

Unable to calculate valid auto load case start position.

Check if the end position for an
‘Auto-load’ scenario can’t be deter-
mined

Unable to calculate valid auto load case end position.

Check if the problem contains rein-
forcement or contacts with hinging
disabled

Note that as this Project includes reinforcement [and contact(s) with hing-
ing disabled], the thrust line and hinges are likely to lie outside the thickness
of the masonry.

Table 24.1: Continuous checks carried out by LimitState:RING and their associated warnings
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Figure 24.1: The LimitState:RING Diagnostics tool

The Display this dialog drop-down menu at the base of the Diagnostics tool allows the user to
specify the circumstances under which the dialog is displayed:

Always Displays the dialog before every Solve, irrespective of whether there are any warnings or
errors to report.

Warnings & Errors only Displays the dialog before Solve only when there are warnings or errors
to report.

Errors only Displays the dialog before Solve only when there are errors to report.

If the setting is changed to Errors only then any warnings encountered will instead be highlighted in
the Output pane by a hyperlink. Clicking the hyperlink will open the Diagnostics dialog with the
warnings present.

Severity Check Warning

Information Check for multi-ring problems The project contains one or more spans with multiple rings. By
default, these rings are assumed to be ’debonded’ (i.e. zero ten-
sion on the intermediate contacts). This may lead to solutions
with unexpectedly low adequacy factors. Use the ’Colour con-
tacts by shear bond strength’ functionality to query the contact
properties for the current model.

Information State the analysis type Analysis type: <ULS, PLS or Support Movement>

Information List the partial factors The following <ULS, PLS or Support Movement>partial factors
are set: <LIST>.

Warning Check for old files that may contain ge-
ometry issues

A LimitState:RING 2.0 project has been imported. However,
due to a problem with the way LimitState:RING 2.0 stores user-
defined profile points, some points displayed in the Geometry
Dialog may be invalid.

Warning Check for blocks with >1 edge touching
the fill

One or more blocks have multiple edges exposed to the fill ma-
terial. Fill forces on these will be modelled as acting at the
midpoint of the exposed edge with the greatest vertical step.
Affected blocks: <LIST>

Warning Check for reinforcement that has zero
tensile strength

Reinforcement with zero tensile resistance has been specified in
the problem, is this intended?

Continued on next page...
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Warning Check for reinforcement that will not af-
fect the solution

Reinforcement has been specified in the problem, but the proper-
ties mean that it will not have an effect at some or all locations.
This may for example be because the limiting tensile and com-
pressive forces are both zero.

Warning Check for reinforcement with zero shear
capacity

Reinforcement with a zero shear capacity has been specified in
the problem. This means that shear failure may be governing.

Warning Check that reinforcement is enabled at
the project level if it is present in the
model

Reinforcement is specified on one or more contacts but disabled
at the project level. Is this intended?

Warning Check for overlap of the surface and the
structure

Detected areas where the top of the backfill is lower than the
arch rings. Please check the Fill Profile / arch dimensions and
amend where necessary.

Warning Check for overlapping blocks There are overlapping blocks. Overlapping blocks: <LIST>

Warning Check for skewbacks with ZERO area Found skewback(s) with zero area. This is likely as a result of
specifying user-defined abutment angles or arch profiles. Please
check the failure mechanism obtained is sensible. <LIST>

Warning Check for identical loading scenarios The following scenarios are identical: <LIST>

Warning Check for contacts that may be ‘glued’
together

Found short inter-ring contacts with modified failure properties.
This may cause the arch (or sections of the arch) to act monolith-
ically and lead to artificially high load resistance being reported.
Please check contacts. Modified contacts: <LIST>

Warning Check for circumstances that may cause
the thrust to move outside the block-
work

Found contact(s) with reinforcement or disabled hinging. This
may cause the thrust line to extend beyond the boundaries of the
blocks. Affected contacts <LIST>.

Warning Check for varying unit weights within a
span

Detected varying unit weights within: <LIST>is this intended?

Warning Check for varying inter-ring contact
properties within a span

Detected varying inter-ring contact properties within: <LIST>is
this intended?

Warning Check for varying radial contact proper-
ties within a span

Detected varying radial contact properties within: <LIST>is this
intended?

Warning Check for mismatched impact settings
(i)

No dynamic / impact axles are specified, but the partial factor is
not equal to 1.0. Do you need to set dynamic axles on your load
vehicle(s)?

Warning Check for mismatched impact settings
(ii)

Dynamic / impact axles are specified, but the partial factor is
1.0. Do you need to change the dynamic partial factor?

Warning Check if backfill restraint is questionable Detected backfill elements that lie above the surface level. Please
consider whether these are able to provide the assumed magni-
tudes of resistance and reduce / zero the limiting force if required.
Questionable elements: <LIST>.

Warning Check for freestanding end piers One or both end abutments are explicitly modelled without fill
behind them. This will cause them to act as a freestanding end
pier. Is this intended?

Warning Check if support movements are speci-
fied for a non-movement analysis

Support movements have been specified, but the analysis type
(<ULS, PLS >) does not consider these. Is this intended?

Warning Check if the most suitable solver type is
being used (i)

The MOSEK solver is the default for solving a DXF imported
model. The problem is currently set to use <NAME >. Con-
sider switching solver to avoid a slow analysis (Tools menu
>Preferences >Solve).

Warning Check if the most suitable solver type is
being used (ii)

The MOSEK solver is the default for solving problems containing
multi-ring spans. The problem is currently set to use <NAME >.
Consider switching solver to avoid a slow analysis (Tools menu
>Preferences >Solve).

Warning Check for appropriate Spandrel Zone
Parameters if solving PLS

A PLS analysis has been specified, but Spandrel Zone Parame-
ter(s) <LIST >is/are set to zero. This may result in unintended
behaviour. Please check the backfill material properties (Ad-
vanced >PLS Tab).

Continued on next page...

c© LimitState Ltd



CHAPTER 24. ANALYSIS 195

Warning Check if an old file with multiple load
cases is loaded

An old file has been loaded that contains multiple load cases.
Vehicles facing in the ’normal’ direction are read in as travelling
from right to left. ’Mirrored’ vehicles are read in as travelling
from left to right. This accounts for the vehicle axle spacings in
older versions being specified in the x-positive direction, making
the leftmost axle the leading one.

Error Check for sensible fill force settings The user-defined minimum horizontal fill force acting on one or
more blocks is larger than the specified maximum. Please correct
using the Property Editor before solving. Affected fill element(s):
<LIST>.

Error Check for a problem that exceeds the
user-defined maximum size

Problem size exceeds the pre-defined limit. To modify the limit,
go to Tools >Preferences >Solve.

Error Check if ‘Auto-calculate effective width’
is used in a support movement problem

The automatically calculated bridge width feature cannot be used
in support movement analysis mode.

Error Check if a support movement analysis is
being attempted without any specified
block movement

Problem set to solve in Support Movement mode, but no support
movement has been specified.

Error Check that loading is specified Please specify a load if you wish to carry out an analysis.

Error Check if an ‘Auto’ analysis type is spec-
ified for a settlement (support move-
ment) problem

Auto scenario type is not compatible with settlement analysis
mode. Sequence is recommended.

Error Check for skewbacks with NEGATIVE
area

Found skewback(s) with negative area. This is likely as a result of
specifying user-defined abutment angles or arch profiles. Please
correct. <LIST>

Error Check for invalid blocks Found invalid block(s). Please correct. Invalid block(s) <LIST
>.

Table 24.2: Checks carried out by the LimitState:RING Diagnostics tool.

24.2 Analysis settings

24.2.1 Overview

To perform an analysis, on the Analysis menu click Solve. Alternatively, this command can be

accessed via the Solve button on the toolbar , and the keyboard shortcut for the command is F5.

24.3 Auto-solve

If the user finds that they use the Drag and Solve (see Section 18.6) method for the majority
of their problems, the Auto-solve feature should be enabled. This will cause LimitState:RING to
automatically solve each time the vehicle is moved. To enable, check the Solve automatically...
box in the Preferences dialog (located in the Tools menu).
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24.4 Types of analysis

24.4.1 Normal analysis

When a single load case is specified, the load factor that would, when applied to the specified live
loading, cause the bridge to collapse is calculated and displayed. When multiple load cases are set
up the collapse load factor associated with each case is calculated in turn. However, as the majority
of the problem remains unchanged, the total CPU time required e.g. for two load cases is rather less
than twice that required for one load case.

24.4.2 Iterative analysis

When finite masonry crushing strength is specified, the governing contact moment vs. normal force
failure envelope is non-linear, which means that an iterative analysis is required. In the iterative
analysis, the failure envelope is progressively refined until the true non-linear failure envelope is
properly represented (by using a series of linear constraints).

By default, the intermediate output from an iterative analysis is suppressed and only the final Ad-
equacy Factor is shown. To override this, and display all the iteration data in the Output pane,
check the Display iteration information in output window box in the Preferences dialog as
shown in Figure 24.2:

Figure 24.2: Analysis details in the Output pane

Note: when multiple load cases are also specified, an iterative analysis is now performed for all load
cases.

By default, the displayed output from an analysis is restricted to:

• The Load Case number (#)

• The Load Case name

• The names of the Vehicle(s) in the load case

• The vehicle Position(s) (in mm, measured from the left-hand springing of the left-hand arch)

• The Effective bridge Width (in mm, either fixed or calculated)

• The solution (as an adequacy factor on the applied load)
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• The minimum Adequacy Factor calculated over all the load cases

To enable the display of all iteration data, go to the Preferences dialog in Tools (see Section 23.3.5)
and select the option to Display iteration information in output window.

24.5 The solvers

A solver is required to find the critical collapse load factor and associated collapse mechanism. The
internal forces in the structure must satisfy all specified yield constraints; these are set up for a
particular problem by LimitState:RING.

Version 4.0 of LimitState:RING makes use of two third-party solvers - Mosek (which uses an interior
point optimization algorithm) and CLP (which uses a simplex optimization algorithm). Both are
powerful linear programming solvers with the problem data passed via memory to maximize efficiency.

By default, LimitState:RING will automatically choose the most appropriate solver for the type of
problem being analysed. A single-ring problem (one where all the spans possess a single ring of
masonry) will be solved using CLP. Multi-ring problems will be solved using Mosek. Should the user
wish to override this setting, it can be done in the Preferences dialog (Tools >Preferences). Note
that solving complex multi-ring problems using CLP may result in a long computation time.

24.6 Analysis results

24.6.1 ‘Adequacy Factor’ found

Following a successful analysis the minimum Adequacy Factor will be displayed at the bottom right
of the LimitState:RING application window, and also in the Output pane. If multiple load cases are
specified then this load factor will be the lowest found for all the load cases tried.

The Adequacy Factor is the multiplier on factored vehicle loads required to cause collapse in the
structure being modelled.

Where the Adequacy Factor is 1.0 or above, the output will be presented in green text.

Where the Adequacy Factor is below 1.0, the output will be presented in red text.

24.6.2 No solution found

When masonry crushing is not enabled, it is possible that the applied load can be increased without
limit. In this case, the structure can be described as being ‘geometrically locked’. This result will
typically occur if the specified arch thickness is large and rigid abutments are specified. Alternatively,
if no part of an applied load falls on the bridge then this outcome will result.

Alternatively, it might be that no solution could be found because no viable equilibrium state could be
identified. This result will typically occur if the arch is the ‘wrong shape’ in relation to the specified
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dead loading (i.e. the dead loads alone are sufficient to cause the structure to collapse). In this case,
an ‘unstable’ message will be reported.

24.6.3 Aborting an analysis

After an analysis is started, LimitState:RING then waits for a solution to be found. To abort this
process, the user should click on the red stop button on the toolbar or press the Esc key to abort
the analysis and return control to the user.
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Post-analysis functions

25.1 ‘Adequacy Factor’ plot

For analyses involving more than a single load case, a plot of the Adequacy Factor against Load
Position will be created on Solve, for example, see the plot in Figure 25.1.

Different loading types will be treated as follows:

Auto These scenarios will be represented by coloured, circular data points joined by lines. Different
scenarios will have a different colour.

Sequence These scenarios will be represented by square, black data points and will not be connected.

Single These scenarios will be represented by a square, black data point.

199



200 CHAPTER 25. POST-ANALYSIS FUNCTIONS

Figure 25.1: Plot of Adequacy Factor against Load Position for a problem containing four scenarios

25.1.1 Critical and near-critical cases

As part of the analysis, the critical load position (i.e. that corresponds to the lowest value of
Adequacy Factor over all the scenarios) will be highlighted with a large, red data point.

It is often useful to also understand which load cases lead to near-critical conditions. As such, any
data point, over all scenarios, that corresponds to an Adequacy Factor within 1% of the critical
value will be highlighted using a large orange data point.

Both of these situations are illustrated in Figure 25.2:
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Figure 25.2: Detail from the plot of Adequacy Factor against Load Position, showing critical and
near-critical cases

25.1.2 Interacting with the plot

As well as providing a useful comparison tool, the plot can be queried and manipulated as follows:

Hover Hovering the mouse cursor above any data point will display the values of Adequacy Factor
(AF) and Position (Pos) for the case in question.

Hover and click Left-clicking with the mouse on any data point will set the viewer to display the
corresponding load case.

Zoom Drawing a rectangle using the mouse, or using the scroll wheel will zoom in and out of the
plot. Double-clicking with the mouse will reset the view of the plot to the maximum extent.

Pan Clicking and holding the scroll wheel, while moving the mouse, will pan the plot.

Save image Right-clicking with the mouse in the plot will bring up a context menu with the option
to save the plot as a raster image (PNG, JPG, TIFF or BMP).

25.2 Visual output

Once a problem has been successfully solved, the visual output is displayed on the viewing pane. The
thrust line shown is calculated without accounting for the presence of reinforcement i.e.:

Eccentricity = Axial Force / Moment
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Depth of crushing = Axial Force / (Masonry crushing strength x Bridge Width)

It follows that, when the reinforcement is active, the thrust line will lie outside the barrel thickness,
as indicated in Figure 25.3:

Figure 25.3: Thrust line lying outside the arch barrel in areas where reinforcement is active

Note: in the vicinity of backing, the thrust line may exhibit ‘spikes’ as large forces are transmitted
from the arch into the backing material. Also, if reinforcement is specified in the problem, the line of
thrust may be displayed as being outside of the arch but without an associated hinge forming. Both
of these situations are perfectly normal.

25.2.1 Force diagrams

To allow alternative interpretation of the behaviour of the structure when reinforcement is present,
in LimitState:RING 4.0, the capability to view normal force (kN/m bridge width), shear force (kN/m
bridge width) and bending moment (kNmm/m bridge width) diagrams has been added. These can

be accessed in a solved model by clicking the moment, shear or normal force icons: , and .

This is illustrated for a beam case in Figure 25.4, and in the case of an arch bridge in Figure 25.5.
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(a) Shear force

(b) Moment

Figure 25.4: Sample beam shear force and moment diagrams

The force diagrams can be displayed by navigating to the relevant options in the View menu, or
by using the ‘appropriate’ toolbar buttons to toggle the view of the normal force, shear force and
moment.

Note:

1. The entities (e.g. thrust and/or bending moment diagrams) displayed on screen when the
report is generated (via Analysis > Report...) will be those also displayed on the image in the
report.

2. A given magnitude (e.g. shear force magnitude) can be queried by clicking on the part of the
contact of interest not obscured by the diagram, and referring to the Property Editor.

25.3 Quantitative output

The contact normal force and bending moment values displayed in the Property Editor, Contact
explorer and in the report output are combined values that take account of joint stresses and the
presence of reinforcement.

Full details of the reinforcement specifications are also included in the Report output (see Chapter
26).
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(a) Normal forces

(b) Shear forces

(c) Moments

Figure 25.5: Sample arch bridge normal force, shear force and moment diagrams
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Report output

26.1 Viewing report output

Following an analysis it is often useful to summarize details of the bridge and of the analyses per-
formed, and then print this out. LimitState:RING comes with an inbuilt word processor, so a Report
output can be generated on any computer, exported to an Adobe pdf file and / or printed.

To view the report as shown in Figure 26.1, on the Analysis menu click Report...:

Figure 26.1: LimitState:RING report
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From here, details can be changed as required, or the layout altered, using commands familiar to
most users who have previously used word-processing packages.

26.2 Adding a template, header or footer

A style template or custom headers and footers can also be appended to the report by selecting the
Tools menu, clicking Preferences and selecting the Report tab, as shown in Figure 26.2:

Figure 26.2: LimitState:RING Report Preferences
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Command line interface

27.1 Overview

The LimitState:RING command line interface add-in allows users to run the software and / or change
problem parameters from a command prompt or batch file. This is especially useful when conducting
parametric studies, generating interaction diagrams or when needing to run a sequence of analyses
on a PC unattended (e.g. if models are particularly large).

Parametric studies With the command line interface, users can modify a wide range of parameters
in a single LimitState:RING model without the need to manually edit a file or group of files.
This allows parametric studies to be conducted quickly and with minimum user intervention.
Full reports and solution files are automatically generated, as well as individual input files
corresponding to each parameter change, so the results can be queried in detail.

Unattended analyses When a large number of analyses need to be run, and the operator can’t be
present to inspect and / or save the results, a simple batch file can be created to run Limit-
State:RING command line instructions, and to undertake a sequence of unattended analyses.

27.1.1 Usage

To run LimitState:RING from the command line, first open a command prompt.

Running LimitState:RING from the command line requires a valid LimitState:RING (.ring) input file.

All calls to run the software from the command line must be made from within the ‘bin’ folder in
the LimitState:RING installation directory (if the full path is to be omitted) or include the relative
or full path to the executable from the current directory. Similarly, filenames must be preceded by
the path if not present in the calling directory.

Note that LimitState:RING is not added to the ‘Path’ in the Environment Variables of the machine
it is installed on. Adding it will allow command line calls to be made without the requirement to
include the full path to the executable file in the call.
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27.1.2 Output

The output from running a LimitState:RING analysis from the command line includes on-screen
information and a number of files that can be enabled or disabled as required.

On-screen output

Note that verbose output will be given if this is set in GUI mode, otherwise, brief solve information
will be displayed.

Diagnostic messages Informs the user how many diagnostic ‘information’ or ‘warning’ messages
are encountered before a solve. If an ‘error’ is encountered then the file will not solve. If the
file is being solved as part of a batch command, the next command in the list will be executed
[shown by default].

File output

By default, if running the file ‘test.ring’ without any modifications to the model properties, the output
will be:

test.txt A text file containing the solution output from the analysis. All data that would normally
appear in the Output window when in GUI mode will be written to this file. In the event of
a crash, all data up to that point will be saved. Note, however, that the data on the file is
overwritten on each Solve.

test.rtf An editable report corresponding to the analysis (the content included in the report can also
be specified by the user).

If running ‘test.ring’ with modifications to properties, a LimitState:RING file containing the modifi-
cations will also be output by default:

test <SUFFIX>.ring A LimitState:RING file including any modifications made.

<SUFFIX> will be replaced by automatically generated text describing any modifications made or
suffix text specified by the user as a command line argument.

Additionally, but not by default, a comma separated solution file may also be output. This will
aggregate the relevant analysis output (date and time, solution, input file name, modifications) from
one or more analyses if specified:

Note:

1. The .ring, .txt and .rtf output files will be saved in the same directory as the original input file,
not the directory from which LimitState:RING is called. Write permissions are required in this
output directory, otherwise the output will not be saved.
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2. All paths containing a space should be enclosed in quotation marks when entered into the
command line interface.

3. Once an analysis has been initiated, the user is free to use the command line for other tasks.
The analysis will continue to run, the output will be sent to the screen and the solution files
saved as normal.

27.1.3 Units

Files store all data in metric units (metres, kilonewtons etc.), irrespective of the unit system used in
GUI mode. Therefore, any modifications made to the input must be carried out using metric units.

27.1.4 Help

To access the command line interface help documentation, open a command line window, navigate
to the directory containing the LimitState:RING executable and enter:

>ring64.exe -help

27.2 Command line syntax

The syntax for running LimitState:RING via the command line takes the following form:

> <APPLICATION>[OPTIONS] <INPUT FILE>

where:

<APPLICATION> is the path to, and name of, the LimitState:RING executable file.

[ OPTIONS ] are optional parameters that influence the nature and output of the analysis.

[ INPUT FILE ] is the name of the LimitState:RING input file.

A typical command line call might read:

ring64.exe -execute -vehicle override:"[3t GVW] 2t Single Axle (CS454)"

"C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring"

or, using short commands:

ring64.exe -x -rv:"[3t GVW] 2t Single Axle (CS454)"

"C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring"

Entering either of these commands would execute DefaultBridge.ring with a new vehicle, “[3t GVW]
2t Single Axle (CS454)”.
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27.2.1 Options syntax

The syntax for the available options is presented in Table 27.1.

Option Short Description
-property -p Modify a property of the problem.

-execute -x Solve the problem.

-save -s Save the input file. If the properties have
been modified using the ‘-p’ command, the
modified file will be saved automatically
with a new name. All other modifications
(e.g. ‘-rv’) will not automatically trigger a
save.

-no save -ns DO NOT automatically save a copy of the
modified input file.

-no report -nr DO NOT save the report output (.ODT)
from the analysis.

-no log -nl DO NOT save an output file (.txt) contain-
ing the analysis data.

-sol file -sl Output a solution file (.csv) containing the
key details from the analysis.

-suffix -sf Add user-defined suffix text to the files out-
put from the analysis.

-version -v Display the version number of Limit-
State:RING that is being used.

-uncomp -u Uncompress the named LimitState:RING
file.

comp -c Compress the named LimitState:RING file.

Table 27.1: Command line options syntax

27.2.2 The solution file

The -sol file (-sf) option specifies that a comma-separated value (.csv) solution file containing the
most relevant analysis data is to be created (or added to if it already exists). The data included in
the file is:

Date and time The date and time that the analysis was started.

Adequacy Factor The calculated adequacy factor for the solved problem.

File name The name of the solved file.

Modifications A list of the modifications made to the file.

The solution file will, by default, be saved in the directory where the LimitState:RING executable lies.
This allows data from multiple input files to be collated in an easily identified location (especially
useful if running a batch file). The user can specify an alternative location for the solution file if
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required (see below). Write permissions are required in the save directory, otherwise the output will
not be saved.

Saving a solution file requires a file name to be specified. The syntax is as follows:

-sol file:"<SOLUTION FILE NAME>"

where <SOLUTION FILE NAME>is the path and name of the solution file (including the .csv
extension).

For example, to execute a file named ‘test.geo’ and log the analysis in
“C:\Users\AnneEngineer\My Documents\ring log.csv” enter:

>ring64.exe -x -sl:"C:\Users\AnneEngineer\My Documents\log.csv" test.ring

If the solution file does not already exist, it will be created containing a header line describing the
contents of the file.

27.3 Property group commands

The most useful functionality provided by the LimitState:RING 4.0 command line tool are probably
the property group commands, which allow the user to replace, remove, or create groups of XML
properties together, allowing for behaviour that is not possible by simple modifications to individual
properties. A list of these commands can be found in Table 27.2, and are discussed in turn below:

Name Command
Vehicle override -rv

Dynamic-axle override -da

Direction override -d

Set position -pos

Unit weight override -rw

Crushing strength override -rcs

Friction override -rf

Shear override -rs

Partial factors override -pf

Table 27.2: Property group commands

27.3.1 Vehicle override

The “replace vehicle” command is used to overwrite the load cases found in a file with a single
load case using a specified vehicle. It is typically used as follows:

ring64.exe -x -rv:"<VEHICLE NAME>" "<FILE PATH>"

where <VEHICLE NAME>is the name of the vehicle as it appears in the Vehicle Database and
<FILE PATH> is the path of the file containing the project that we wish to solve for. By default,
the file is solved with the new vehicle as type “auto”.
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An example of the command is shown below:

ring64.exe -x -rv:"[3t GVW] 2t Single Axle (CS454)"

"C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring"

This will:

• open the file C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring;

• remove all scenarios in that file;

• create a new scenario using the “[3t GVW] 2t Single Axle (CS454)” vehicle with type = auto;

• solve in console mode.

27.3.2 Position override

The position override command is used in conjunction with the replace vehicle command to use a
vehicle of type “single position”, and set the position of that new vehicle on the bridge. It is typically
used as follows:

ring64.exe -x -pos: "<POSITION>" -rv:"<VEHICLE NAME>" "<FILE PATH>"

where <POSITION>is a number specifying the position of the vehicle along the bridge.

An example of the command is shown below:

ring64.exe -x -pos:2500 -rv:"[3t GVW] 2t Single Axle (CS454)"

"C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring"

This will:

• open the file C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring;

• perform the replace vehicle command with the “[3t GVW] 2t Single Axle (CS454)” vehicle;

• change the type of the replaced vehicle to “single position”;

• set the position of that vehicle to x = 2500;

• solve in console mode.

Note that:

• Replacing a vehicle without specifying the position of the new vehicle will delete all existing
scenarios and make a new scenario with the given vehicle. This will be an auto-solve scenario.

• Replacing a vehicle with a position specified will delete all existing scenarios and make a new
scenario with the given vehicle. This will be an single solve scenario at the position specified.
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27.3.3 Direction override

The direction override command is used to set the direction of all vehicles in a file as desired. It will
apply to all vehicles in all scenarios and is typically used as follows:

ring64.exe -x -d:"<DIRECTION>" "<FILE PATH>"

where <DIRECTION NAME>is a text string specifying the new direction in which the vehicle should
be facing. Note that switching the direction will mirror the vehicle in the line x = p, where p is the
position of the first axle. The command expects one of the two following strings:

• “l2r” (left to right)

• “r2l” (right to left)

An example of the command is shown below:

ring64.exe -x -d:"l2r"

"C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring"

This will:

• open the file C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring;

• set the vehicle direction of all vehicles in that file to “left to right”;

• solve in console mode.

27.3.4 Dynamic axle override

The dynamic axle (impact) override command is used to override the dynamic axles of a vehicle
newly created with the replace vehicle command. It is typically used as follows:

ring.exe -x -da:"<DYNAMIC AXLES>" -rv:"<VEHICLE NAME>" "<FILE PATH>"

where <DYNAMIC AXLES>is a text string specifying the new dynamic axles e.g.:

“1” Set first axle as dynamic.

“1,3,5” Set axles 1, 3 and 5 as dynamic.

An example of the command is shown below:

ring64.exe -x -da:"1,2,3,4" -rv:"[3t GVW] 2t Single Axle (CS454)"

"C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring"

This will:
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• open the file C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring;

• perform the replace vehicle command with the “[3t GVW] 2t Single Axle (CS454)” vehicle;

• set the axles 1, 2, 3, and 4 on the vehicle as dynamic;

• solve in console mode.

27.3.5 Partial factors

The “Partial Factor” commands pfu and pfp are used to respectively override the ULS and PLS
partial factors in a file. Only one value can be modified per call, but the call can be made multiple
times in a single command. It is typically used as follows:

ring64.exe -x -pfu:"<PARTIAL FACTOR>"="<VALUE>" "<FILE PATH>"

where <PARTIAL FACTOR>is a key specifying the Partial Factor to modify, and <VALUE>is the
new value that it should be given. The keys of the different partial factors are:

Partial Factor Key
Axle load axleL

Dynamic factor dynamicF

Load effects / model factor modelF

Surface fill / ballast unit weight ballastUW

Masonry unit weight masonryUW

Fill unit weight fillUW

Track load trackL

Masonry compressive strength masonrySTR

Masonry shear bond strength masonrySHE

Masonry friction masonryF

Table 27.3: Partial Factor keys

An example of the command being used to modify the ULS axle load factor is shown below:

ring64.exe -x -pfu:axleL=1.5

"C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring"

This will:

• open the file C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring;

• set “axle load” partial factor to 1.5;

• solve in console mode.

27.3.6 Material properties

The material properties commands are used to override select material properties for all blocks or
contacts in a file. There are four commands available, shown in Table 27.4:
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Material property Command
Masonry unit weight -rw

Masonry crushing strength -rcs

Masonry friction -rf

Masonry shear -rs

Table 27.4: Material properties commands

It is typically used as follows:

ring64.exe <COMMAND>:<VALUE> "<FILE PATH>"

where <COMMAND> is one of the commands specified in Table 27.4, specifying the material
property to change, and <VALUE> is the new value that it should be given. An example of the
command being used to overwrite the unit weight of all masonry in the file is shown below:

ring64.exe -x -rw:25

"C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring"

This will:

• open the file C:\User Data\UserName\Documents\LimitState RING files\DefaultBridge.ring;

• set the unit weight of all masonry to 25 kg/m3;

• solve in console mode.

27.4 File format

Project files (.ring) are saved in compressed Extensible Markup Language format (XML - see here
http://en.wikipedia.org/wiki/XML). As such, they can be uncompressed (using a tool installed with
LimitState:RING) and the contents inspected in order to determine the descriptors used to assign
properties to different materials, geometry objects etc.:

27.4.1 Decompressing files

To decompress a LimitState:RING file, select and right click with the mouse. The option to Convert
to XML will be displayed in the context menu. Select this and the file will be converted and a copy
saved in the same location with the suffix ‘UnCompressed’ e.g. ‘testFile.ring’ will be uncompressed
and saved as ‘testFileUnCompressed.ring’. The file can then be read into any text editing software
(e.g. MS Notepad). Alternatively, files can be uncompressed from the command line (see Section
27.2).

Note:

1. LimitState:RING files cannot be uncompressed using standard compression software.

2. A license is not required in order to access the convert functionality.
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27.5 Properties

The following sections detail some of the more commonly used properties that can be modified using
the command line. Many have short codes that are used to represent longer property names as seen
in the XML. Not all properties are listed - others can be identified by examining the uncompressed
XML directly.

27.5.1 Object keys

Modifying any property relies on knowing the appropriate Object Key. These, along with access to
the command line functionality, are available to users holding an appropriate license.
Object Keys are unique numerical identifiers for the individual parts (materials, geometry objects
etc.) of a LimitState:RING project that, when used on the command line, will allow modification of
the value for a particular property of said part. Project-level properties can also be edited using the
command line interface but require no object key. The syntax for modifying any property with an
object key is:

ring64.exe -x -p:<PROPERTY NAME>: <KEY >= <VALUE>

"<FILE PATH>".ring>ring -p:cu:44=30 -x -sf: my test test.ring

• <PROPERTY NAME> is the XML property name that can be found in TABLE REF or the
uncompressed XML.

• <KEY> is an ID of the object to be modified, these are displayed in the Property Editor
when in GUI mode. They are hidden by default - to show them, go to Tools > Preferences >
General > Show additional Property Editor attributes.

• <VALUE> is the new value to be applied to the property.

For example:

>ring64.exe -p:bridgeWidth:2=2500 -x “test.ring”

will execute test.ring with the bridge width set to 2500mm.

When directly examining the XML code for a file, the object keys are specified by the text as:

k="<a number>"

For example:

k="NUMBER" is the key for the solid.

27.5.2 Project properties

Project properties can be modified via the project key:
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Short Name XML Property Name Allowed Values
Auto calculate AutoCalculatedWidth true/false

Effective width bridgeWidth > 0

Table 27.5: Project properties

27.6 Creating and running a batch file

In addition to single command line calls, it is possible to run LimitState:RING from a batch file.
This allows multiple files to be amended and solved without the requirement to be present at the
machine. To create a batch file, open a text editor such as MS Notepad and enter the commands.

Save the file with the extension ‘.bat’ while ensuring that the ‘Save type’ is set to ‘All files (*.*)’.

To run the batch file, open a command prompt in the location of the file and enter the name, followed
by the .bat extension.

At its simplest, the syntax of a batch file need only resemble a number of individual command line
calls on separate lines.
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Appendix A

Mathematical formulation

A.1 Joint equilibrium formulation (adequacy factor analysis)

This section contains details of the mathematical formulation used in LimitState:RING 4.0. A joint
equilibrium formulation, similar to that proposed initially by (Livesley 1978) is used. Whilst this
formulation produces a large number of constraints and variables, the total number of non-zero
elements will generally be relatively small, which means that it can be solved very efficiently using
modern interior point Linear Programming (LP) algorithms. Thus, assuming there are b blocks and
c contact surfaces, the problem may be stated as follows:

Max λ (A.1)

subject to the equilibrium constraints:

Bq− λfL = fD (A.2)

and no-tension (‘rocking’) yield constraints:

mi ≤ 0.5niti
mi ≥ −0.5niti

}
for each contact, i = 1, ..., c (A.3)

and sliding yield constraints:

si ≤ µini
si ≥ −µini

}
for each contact, i = 1, ..., c (A.4)

where λ is the load factor (which is the same as the adequacy factor when the vehicle loads are not pre-
factored), B is a suitable (3b×3c) equilibrium matrix containing the direction cosines, and q and f are
respectively vectors of contact forces and block loads. Thus qT = {n1, s1,m1, n2, s2,m2, ..., nc, sc,mc}; f =
fD+λfL, where fD and fL are respectively vectors of dead and live loads. Contact and block forces,
dimensions and frictional properties are shown in Figure A.1. Using this formulation the LP problem
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variables are the contact forces: n1, s1,m1 (where ni ≥ 0; si,mi are unrestricted ‘free’ variables),
and the unknown load factor, λ.

Figure A.1: Block and contact forces

A.2 Joint equilibrium formulation (support movement analysis)

The problem may be stated as follows:

Min E (A.5)

subject to the equilibrium constraints:

Bq− fSUP = fD (A.6)

and a constraint specifying support movement:

dTSUP fSUP − E = 0 (A.7)

where E is the support movement energy, and dsup and fsup are respectively vectors of pre-defined
block support movements and unknown block support reactions (see Figure A.1 for block degrees of
freedom). Other terms are as defined in Appendix A.1.

The yield conditions equation A.3 and equation A.4 are also imposed in an unchanged form. Using this
formulation the LP problem variables are the contact forces: (where ni ≥ 0; si,mi are unrestricted
‘free’ variables), the support reactions in fsup and the support movement energy E.

A.3 Including finite masonry material strength

The yield constraints (equation A.3) given in Appendix A.1 are valid only if the material is infinitely
strong in compression. If it is assumed that the masonry possesses finite masonry strength and that
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the thrust is transmitted through a rectangular crush block, then (equation A.3) may be replaced
with:

mi ≤ ni
(
0.5ti − ni

2σcrushb

)
mi ≥ −ni

(
0.5ti − ni

2σcrushb

)  for each contact, i = 1, ..., c (A.8)

where b is the breadth of the masonry section.

To aid comparison, both equation A.3 and equation A.8 are plotted in Figure A.2:

Figure A.2: Contact surface moment vs. normal force failure envelopes

However, the constraints in equation A.8 are non-linear. Therefore, if the LP solver is still to be
used to obtain a solution to the global problem, then these constraints need to be approximated as
a series of linear constraints.

In order to minimize the number of constraints in the problem (and to maximize computational
efficiency) an iterative solution algorithm, which involves only refining the representation of the
failure envelope where required, is used:

A.3.1 Algorithm

1. For each contact i, initially add three linear constraints (i.e. OA, OB & AB in Figure A.2).

2. Obtain a solution to the global LP problem.

3. For each contact i, substitute ni from the last solution into the inequality constraints in equa-
tion A.8. If a constraint is violated, calculate the violation factor ki; i.e.:

ki =
|mi|

ni

(
0.5ti−

ni
2σcrushb

)
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4. For each contact with ki > 1.0 (i.e. violation), add an additional linear constraint (e.g. in
the case of point X in Figure A.2, introduce a new linear constraint tangential to the true
non-linear constraint at X ′).

5. Repeat from step 2 until the maximum value of ki < 1 + tol, where tol is taken as a suitably
small value.

A.4 Including reinforcement

LimitState:RING 4.0 uses rigorous optimization techniques to find the distribution of internal forces
that give rise to the largest possible load factor, which can be applied whilst still satisfying equilibrium
and yield constraints.

When reinforcement is involved, consider a contact between adjacent rigid blocks. In order to model
a rectangular crush block of initially unknown depth (see Figure A.3), the failure criterion given in
Appendix A.3 can still be used providing the normal force ncont and moment mcont values used only
account for the effects of contact pressures i.e. those which exclude the effects of any reinforcement
bars that span across the contact.

Figure A.3: Contact surfaces with top and bottom reinforcement bars

However the presence of reinforcement has the effect of modifying the total normal force and moment
at the contact as follows:

Total normal force carried, ntot = ncont + CA + CB − TA − TB

Total moment carried, mtot = mcont + dA(CA − TA) + (t− dB)(CB − TB)

where CA, TA and CB, TB are respectively the compressive and tensile reinforcement forces near
contact edges A and B, and t is the contact thickness. The reinforcement forces are free to take on
any positive value up to user-specified limits; after solving the software will identify a set of values
corresponding to the critical load factor or prescribed support movement, though outside yielding
regions these values will generally not be unique. The increased normal force and moment that
can be carried means that the predicted load-carrying capacity of a bridge containing reinforcement
will always be greater than or equal to that corresponding to an otherwise identical bridge without
reinforcement.

Modelling bars separately from the line contact as described above obviates the need to use a more
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complex ‘reinforced concrete’-type yield surface. However, the equivalence of the results obtained
can easily be verified (see Appendix F).

Finally, it should be noted that the contact normal forces and moments reported in LimitState:RING
4.0 (in the Property Editor, Explorers and Report) are total values i.e. as given by ntot and mtot

respectively.
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A.5 Worked example

This worked example is designed to help illustrate how the mathematical formulation described in
Appendix A.1 may be applied in practice.

To ensure that the number of problem variables and constraints are kept down to an absolute
minimum, a simple three block arch is considered, as shown in Figure A.4. (This geometry can be
generated in LimitState:RING 4.0 by specifying a span of 20m, a rise of 10m, a ring thickness of
1.5m and three blocks in the span.) Each block, labelled A, B and C is, for simplicity, assumed to
weigh 1 unit. Block A is also subject to a unit live load applied at the centroid. The blocks are
separated by four contact surfaces, labelled 1, 2, 3 and 4. The blocks are taken to be infinitely strong
and the contacts are taken to have a coefficient of friction of 0.6. The objective is to find the load
factor (or ‘multiplier’) λ, which can be applied to the live load in order to cause collapse (N.B. The
load factor λ is equivalent to the Adequacy Factor (AF ) when the live load is not pre-factored).

Figure A.4: Details of simple three block arch example problem

As described in Appendix A.1, the problem formulation involves equilibrium constraints, yield con-
straints and an objective function.

A.5.1 Equilibrium constraints

Consider the equilibrium of block A as shown in Figure A.5:
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Figure A.5: Block A: forces and geometry for formulating equilibrium constraints

Resolving forces in the X direction:

− s1 + s2 sin 30− n2 cos 30 = 0 (A.9)

∴ −s1 +
s2
2
− n2

√
3

2
= 0 (A.10)

Resolving forces in the Y direction:

− n1 + s2 cos 30 + n2 sin 30 + λ+ 1 = 0 (A.11)

∴ −n1 + s2

√
3

2
+
n2
2

+ λ+ 1 = 0 (A.12)

Taking moments about the block centroid:

− s1 × y − n1 × x−m1 − s2 × y + n2 × x+m2 = 0 (A.13)

∴ −4.662s1 − 2.674n1 −m1 − 4.662s2 + 2.674n2 +m2 = 0 (A.14)

Clearly, similar relationships can readily be derived for blocks B and C (in the case of the moment
equilibrium constraint it is only necessary to change the subscripted numerals).
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A.5.2 Yield constraints

Consider the no-tension constraints for contact 1; these can be obtained simply by entering the
actual arch thickness (1.5) in equation A.3, and re-arranging to ensure problem variables are on the
left-hand side:

m1 ≤ 1.5(0.5n1) (A.15)

∴ −1.5(0.5n1) +m1 ≤ 0 (A.16)

m1 ≥ 1.5(−0.5n1) (A.17)

∴ −1.5(−0.5n1)−m1 ≤ 0 (A.18)

Consider the sliding constraints for contact 1; these can be obtained simply by entering the actual
coefficient of friction (0.6) in equation A.4 and re-arranging to ensure problem variables are on the
left-hand side:

s1 ≤ 0.6n1 (A.19)

∴ s1 − 0.6n1 ≤ 0 (A.20)

s1 ≥ −0.6n1 (A.21)

∴ −s1 − 0.6n1 ≤ 0 (A.22)

These yield constraints can also be used for contacts 2, 3 and 4 (by simply changing the subscript
according to the contact number).

A.5.3 Objective function

In this case the objective is simply to maximize the load factor λ.

A.5.4 Problem matrix

The problem matrix (also termed the ‘linear programming tableau’) may now be formed, as shown
in Table A.1:
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Table A.1: Problem matrix (‘linear programming tableau’)

This problem can now be solved using any suitable linear programming solver. For this problem, the
critical load factor may be found to be 2.742.

Once solved, values for the contact stress resultant variables (shear force, normal force, moment)
also become available. Additionally, quantities that correspond to these in a work sense also become
available (sliding displacement, opening displacement, rotation). This allows the collapse mechanism
to be identified, which in this case is a four hinge failure mechanism.
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Appendix B

Additional notes on the backfill model

B.1 Boussinesq distribution model

According to Boussinesq theory, the vertical stress at point X, due to a uniform pressure q on a strip
area of width B and infinite length, is given in terms of the angles and as defined in Figure B.1:

Figure B.1: Vertical stresses calculated according to Boussinesq theory

Although the distribution has been used for many years in masonry arch analysis programs (e.g.
Choo et al. 1991), from a theoretical perspective the use of a Boussinesq-type distribution is not
entirely satisfactory, since:

1. there does not exist a semi-infinite elastic half space below the load;

2. the elastic distribution indicated is not really compatible with an ultimate load analysis.

However, notwithstanding the above comments, the above equation does provide a useful means of
generating a suitable ‘bell shaped’ curve.

Furthermore, to avoid excessive distribution at the ULS, when concentration of the load is likely, the
Boussinesq distribution is truncated in LimitState:RING 4.0, with the computed stresses factored up
to ensure the vertical applied load is equal to the sum of the distributed load stresses multiplied by
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the areas over which they act. However, as applied loads are normally placed at numerous positions
across the bridge, no attempt is made to ensure that the centre of the line of action of an applied
load coincides with the centre of the line of action of the distributed loads (i.e. moment equilibrium
is not enforced).

B.2 Limiting horizontal fill stresses

The horizontal soil stresses applied to the extrados of a given voussoir are limited in LimitState:RING
4.0 to those that would just cause sliding of the overlying strip of soil.

The relevant vertical and horizontal stresses and forces, together with the normal and shear forces,
are shown on Figure B.2:

Figure B.2: Forces acting on extrados of a block subject to backfill pressures

where σv and σh are respectively the applied vertical and horizontal stresses, which give rise respec-
tively to stress resultants V and H; also N and S are respectively the resulting normal and shear
forces at the extrados of the block.

If the specified soil / arch interface has friction δ and adhesion a, then the overlying strip of soil will
just slide when:

Smax = N tan δ + al (B.1)

where:
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Smax = Hmax cos θ − V sin θ (B.2)

N = Hmax sin θ + V cos θ (B.3)

Hence the maximum applied horizontal force can be expressed as:

Hmax =
al + V (cos θ tan δ + sin θ)

cos θ − sin θ tan δ
(B.4)

Now:

Hmax = vσh,max (B.5)

V = hσv (B.6)

Hence the maximum horizontal stress that can be applied is:

σh,max =
al + hσv(cos θ tan δ + sin θ)

v(cos θ − sin θ tan δ)
=
a+ cos θσv(cosσ tan δ + sin θ)

sin θ(cosθ − sin θ tan δ)
(B.7)

B.3 Passive and active fill pressures

At collapse, portions of the arch will move into the backfill, thereby mobilizing passive earth pressures.
Other portions of the arch may move away from the soil, thereby mobilizing active earth pressures.
The passive pressures in particular can have a significant effect on the arch collapse load. The semi-
empirical soil model employed in LimitState:RING 4.0 models passive earth pressures by applying
empirical correction factors mp and mpc to the lateral earth pressure coefficients Kp and Kpc that
are normally computed for vertical smooth retaining wall as follows:

Kp =
1 + sinφ

1− sinφ
= tan2

(
45 +

φ

2

)
(B.8)

Kpc = 2
√
Kp (B.9)

LimitState:RING 4.0 model does not, by default, include active pressures in the analysis, though
users can include them if they wish. It is important to appreciate that quantitative values of mp and
mpc are, at present, empirical and have a limited theoretical basis. They correct for a number of
effects including:

• the curved shape of the arch;
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• the magnitude of the soil / arch interface friction and / or adhesion;

• gross displacement and strength mobilization effects (see also Appendix B.4);

• in-situ lateral earth pressures arising, for example, from compaction of the fill; and

• active pressure effects on other portions of the arch.

Note that while values of the soil / arch interface properties can be specified in LimitState:RING 4.0,
these are used in a limited way, as discussed in Appendix B.2. In LimitState:RING 4.0, the default
value of mp is taken as 0.33. This has been shown to give a reasonable prediction of collapse load in
physical model tests on single-span arches. There is very limited data currently available for the effects
of cohesion on arch collapse load. The default factor mpc is therefore currently set conservatively at
0.05. (This has been increased from the default value of 0.01 utilized in LimitState:RING 2.0 in the
light of additional experimental and numerical data.)

When φ is small, mpKp can fall significantly below 1.0 for a value of mp equal, for example, to the
default 0.33. It may be argued that a value less than 1.0 indicates that the soil is not positively
mobilizing any friction to resist arch movement and is over conservative. There is therefore an option
in LimitState:RING 4.0 to ensure that the resultant value of mpKp never falls below 1.0. This is on
by default. Specific situations where this may be invalid include:

• situations involving small arch movements where the at rest (starting) lateral earth pressure
coefficient K0 was initially very much less than 1.0. This might occur in the unlikely event of
poorly compacted backfill;

• situations involving low strength backfills where the active earth pressures are relatively high
compared to the passive earth pressures (mp corrects for several effects including active earth
pressures as listed above). This is unlikely to occur for single-span arches where an external
load is applied above the active side, such that the effect of the distributed load itself normally
dominates the active side soil pressures. It may, however, be relevant for a deforming arch that
is part of a multi-span arch bridge, but not subject to an external load.

(Burroughs et al. 2002) suggested using an alternative pressure coefficient for arches:

Ke = K0 + e(Kp −K0) (B.10)

where K0 is the at rest earth pressure coefficient, typically taken as 1 − sinφ (though if the fill
has been compacted then K0 can take on significantly higher values), and e is an empirical factor.
When φ is high, and if e is taken as equal to e.g. the default value of mp = 0.33, then the pressure
coefficient Ke

∼= mpKp (since K0 is very small compared with Kp). Therefore, there is very little
difference between this approach and that used by LimitState:RING 4.0.

For low values of φ, the main potential advantage of the approach proposed by (Burroughs et al.
2002) is that it limits the minimum value of Ke to K0. However, since mp is designed to correct for
a number of factors, not just the simple passive pressure coefficient, it was considered inappropriate
to use this as the default approach in LimitState:RING 4.0. However, since the user is free to select
mp, then this approach can be applied if desired by setting mp = Ke/Kp. Nonetheless, for the same
reasons discussed earlier with respect to the option ‘Keep mpKp>=1.0’, at the present time it is
recommended that Burroughs’ coefficient Ke is used with caution in LimitState:RING 4.0.
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B.4 Gradual build-up of passive pressures

Experimental evidence has shown that peak passive pressures are only mobilized when structural
deformations of sections of an arch into the surrounding fill material are relatively large. It can
therefore be argued that a gross displacement analysis (Gilbert 1997) is required to identify the peak
load, and that a normal LimitState:RING 4.0 analysis, which assumes infinitesimal deformations, is
inappropriate.

However, in reality, the fill in most short-span bridges will be very well compacted (due to trafficking),
hence relatively large pressures can be expected to be mobilized even when displacements are relatively
small. For example, Figure B.3 shows the mean horizontal pressures mobilized above the springings
or piers of three of the most well-instrumented bridges tested at Bolton in the 1990s (refer also to
Appendix G). These bridges were backfilled with a well-compacted graded crushed limestone fill
material.

Figure B.3: Mean horizontal backfill pressure vs. net closing barrel rotation of arch barrels

A special version of LimitState:RING was developed to enable gross displacement analyses to be
performed, with the experimentally observed build-up in pressures back-substituted into the analysis.
The trend shown in Figure B.4 was obtained:
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Figure B.4: Experimental and predicted load vs. displacement response of single-span bridges

Thus, Figure B.4 indicates that the standard mechanism solution, which does not take gross structural
movements into account, is in error by less than 15%. Had the build-up in backfill pressures been
more gradual, then the error would have been greater. Nevertheless, given the numerous other
uncertainties that exist when modelling masonry arch bridges, such errors may well be considered
acceptable.

B.5 Unusual failure mechanisms

Most bridges tested in the laboratory to date have failed in four hinge failure mechanisms and,
as indicated previously, taking mp = 1

3 (where the resultant coefficient of lateral earth pressure is
calculated as mpKp) permits generally good predictions of carrying capacity to be obtained. However,
it is currently unclear as to whether taking mp = 1

3 is applicable in all cases; LimitState:RING 4.0
chooses the critical failure mechanism from a multitude of possible ones and a four hinge failure
mechanism is by no means always identified as being critical.

For example, Figure 5.4(b) shows an alternative failure mode encountered when recently assessing
a short-span bridge. Here the predicted failure mode involves sliding failures at three joints, and
translation rather than rotation of a section of arch into the fill. However, the magnitudes of the
passive restraining pressures applied correspond to those mobilized in a four hinge mechanism. In
reality, the sliding failure mode predicted would be likely to more rapidly mobilize significant passive
zone soil pressures. Thus, the LimitState:RING 4.0 strength prediction (using mp =

1
3) may be quite

conservative.

In the future it is expected that this issue will be resolved by moving away from the current indirect
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modelling strategy for the soil, and towards modelling the soil explicitly (i.e. using solid elements to
represent the soil material).

B.6 Backfill - Backwards compatibility with RING 1.5

The import facility in LimitState:RING 4.0 will automatically convert RING 1.5 backfill settings to
the correct equivalent values so that identical pressure distributions are modelled in LimitState:RING
4.0. The LimitState:RING 4.0 model provides additional capabilities above those provided in RING
1.5. In order for users to manually replicate RING 1.5 settings in LimitState:RING 4.0 and also
understand how the import facility has represented RING 1.5 models, this section provides direct
guidance on how to replicate RING 1.5 settings.

The RING 1.5 Backfill properties tab is given in Figure B.5:

Figure B.5: RING 1.5 Backfill properties tab

B.6.1 Unit weight

In LimitState:RING 4.0, enter this value under ‘Unit weight’.

B.6.2 Limiting fill / barrel angle of friction

This requires an angle of friction φ to have been set in the LimitState:RING 4.0 dialog (see the section
on B.6.4 for guidance on setting this value). Let the required limiting backfill/arch barrel angle of
friction be δ. In LimitState:RING 4.0, click on Advanced and in the section Soil-arch interface
properties set the Friction, multiplier on φ value to δ/φ. Also set the Adhesion, multiplier on
c value to zero.
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B.6.3 Load dispersion type

In LimitState:RING 4.0, click on Advanced. The settings in the section ‘Live load dispersion details’
are directly equivalent to the RING 1.5 settings. Note that cut off angle (deg) in LimitState:RING
4.0 is directly equivalent to Limiting angle (rads) in RING 1.5, except that the units are now degrees
not radians.

B.6.4 Horizontal pressure type

None

To replicate this option in LimitState:RING 4.0, set φ and c to zero in the section Soil Properties.
(Note the LimitState:RING 4.0 import facility will also set the Factor mp and Factor mpc to zero,
and uncheck the box Keep mpKp >= 1.0 in the Advanced section Passive zone parameters.)

Uniform

To replicate this option in LimitState:RING 4.0, in the section Soil Properties, set φ equal to δ
(the selected value of the limiting fill / barrel angle of friction) and c to the specified RING 1.5
uniform pressure Magnitude. Click on Advanced and in the section Passive zone parameters set
the Factor mp to zero and Factor mpc to (1/(2 tan(45 + δ/2))). Finally, uncheck the box Keep
mpKp >= 1.0. The value given in the box mpcKpcc should be the required value of the uniform
pressure. To correctly set the required limiting backfill / arch barrel angle of friction, set the Friction,
multiplier on φ value to 1.0. Also set the Adhesion, multiplier on c value to zero.

Classical

To replicate this option in LimitState:RING 4.0, first click on Advanced and in the section Passive
zone parameters set the Factor mp to a preferred value. This may be chosen as any value
0 ≤ mp ≤ 1.0. (The LimitState:RING 4.0 import facility uses the default value of 0.33.) Then set
the Factor mpc to zero and uncheck the box Keep mpKp >= 1.0.

Let the specified RING 1.5 Earth Pressure Coefficient be E. Compute the equivalent soil angle of
friction φ using the following formula:

φ = 2

(
arctan

(√
E

mp

)
− 45o

)
(B.11)

In the section Soil Properties, set φ to the value calculated in equation B.11 and c to zero. The
value given in the box mpKp should be the required value of E. Ensure that the correct procedure
for replicating the RING 1.5 Limiting fill / barrel angle of friction value has been followed using
the value of φ computed here.
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B.6.5 Automatic identification of passive zones

This is implemented in the same way in LimitState:RING 4.0 as in earlier versions of the software,
including RING 1.5. Click ’Advanced’ in LimitState:RING 4.0. The corresponding check box and
table may be found in the section Passive zone parameters.
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Appendix C

Default parameters

C.1 General

The General default properties are given in Table C.1:

Parameter Default Notes

Bridge width 2500mm ‘Specified’ width selected by default.

Table C.1: General default properties

C.2 Geometry

The Geometry default properties are given in Table C.2:

Parameter Default Notes

Intrados shape Segmental Common in practice.

Number of units per ring 40

Number of rings 1
Most European bridges do not use
multi-ring construction.

Depth of surface fill / ballast 500mm Default surface profile assumed to be
level. Height of surface fill layer = y
distance between left-hand intrados
springing and base of surface fill
layer.

Height of surface fill layer 2100mm

Table C.2: Geometry default properties
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C.3 Transverse properties (used with auto-computed bridge width)

The transverse default properties, used with an Auto-computed bridge width, are given in Table
C.3:

Parameter Default Notes

Transverse sleeper length 2400mm Railway underline bridges only

Transverse axle spacing 1800mm Highway bridges only

Auto-computed extra width
a) 0mm
b) 1500mm

a) Railway bridges UIC 774-2R

b) Highway bridges UK Highways Agency

Standard BD21/01

Transverse angle of dispersion
of live loads (ballast / surface
fill)

a) 15◦

b) 26.6◦

a) Railway bridges - UIC 774-2R

b) Highway bridges - equivalent to 2:1, as

recommended in UK Highways Agency Stan-

dard BD21/01

Transverse angle of dispersion
of live loads (backfill)

a) 30◦

b) 26.6◦

a) Railway bridges

b) Highway bridges - equivalent to 2:1, as

recommended in UK Highways Agency Stan-

dard BD21/01

Table C.3: Transverse default properties (used with auto-computed bridge width)
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C.4 Material properties

The default material properties are given in Table C.4:
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Parameter Default Notes

Unit weight (masonry) 20kN/m3

Coefficient of friction (radial) 0.6 From BS5628(i)

Coefficient of friction (tangen-
tial)

0.5
Based on measured in Bolton laboratory

bridges (mean measured value was 0.53)

(Melbourne & Gilbert 1995)

Shear bond strength 0.0

Masonry crushing strength 5N/mm2

Unit weight (surface fill / bal-
last)

18kN/m3

Unit weight (backfill) 18kN/m3

Longitudinal angle of dispersion
of live loads (ballast / surface
fill)

a) 15◦

b) 26.6◦

a) Railway bridges - UIC 774-2R

b) Highway bridges - equivalent to 2:1, as

recommended in UK Highways Agency Stan-

dard BD21/01

Longitudinal angle of dispersion
of live loads (backfill)

a) 30◦

b) 30◦

a) Railway bridges
b) Highway bridges

(LimitState:RING 4.0 standard value, cali-

brated against load tests)

Angle of friction, φ 37.5◦

In LimitState:RING 3.x and earlier a very

conservative value of 30◦ was assumed; in

LimitState:RING 4.0 a more realistic value

has been adopted, likely to be more represen-

tative of the compacted fill found in practice.

Cohesion, c 0kN/m2

Model dispersion of live load true

Model horizontal ‘passive’ pres-
sures

true

Soil-arch interface, friction
multiplier on φ

0.66

Soil-arch interface, adhesion
multiplier on c

0.5

Fill dispersion model (ballast /
surface fill)

Normal

Fill dispersion model (backfill) Boussinesq With 30◦ cutoff

ULS active zone factor ma 0.0

ULS passive zone factor mp 0.33

ULS passive zone factor mpc 0.05

Keep mpKp > 1.0 true

PLS active zone factor maKa 1.0

PLS passive zone factor mpKp 1.0

Auto apply horizontal pressures true

Table C.4: Default material properties
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C.5 Partial factors

The default partial factors are given in Table C.5:

Partial Factor Symbol ULS PLS Notes
Vehicle Loads (multipliers on vehicle loading)
Axle load γf,l 1.5 1 Applied to variable load from vehi-

cle axles

Dynamic / impact γf,dyn 1 1 Applied to axles where a ‘Dynamic
/ impact’ (see Section 18.3.5) fac-
tor has been set

Load effects γf,3 1 1 Takes account of uncertainties in
modelling the effects of loads
(equivalent to a model factor), ap-
plied via the vehicle loading

Material Loads (multipliers on material unit weights)
Surface fill / ballast unit weight γf,sf 1 1 Load factor - applied to permanent

load from surface fill / ballast

Masonry unit weight γf,m 1 1 Load factor - applied to permanent
load from masonry

Fill unit weight γf,f 1 1 Load factor - applied to permanent
load from backfill and backing

Track load γf,t 1 1 Applied to permanent load from
track

Material Strengths (divisors on material strength)
Masonry compressive strength γm,ms 1 2 Material factor - applied to ma-

sonry crushing strength

Masonry shear bond strength γm,ma 1 2 Material factor - applied to ma-
sonry shear bond strength (adhe-
sion)

Masonry friction γm,mf 1 1 Material factor - applied to ma-
sonry friction coefficients

Table C.5: Default Partial Factors

C.6 Track parameters

The default track parameters are given in Table C.6:
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Parameter Default Notes

Sleeper spacing 500mm
Conservative value, less than standard
600mm

Sleeper breadth 250mm Standard (see Network Rail 2006)

Sleeper length (transverse) 2400mm Standard sleeper length

Track weight (incl. sleepers,
rails and ballast between sleep-
ers)

2.0kN/m2

Table C.6: Default track parameters
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Standard loading models

D.1 Highway loading models

D.1.1 Default single axle vehicle

When used with partial factors of unity, the adequacy factor reported by LimitState:RING 4.0 is
equal to the load multiplier required to cause collapse (ULS) or permanent, long-term degradation
(PLS) when a 100kN, single axle, vehicle is present. Thus, an adequacy factor of 4.0 indicates that
a load of 400kN is required to cause the ULS or PLS to be reached, depending on which mode is
being used.

Type Name
Single Axle Default 100kN Single Axle

Table D.1: Default single axle vehicle

D.1.2 CS454 - Chapter 7 vehicles

Vehicles appearing in CS454 Revision 1, Chapter 7 (Page 50, Tables 7.3.1(a) and (b)):
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Type Name
Single Axles [18t+ GVW] 11.5t Single Axle (CS454)

Single Axles [FE GP1] 10t Single Axle (CS454)

Single Axles [13t GVW] 9t Single Axle (CS454)

Single Axles [10t GVW] 7t Single Axle (CS454)

Single Axles [7.5t GVW] 5.5t Single Axle (CS454)

Single Axles [FE GP2] 5t Single Axle (CS454)

Single Axles [3t GVW] 2t Single Axle (CS454)

Double Axle Bogies [Normal GVW] 2x 10t, 1.8m Axle Spacing (CS454)

Double Axle Bogies [26t+] 2x 9.5t, 1.3m Axle Spacing (CS454)

Double Axle Bogies [Normal GVW] 2x 8t, 1.0m Axle Spacing (CS454)

Double Axle Bogies [Normal GVW] 2x 10t, 1.8m Axle Spacing, Lift-Off (CS454)

Double Axle Bogies [26t+] 2x 9.5t, 1.3m Axle Spacing, Lift-Off (CS454)

Double Axle Bogies [Normal GVW] 2x 8t, 1.0m Axle Spacing, Lift-Off (CS454)

Triple Axle Bogies [Normal GVW] 3x 8t, 1.3m Axle Spacing (CS454)

Triple Axle Bogies [Normal GVW] 3x 7t, 1.0m Axle Spacing (CS454)

Triple Axle Bogies [Normal GVW] 3x 8t, 1.3m Axle Spacing, Lift-Off (CS454)

Triple Axle Bogies [Normal GVW] 3x 7t, 1.0m Axle Spacing, Lift-Off (CS454)

Table D.2: CS454 Chapter 7 load vehicles

D.1.3 CS454 - Appendix B - Load vehicles

Vehicles appearing in CS454 Revision 1, Appendix B (Page 67/68, Table B1):
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Type Name
Normal Traffic [A] 32t, 4 Axle, Rigid (CS454)

Normal Traffic [B] 38t, 2+2 Artic (CS454)

Normal Traffic [C] 40t, 2+3 Artic (CS454)

Normal Traffic [D] 40t, 3+2 Artic (CS454)

Normal Traffic [D*] 40t, 3+2, Artic (CS454)

Normal Traffic [E] 40t, 3+2 Artic, 10.5t Drive (CS454)

Normal Traffic [E*] 40t, 3+2 Artic, 10.5t Drive (CS454)

Normal Traffic [F] 41t, 3+3 Artic, 10.5t Max. (CS454)

Normal Traffic [F*] 41t, 3+3 Artic, 10.5t Max. (CS454)

Normal Traffic [G] 44t, 3+3 Artic, 10.5t Max. (CS454)

Normal Traffic [G*] 44t, 3+3 Artic, 10.5t Max. (CS454)

Normal Traffic [H] 44t, 3+2 Artic, 40ft ISO (CS454)

Normal Traffic [H*] 44t, 3+2 Artic, 40ft ISO (CS454)

26 tonnes [I] 26t, 3 Axle, Short Wheelbase, Min. Spacing (CS454)

26 tonnes [J] 26t, 3 Axle, Max. Equal Weight (CS454)

26 tonnes [K] 26t, 3 Axle, Max. Axle Weight (CS454)

26 tonnes [K*] 26t, 3 Axle, Max. Axle Weight (CS454)

26 tonnes [L] 26t, 3 Axle, Artic, King-Pin 0.2m (CS454)

26 tonnes [L*] 26t, 3 Axle, Artic, King-Pin 0.2m (CS454)

18 tonnes [M] 18t Vehicle (CS454)

7.5 tonnes [N] 7.5t Vehicle (CS454)

3 tonnes [O] 3t Vehicle (CS454)

Table D.3: CS454 Appendix B - Load vehicles

* Vehicle contains reversed axles

D.1.4 CS454 - Appendix B - Fire engines

Vehicles appearing in CS454 Revision 1, Appendix B (Page 69, Table B2):

Type Name
Group 1 [Group 1] Up to 17t, 2 Axle, Min. Spacing (CS454)

Group 1 [Group 1] Up to 17t, 2 Axle, Max. Spacing (CS454)

Group 2 [Group 2] Up to 8.5t, 2 Axle, Min. Spacing (CS454)

Table D.4: CS454 Appendix B - Fire engines

D.1.5 CS454 - Appendix C - HB vehicles

HB vehicle models appearing in CS454 Revision 1, Appendix C (Page 70, Figure C1):
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Type Name
HB 1 Unit, 6m Inner Spacing (CS454)

HB 1 Unit, 11m Inner Spacing (CS454)

HB 1 Unit, 16m Inner Spacing (CS454)

HB 1 Unit, 21m Inner Spacing (CS454)

HB 1 Unit, 26m Inner Spacing (CS454)

Table D.5: CS454 - Appendix C - HB vehicles

D.1.6 CS458 - Special Vehicles (SV)

Vehicles appearing in CS458 Revision 0 (Pages 12-17, Figures 3.8-3.16):

Type Name
SV-80 SV-80, 1.2m Inner Spacing (CS458)

SV-80 SV-80, 5.0m Inner Spacing (CS458)

SV-80 SV-80, 9.0m Inner Spacing (CS458)

SV-100 SV-100, 1.2m Inner Spacing (CS458)

SV-100 SV-100, 5.0m Inner Spacing (CS458)

SV-100 SV-100, 9.0m Inner Spacing (CS458)

SV-150 SV-150, 1.2m Inner Spacing (CS458)

SV-150 SV-150, 5.0m Inner Spacing (CS458)

SV-150 SV-150, 9.0m Inner Spacing (CS458)

SV-196 SV-196, 1.2m Inner Spacing (CS458)

SV-196 SV-196, 5.0m Inner Spacing (CS458)

SV-196 SV-196, 9.0m Inner Spacing (CS458)

SV-TT SV-TT (CS458)

Table D.6: CS458 - Special Vehicles (SV)

Note:

1. CS458 SV-196 differs from BD91/04 SV-196.

2. Direction of travel of CS458 Special Vehicle varies between models. LimitState:RING 4.0
assumes ‘left to right’ movement by default and this is reflected in the table.

D.1.7 BD21/97 - Appendix A - ‘Construction and Use’ vehicles

Construction and Use load vehicle models appearing in BD21/97 Appendix A (Page A/1, Sections
c and d):
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Type Name
Single Axle 10.5t, Single Axle (BD21/97)

Bogies 16.26t, 2 Axle Bogie, 1.02m O/A Spread (BD21/97)

Bogies 20.34t, 2 Axle Bogie, 1.85m O/A Spread (BD21/97)

Bogies 18.00t, 3 Axle Bogie, 1.40m O/A Spread (BD21/97)

Bogies 22.50t, 3 Axle Bogie, 2.70m O/A Spread (BD21/97)

Bogies 24.00t, 3 Axle Bogie, Air or Fluid, 2.60m O/A Spread (BD21/97)

Table D.7: BD21/97 - Appendix A - Construction and Use vehicles

D.1.8 BD21/97 - Appendix A - European Union (EC) vehicles

European Union (EC) load vehicles appearing in BD21/97 Appendix A (Page A/2, Sections C and D):

Type Name
Driving Single Axle 11.5t, Single Axle (BD21/97)

Bogies 16t, 2 Axle Bogie, 1.00m O/A Spread (BD21/97)

Bogies 18t, 2 Axle Bogie, 1.30m O/A Spread (BD21/97)

Bogies 19t, 2 Axle Bogie, Road Friendly, 1.30m O/A Spread (BD21/97)

Bogies 20t, 2 Axle Bogie, 1.80m O/A Spread (BD21/97)

Bogies 21t, 3 Axle Bogie, 2.60m O/A Spread (BD21/97)

Bogies 24t, 3 Axle Bogie, 2.80m O/A Spread (BD21/97)

Table D.8: BD21/97 - Appendix A - European Union (EC) vehicles

D.1.9 BD21/97 - Appendix D - Critical ‘Construction and Use’ vehicles

Vehicles appearing in BD21/97, Appendix D (Page D/2, Table D1):

Type Name
B1 [B1] 30.48t, 4 Axle, Rigid (BD21/97)

C1 [C1] 30.48t, 4 Axle, Rigid (BD21/97)

D1 [D1] 32.52t, 4 Axle, Articulated (BD21/97)

E1 [E1] 32.52t, 5 Axle, Articulated (BD21/97)

F1 [F1] 38.00t, 5 Axle, Articulated (BD21/97)

G1 [G1] 38.00t, 5 Axle, Articulated (BD21/97)

G1 [G1*] 38.00t, 5 Axle, Articulated (BD21/97)

H1 [H1] 38.00t, 5 Axle, Articulated (BD21/97)

H1 [H1*] 38.00t, 5 Axle, Articulated (BD21/97)

J1 [J1] 38.00t, 5 Axle, Articulated (BD21/97)

Table D.9: BD21/97 - Appendix D - Critical Construction and Use vehicles

* Vehicle contains reversed axles
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D.1.10 BD21/97 - Appendix D - Critical European Union (EC) vehicles

Vehicles appearing in BD21/97, Appendix D (Page D/2, Table D2):

Type Name
EC1 [EC1] 26t, 3 Axle, Rigid (BD21/97)

EC1 [EC1*] 26t, 3 Axle, Rigid (BD21/97)

EC2 [EC2] 32t, 4 Axle, Rigid (BD21/97)

EC2 [EC2*] 32t, 4 Axle, Rigid (BD21/97)

EC3 [EC3] 40t, 5 Axle, Rigid (BD21/97)

EC3 [EC3*] 40t, 5 Axle, Rigid (BD21/97)

EC4 [EC4] 44t, 6 Axle, Rigid (BD21/97)

EC4 [EC4*] 44t, 6 Axle, Rigid (BD21/97)

Table D.10: BD21/97 - Appendix D - Critical European Union vehicles

* Vehicle contains reversed axles

D.1.11 BD21/97 - Appendix D - Restricted ‘Construction and Use’ vehicles

Restricted Construction and Use load vehicles appearing in BD21/97 Appendix D (Page D/3, Table
D3):

Type Name
RA [RA] 20.32t, 3 Axle, Rigid (BD21/97)

RB [RB] 24.38t, 3 Axle, Rigid (BD21/97)

RC [RC] 24.39t, 3 Axle, Rigid (BD21/97)

RC [RC*] 24.39t, 3 Axle, Rigid (BD21/97)

RD [RD] 24.39t, 3 Axle, Rigid (BD21/97)

RD [RD*] 24.39t, 3 Axle, Rigid (BD21/97)

RE [RE] 17.00t, 2 Axle, Rigid (BD21/97)

RF [RF] 7.50t, 2 Axle, Rigid (BD21/97)

RG [RG] 3.00t, 2 Axle, Rigid (BD21/97)

Table D.11: BD21/97 - Appendix D - Restricted Construction and Use vehicles

* Vehicle contains reversed axles

D.1.12 BD21/97 - Appendix E - Fire engines

Vehicles appearing in BD21/97, Appendix E (Page E/1, Table E1):
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Type Name
Group 1 [Group 1] Dennis DF (BD21/97)

Group 1 [Group 1] Leyland MS 1600, 3.68m Axle Spacing (BD21/97)

Group 1 [Group 1] Leyland MS 1600, 4.62m Axle Spacing (BD21/97)

Group 1 [Group 1] Leyland MS 1600, 5.26m Axle Spacing (BD21/97)

Group 1 [Group 1] Dodge, 5.8m Axle Spacing (BD21/97)

Group 1 [Group 1] Dodge, 5.2m Axle Spacing (BD21/97)

Group 1 [Group 1] Dodge, 4.5m Axle Spacing (BD21/97)

Group 1 [Group 1] Dodge, 4.04m Axle Spacing (BD21/97)

Group 1 [Group 1] Dodge, 3.8m Axle Spacing (BD21/97)

Group 1 [Group 1] Ford, 3.73m Axle Spacing (BD21/97)

Group 1 [Group 1] Ford, 4.04m Axle Spacing (BD21/97)

Group 1 [Group 1] Bedford SLR1 (BD21/97)

Group 1 [Group 1] Bedford SLRA (BD21/97)

Group 1 [Group 1] Dodge, 3.5m Axle Spacing (BD21/97)

Group 1 [Group 1] Dennis RS and SS (BD21/97)

Group 2 [Group 2] Dodge, 3.5m Axle Spacing (BD21/97)

Group 2 [Group 2] Dodge, 3.6m Axle Spacing (BD21/97)

Table D.12: BD21/97 - Appendix E - Fire engines

Note: it is apparent that, for some vehicles, the summation of front and rear axle loads does not equal
the stated gross weight. Values in the LimitState:RING 4.0 Vehicle Database have been calculated
directly from the values as given in the code and are therefore compliant with this document. It
should also be noted that, in each case, the summation is always greater than the gross value and
thus leads to the calculation of a conservative solution.

D.1.13 BD21/97 - Appendix F - Restricted ‘Assessment Live Loadings’

Restricted Assessment Live Loading vehicles appearing in BD21/97 Appendix F (Page F/1, Table
F1):

Type Name
17t+ GVW 10.5t, Single Axle (BD21/97)

12.5t GVW 9t, Single Axle (BD21/97)

10t GVW 7t, Single Axle (BD21/97)

7.5t GVW 5.5t, Single Axle (BD21/97)

3t GVW 2t, Single Axle (BD21/97)

24.5t+ GVW 2x 9t, Double Axle, 1.3m Spread (BD21/97)

32.5t GVW 2x 9.5t, Double Axle, 1.3m Spread (BD21/97)

Fire Engines Group 1 FE Group 1: 10t, Single Axle (BD21/97)

Fire Engines Group 2 FE Group 2: 5t, Single Axle (BD21/97)

Table D.13: BD21/97 Appendix F - Restricted Assessment Live Loadings
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D.1.14 BD21/01 - Annex A - Authorised Weight (AW) vehicles

Authorised Weight Regulations vehicle load models appearing in BD21/01 Annex A (Page A/1, Sec-
tion A1, Sections C and D):

Type Name
Single Axle 11.5t, Single Axle, Driving (BD21/01)

Single Axle 10.0t, Single Axle, Non-Driving (BD21/01)

Double Axle Bogie 2x 8t, Driving, 1.0m Spread (BD21/01)

Double Axle Bogie 2x 9t, Driving, 1.3m Spread (BD21/01)

Double Axle Bogie 2x 9.5t, Driving, 1.3m Spread (BD21/01)

Double Axle Bogie 2 Axle, 11.5t Driving, 1.3m Spread (BD21/01)

Double Axle Bogie 2 Axle, 10.5t Driving, 1.3m Spread (BD21/01)

Double Axle Bogie 2x 5.5t, Non-Driving, 1.0m Spread (BD21/01)

Double Axle Bogie 2x 8t, Non-Driving, 1.0m Spread (BD21/01)

Double Axle Bogie 2x 9t, Non-Driving, 1.3m Spread (BD21/01)

Double Axle Bogie 2x 10t Non-Driving, 1.8m Spread (BD21/01)

Triple Axle Bogie 3x 7t, Non-Driving, 1.3m Spread (BD21/01)

Triple Axle Bogie 3x 8t, Non-Driving, >1.3m Spread (BD21/01)

Table D.14: BD21/01 - Annex A - Authorised Weight vehicles

D.1.15 BD21/01 - Annex D - Critical Road vehicles (AWR)

Authorised Weight Regulations vehicles appearing in BD21/01 Annex D (Page D/2 - Table D1):

Type Name
32t GVW 32t, 4 Axle, Rigid (BD21/01)

38t GVW 38t, 4 Axle, 2+2 Artic (BD21/01)

40t GVW 40t, 5 Axle, 2+3 Artic (BD21/01)

40t GVW 40t, 5 Axle, 3+2 Artic (BD21/01)

40t GVW 40t*, 5 Axle, 3+2 Artic (BD21/01)

40t GVW 40t, 5 Axle, 3+2 Artic, 10.5t Drive (BD21/01)

40t GVW 40t*, 5 Axle, 3+2 Artic, 10.5t Drive (BD21/01)

41t GVW 41t, 6 Axle, 3+3 Artic (BD21/01)

41t GVW 41t*, 6 Axle, 3+3 Artic (BD21/01)

44t GVW 44t, 6 Axle, 3+3 Artic (BD21/01)

44t GVW 44t*, 6 Axle, 3+3 Artic (BD21/01)

44t GVW 44t, 5 Axle, 3+2 Artic, 40ft ISO (BD21/01)

44t GVW 44t*, 5 Axle, 3+2 Artic, 40ft ISO (BD21/01)

Table D.15: BD21/01 - Annex D - Critical Road vehicles (AWR)

* Contains reversed axles
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D.1.16 BD21/01 - Annex E - Fire engines

Vehicles appearing in BD21/01, Annex E (Page E/1, Table E1):

Type Name
Group 1 [Group 1] Dennis DF (BD21/01)

Group 1 [Group 1] Leyland MS 1600, 3.68m Axle Spacing (BD21/01)

Group 1 [Group 1] Leyland MS 1600, 4.62m Axle Spacing (BD21/01)

Group 1 [Group 1] Leyland MS 1600, 5.26m Axle Spacing (BD21/01)

Group 1 [Group 1] Leyland MS 1600, 5.26m Axle Spacing (BD21/01)

Group 1 [Group 1] Dodge, 5.8m Axle Spacing (BD21/01)

Group 1 [Group 1] Dodge, 5.2m Axle Spacing (BD21/01)

Group 1 [Group 1] Dodge, 4.5m Axle Spacing (BD21/01)

Group 1 [Group 1] Dodge, 4.04m Axle Spacing (BD21/01)

Group 1 [Group 1] Dodge, 3.8m Axle Spacing (BD21/01)

Group 1 [Group 1] Ford, 3.73m Axle Spacing (BD21/01)

Group 1 [Group 1] Ford, 4.04m Axle Spacing (BD21/01)

Group 1 [Group 1] Bedford SLR1 (BD21/01)

Group 1 [Group 1] Bedford SLRA (BD21/01)

Group 1 [Group 1] Dodge, 3.5m Axle Spacing (BD21/01)

Group 1 [Group 1] Dennis RS and SS (BD21/01)

Group 1 [Group 1] Dennis Rapier (BD21/01)

Group 1 [Group 1] Dennis Sabre, 3.8m Axle Spacing (BD21/01)

Group 1 [Group 1] Dennis Sabre, 4.2m Axle Spacing (BD21/01)

Group 1 [Group 1] Mercedes Benz ATEGO (BD21/01)

Group 1 [Group 1] DAF FF55.230 (BD21/01)

Group 2 [Group 2] Dodge, 3.5m Axle Spacing (BD21/01)

Group 2 [Group 2] Dodge, 3.6m Axle Spacing (BD21/01)

Table D.16: BD21/01 - Annex E - Fire engines

Note: it is apparent that, for some vehicles, the summation of front and rear axle loads does not equal
the stated gross weight. Values in the LimitState:RING 4.0 Vehicle Database have been calculated
directly from the values as given in the code and are therefore compliant with this document. It
should also be noted that, in each case, the summation is always greater than the gross value and
thus leads to the calculation of a conservative solution.

D.1.17 BD21/01 - Annex F - Restricted ‘Assessment Live Loadings’

Restricted Assessment Live Loading vehicles appearing in BD21/01 Annex F (Page F/1, Table F1):
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Type Name
18t+ GVW 11.5t, Single Axle (BD21/01)

12.5t GVW 9t, Single Axle (BD21/01)

10t GVW 7t, Single Axle (BD21/01)

7.5t GVW 5.5t, Single Axle (BD21/01)

3t GVW 2t, Single Axle (BD21/01)

26t+ GVW 2x 9.5t, Double Axle, 1.3m Spread (BD21/01)

Fire Engine Group 1 FE Group 1: 10t, Single Axle (BD21/01)

Fire Engine Group 2 FE Group 2: 5t, Single Axle (BD21/01)

Table D.17: BD21/01 - Annex F - Restricted Assessment Live Loadings

Note: spacing for 2x 9.5t Double Axle vehicle taken from Appendix A/1 Section d.

D.1.18 BD37/01 - Appendix A - HB vehicles

HB vehicle models appearing in BD37/01 - Appendix A - COMPOSITE VERSION OF BS 5400:
PART 2. Load model outlined on page A60, Figure 12, variations outlined on page A59 (cl6.3) and
page 4/1 (cl4.1):

Type Name
1 Unit HB 1 Unit, 6m Inner Spacing (BD37/01)

1 Unit HB 1 Unit, 11m Inner Spacing (BD37/01)

1 Unit HB 1 Unit, 16m Inner Spacing (BD37/01)

1 Unit HB 1 Unit, 21m Inner Spacing (BD37/01)

1 Unit HB 1 Unit, 26m Inner Spacing (BD37/01)

30 Units HB 30 Units, 6m Inner Spacing (BD37/01)

30 Units HB 30 Units, 11m Inner Spacing (BD37/01)

30 Units HB 30 Units, 16m Inner Spacing (BD37/01)

30 Units HB 30 Units, 21m Inner Spacing (BD37/01)

30 Units HB 30 Units, 26m Inner Spacing (BD37/01)

37.5 Units HB 37.5 Units, 6m Inner Spacing (BD37/01)

37.5 Units HB 37.5 Units, 11m Inner Spacing (BD37/01)

37.5 Units HB 37.5 Units, 16m Inner Spacing (BD37/01)

37.5 Units HB 37.5 Units, 21m Inner Spacing (BD37/01)

37.5 Units HB 37.5 Units, 26m Inner Spacing (BD37/01)

45 Units HB 45 Units, 6m Inner Spacing (BD37/01)

45 Units HB 45 Units, 11m Inner Spacing (BD37/01)

45 Units HB 45 Units, 16m Inner Spacing (BD37/01)

45 Units HB 45 Units, 21m Inner Spacing (BD37/01)

45 Units HB 45 Units, 26m Inner Spacing (BD37/01)

Table D.18: BD37/01 - Appendix A - HB vehicles
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D.1.19 BD86/11 - Special Vehicles (SV)

Vehicles appearing in BD86/11 (Pages 3/2 to 3/5, Figures 3.1 - 3.4):

Type Name
SV80 SV80, 1.2m Bogie Spacing (BD86/11)

SV80 SV80, 5.0m Bogie Spacing) (BD86/11)

SV80 SV80, 9.0m Bogie Spacing) (BD86/11)

SV100 SV100, 1.2m Bogie Spacing) (BD86/11)

SV100 SV100, 5.0m Bogie Spacing) (BD86/11)

SV100 SV100, 9.0m Bogie Spacing) (BD86/11)

SV150 SV150, 1.2m Bogie Spacing) (BD86/11)

SV150 SV150, 5.0m Bogie Spacing) (BD86/11)

SV150 SV150, 9.0m Bogie Spacing) (BD86/11)

SV Train SV-Train, 1.2m Bogie Spacing (BD86/11)

SV Train SV-Train, 5.0m Bogie Spacing (BD86/11)

SV Train SV-Train, 9.0m Bogie Spacing (BD86/11)

SV-TT SV-TT Load Model (BD86/11)

Table D.19: BD86/11 - Special Vehicles (SV)

Note:

1. BD91/04 ‘SV-196’ and BD86/11 ‘SV-Train’ differ from CS458 ‘SV-196’ in that the latter has
a 4-axle leading trailer.

2. BD91/04 ‘SV-TT’ and BD86/11 ‘SV-Train’ differ from CS458 ‘SV-196’ in that the latter has
a 4-axle leading trailer.

3. Direction of travel of BD86/11 Special Vehicles varies between models. LimitState:RING 4.0
assumes ‘left to right’ movement by default and this is reflected in the table.

D.1.20 BD91/04 - Authorised Weight (AW) vehicles

Authorised Weight vehicles appearing in BD91/04 (Page 3/4, Table 3.2):
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Type Name
32t GVW 32t, 4 Axle, Rigid (BD91/04)

38t GVW 38t, 4 Axle, 2+2 Artic (BD91/04)

40t GVW 40t, 5 Axle, 2+3 Artic (BD91/04)

40t GVW 40t, 5 Axle, 3+2 Artic (BD91/04)

40t GVW 40t*, 5 Axle, 3+2 Artic (BD91/04)

40t GVW 40t, 5 Axle, 3+2 Artic, 10.5T Drive (BD91/04)

40t GVW 40t*, 5 Axle, 3+2 Artic, 10.5T Drive (BD91/04)

41t GVW 41t, 6 Axle, 3+3 Artic (BD91/04)

41t GVW 41t*, 6 Axle, 3+3 Artic (BD91/04)

44t GVW 44t, 6 Axle, Artic (BD91/04)

44t GVW 44t*, 6 Axle, Artic (BD91/04)

44t GVW 44t, 5 Axle, 3+2 Artic, 40ft ISO (BD91/04)

44t GVW 44t*, 5 Axle, 3+2 Artic, 40ft ISO (BD91/04)

Table D.20: BD91/04 - Authorised Weight (AW) vehicles

* Contains reversed axles

D.1.21 BD91/04 - Special Vehicles (SV)

Vehicles appearing in BD91/04 (Pages 3/5 and 3/6, Figures 3.1-3.4):

Type Name
SV80 SV80, 1.2m Bogie Spacing (BD91/04)

SV80 SV80, 5.0m Bogie Spacing) (BD91/04)

SV80 SV80, 9.0m Bogie Spacing (BD91/04)

SV100 SV100, 1.2m Bogie Spacing (BD91/04)

SV100 SV100, 5.0m Bogie Spacing (BD91/04)

SV100 SV100, 9.0m Bogie Spacing (BD91/04)

SV196 SV196, 1.2m Inner Axle Spacing (BD91/04)

SV196 SV196, 5.0m Inner Axle Spacing (BD91/04)

SV196 SV196, 9.0m Inner Axle Spacing (BD91/04)

SV-TT SV-TT Load Model (BD91/04)

Table D.21: BD91/04 - Special Vehicles

Note:

1. BD91/04 SV-196 differs from CS454 SV-196.

2. Direction of travel of BD91/04 Special Vehicles varies between models. LimitState:RING 4.0
assumes ‘left to right’ movement by default and this is reflected in the table.

3. BD91/04 SV-196 model does not specify a spacing between tractor and bogies. 4.0m is
assumed, based on the spacing used in other standards.
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D.2 Railway loading models

D.2.1 UIC702 - Load Model 71 (LM71)

Load Model 71, as described in UIC776-1R and UIC702:

Type Name
LM71 LM71, No UDL

Table D.22: UIC702 - LM71 Load Model

Note: distributed load components are not included in LimitState:RING 4.0 vehicles.

D.2.2 UIC700 - Appendix 1

Vehicles appearing in UIC700 Appendix 1, ‘Load Models (Design-Wagons) Representing the Line
Categories’ (Page 12):

Type Name
A [A] 16t Axles, 5.0t/m (UIC700)

B1 [B1] 18t Axles, 5.0t/m (UIC700)

B2 [B2] 18t Axles, 6.4t/m (UIC700)

C2 [C2] 20t Axles, 6.4t/m (UIC700)

C3 [C3] 20t Axles, 7.2t/m (UIC700)

C4 [C4] 20t Axles, 8.0t/m (UIC700)

D2 [D2] 22.5t Axles, 6.4t/m (UIC700)

D3 [D3] 22.5t Axles, 7.2t/m (UIC700)

D4 [D4] 22.5t Axles, 8.0t/m (UIC700)

E4 [E4] 25t Axles, 8.0t/m (UIC700)

E5 [E5] 25t Axles, 8.8t/m (UIC700)

Table D.23: UIC700 - Appendix 1 load models

D.2.3 UIC700 - Appendix 5

Vehicles appearing in UIC700 Appendix 5, ‘Load Limits for Two-Axle Vehicles’ (Page 16):
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Type Name
25t 25t Axles, 7.2m Spacing (UIC700)

22.5t 22.5t Axles, 7.2m Spacing (UIC700)

20t 20t Axles, 7.2m Spacing (UIC700)

18t 18t Axles, 7.2m Spacing (UIC700)

16t 16t Axles, 7.2m Spacing (UIC700)

20t 20t Axles, 6.4m Spacing (UIC700)

18t 18t Axles, 6.4m Spacing (UIC700)

16t 16t Axles, 6.4m Spacing (UIC700)

Table D.24: UIC700 - Appendix 5 load models

D.2.4 BD37/01

Vehicles appearing in BD37/01 Appendix A (Figure 15(a) and Clause 8.2.2):

Type Name
RU RU Loading, No UDL (BD37/01)

RL RL Loading, 200kN Axle, No UDL (BD37/01)

RL RL Loading, 300kN and 150kN Axles, No UDL (BD37/01)

Table D.25: BD37/01 - Railway load models

D.2.5 Network Rail (NR/GN/CIV/025)

Vehicles appearing or referenced in Network Rail NR/GN/CIV/025 (Pages 6/36 and 8/36. See also
CEC025):

Type Name
RA1 [RA1] 1 BSU, No UDL (NR)

RA1 [RA1] 1 BSU, Short Lengths, No UDL (NR)

RA10 [RA10] RA1, 20 BSU, No UDL (NR)

RA10 [RA10] RA1, 20 BSU, Short Lengths, No UDL (NR)

ALW Assessment Load Wagon (NR)

Table D.26: Network Rail (CIV025 / CEC025) - Railway load models

Note:

1. 1 BSU loading vehicles assume a total load of 1 ‘long ton’.

2. LimitState:RING 4.0 does not include UDL loading in load models.
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D.2.6 Indian Railways - Bridge Rules - Appendix XIX

Vehicles appearing or referenced in Indian Railways - Bridge Rules - Appendix XIX (Modified Broad
Gauge):

Type Name
MBG 1987 MBG 1987, 19.5m Locos, No UDL (IR)

MBG 1987 MBG 1987, 16m Locos, No UDL (IR)

Table D.27: Indian Railways - Appendix XIX load models

Note: distributed load components are not included in LimitState:RING 4.0 vehicles.

D.2.7 Indian Railways - Bridge Rules - Appendix XXVI

Vehicles appearing or referenced in Indian Railways - Bridge Rules - Appendix XXVI (DFC Loading):

Type Name
DFC 1 DFC Combination 1, 32.5t Axle Load, Diesel (IR)

DFC 2 DFC Combination 2, 32.5t Axle Load, Electric (IR)

DFC 3 DFC Combination 3, 32.5t Axle Load, Electric (Bo-Bo) (IR)

DFC 4 DFC Combination 4, 25t Loco (IR)

DFC 5 DFC Combination 5, 22.5t Loco (IR)

Table D.28: Indian Railways - Appendix XXVI load models

Note: distributed load components are not included in LimitState:RING 4.0 vehicles.
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Appendix E

Worked examples - General

E.1 Example 1 - Single-span stone voussoir underline railway bridge

E.1.1 Details

Bridge name: Case study example 11

Description: An initial LimitState:RING 4.0 assessment of a single-span stone voussoir underline
railway arch bridge is described. The bridge spans squarely between abutments and currently carries
a single straight track. The bridge is in a ‘fair’ condition, with:

• mortar loss of approx. 20mm on average in the vicinity of the arch springings;

• two longitudinal cracks in the arch barrel underneath the edges of the track, approx. 3.1m
apart.

Load Model LM71 is used in this assessment.

1This is a fictitious bridge, with details taken from several real bridges.
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Photograph:

Figure E.1: Photograph of Example 1 bridge

Commentary:

When undertaking an initial assessment of a bridge there will often be question-marks over certain
dimensions, internal constructional details and material properties. A prudent strategy is to use ‘best
guess’ values for the relevant parameters initially, but to subsequently undertake parametric studies
to determine the sensitivity of the analysis to the assumptions made. This ensures that a subsequent
detailed dimensional survey and / or intrusive investigation can focus in on the features of the bridge
that have been identified to be most important.

Other issues specifically relevant to this bridge:

• The influence of the mortar loss should be considered separately to see whether re-pointing is
an immediate priority.

• The presence of longitudinal cracks in the arch barrel will be likely to limit the effective bridge
width (to 3.1m).

The first step in the assessment is to assemble the data necessary in order to undertake an analysis:
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E.1.2 Assessment data

Parameter Value Notes

Span 5480mm

Rise 2105mm Measured values (arch thickness con-
firmed by drillings at the crown and
springings)

Thickness 340mm

Depth of fill & ballast below the
underside of the sleepers above the
crown

1155mm

Effective width of bridge 3100mm Governed by the presence of longitu-
dinal cracks in arch barrel

Intrados shape Segmental First approximation in the absence of
a comprehensive dimensional survey

Number of units per ring 23 Actual number of voussoirs

Number of rings 1 Single ring of voussoirs

Table E.1: Bridge geometry

Parameter Value Notes

Depth of ballast below sleeper 300mm Estimated value

Sleeper breadth 250mm Typical value (timber sleeper)

Sleeper length 2400mm Typical value (timber sleeper)

Table E.2: Track geometry

Parameter Value Notes

Unit weight (masonry) 26kN/m3 Estimated value (limestone)

Coefficient of friction (radial) 0.6 Estimated value

Crushing strength 20N/mm2 Estimated value (limestone blocks
with thin joints < 8mm)

Unit weight (backfill) 18kN/m3 Estimated value

Angle of friction (backfill) 300 Default value

Cohesion (backfill) 0kN/m2 Default value

Unit weight (ballast) 18kN/m3 Estimated value

Track weight (incl. sleepers, rails and
ballast between sleepers)

2.40kN/m2
Assuming 7.45kN/m length, taken
from NR/GN/CIV/025 (assuming BH
rail and timber sleepers)

Table E.3: Material properties (characteristic values)
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Parameter Value Notes

Load model name
LM71 (no
udl)

Distributed part of this load model
can be ignored for this short-span
bridge

Table E.4: Live load models to be considered

Parameter Value Notes

Spread through ballast
(longitudinal)

150 4:1 from UIC 774-2R / EN 1991-2

Spread through ballast (transverse) 150 4:1 from UIC 774-2R / EN 1991-2

Spread through fill (transverse) 300

Fill dispersion model (longitudinal)
Boussinesq
(with 300

cutoff)

Table E.5: Live load dispersion parameters

Parameter Value Notes

Masonry strength 2.5

Masonry friction 1.0

Masonry unit weight 0.95 (A) Also check with 1.35 (B)

Fill unit weight 0.95 (A) Also check with 1.2 (B)

Ballast unit weight 0.95 (A) Also check with 1.2 (B)

Track load 0.95 (A) Also check with 1.2 (B)

Axle load 1.0

Dynamic 1.0

Table E.6: Partial factors

E.1.3 Analysis results

Analysis 1: Partial factors ‘A’, reducing dead load effects

Computed ULS adequacy factor = 2.44 (axles spaced between 3200 and 8000mm from the left
springing). The associated failure mechanism involves four hinges:
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Figure E.2: Example 1: four hinge failure mechanism

Analysis 2: Mortar loss and partial factors ‘A’, reducing dead load effects

Computed ULS adequacy factor = 2.44 (axles spaced between 3200 and 8000mm from the left
springing) i.e. 30mm mortar loss near the springings (bottom two mortar joints) does not affect the
computed load-carrying capacity.

Analysis 3: Partial factors ‘B’, increasing dead load effects

Computed ULS adequacy factor = 2.98 (axles spaced between 3200 and 8000mm from the left
springing) i.e. this case is not critical.

E.1.4 Next steps

• Dynamic factors can now be applied to the computed adequacy factor as deemed appropriate.

• The validity of the assumptions made should, where possible, be verified e.g. the shape of the
arch should be verified as this can have an important influence on the computed load-carrying
capacity.

• If the computed load-carrying capacity proves to be insufficient then consideration should be
given to carrying out a more detailed investigation of the fill and/or backing (if present).
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E.2 Example 2 - Multi-span, multi-ring brickwork underline railway
bridge

E.2.1 Details

Bridge name: Case study example 22

Description: An initial LimitState:RING 4.0 assessment of a multi-span, multi-ring brickwork un-
derline railway arch bridge is described. The bridge spans squarely between abutments and piers and
currently carries two straight tracks. The eight semicircular spans are nominally identical.

The bridge was constructed using engineering bricks and lime mortar and is in a reasonably good
condition, with only isolated instances of loss of mortar from the joints and/or minor cracking. A
hammer survey indicated no evidence of ring separation.

Initial intrusive investigations have indicated that the bridge contains solid piers. However intrusive
investigations have not yet been undertaken to identify the extent / nature of any backing above the
piers (although photographs show staining of the brickwork below what seems likely to be the top
level of backing).

Load Model LM71 is used in this assessment.

Photographs:

Figure E.3: Photographs of Example 2 bridge

Commentary:

• This bridge will initially be analysed assuming that the rings forming the arch barrel are well

2This is a fictitious bridge, with details taken from several real bridges.
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bonded together; the influence of potential ring separation will then be considered to obtain a
more conservative estimate of bridge strength.

• When all arches in a viaduct have nominally identical geometry, modelling only the two spans on
either side of the tallest pier is generally sufficient for the purposes of a preliminary assessment.

• In the preliminary assessment, backing will conservatively be ignored (although parametric
studies have indicated that this could enhance carrying capacity by around 30%-40%).

E.2.2 Assessment data

Parameter Value Notes

Effective width 3930mm
Governed by the presence of longitu-
dinal cracks in arch barrel

Table E.7: General geometrical details

Parameter Value Notes

Span 13610mm

Rise 6780mm

Thickness 682.5mm Survey values

Depth of fill & ballast below the
underside of the sleepers above the
crown

1217.5mm

Intrados shape Segmental
First approximation in the absence of
a comprehensive dimensional survey

Number of units per ring 80 Large number to increase precision

Number of rings 1 or 6 6 rings in practice

Table E.8: Bridge geometry: span 1

Parameter Value Notes

Height 6170mm

Width (top) 2035mm Survey values

Width (bottom) 2850mm

Number of units in pier 20

Table E.9: Bridge geometry: pier between span 1 and 2
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Parameter Value Notes

Span 13610mm

Rise 6780mm

Thickness 682.5mm Measured values

Depth of fill & ballast below the
underside of the sleepers above the
crown

1217.5mm

Intrados shape Segmental
First approximation in the absence of
a comprehensive dimensional survey

Number of units per ring 80 Large number to increase precision

Number of rings 1 or 6 6 rings in practice

Table E.10: Bridge geometry: span 2

Parameter Value Notes

Depth of ballast below sleeper 300mm Estimated value

Sleeper breadth 250mm Standard width

Sleeper length 2400mm

Table E.11: Track geometry

Parameter Value Notes

Unit weight (masonry) 20kN/m3 Estimated value (engineering bricks)

Coefficient of friction (radial) 0.6 Typical value

Coefficient of friction (tangential) 0.5
Typical for degraded mortar (Bolton
laboratory tests measured value)

Crushing strength (masonry) 15N/mm2 Estimated value (engineering bricks
with thin joints < 8mm)

Unit weight (backfill) 21kN/m3 Estimated value (most of fill actually
brickwork backing)

Angle of friction (backfill) 300 Default value

Cohesion (backfill) 0kN/m2 Default value

Unit weight (ballast) 18kN/m3 Estimated value

Track weight (incl. sleepers, rails and
ballast between sleepers)

1.90kN/m2
7.45kN/m length, taken from
NR/GN/CIV/025 (assuming BH rail
and timber sleepers)

Table E.12: Material properties (characteristic values)
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Parameter Value Notes

Load model name
LM71 (no
udl)

Distributed part of this load model ig-
nored initially, but depending on ob-
served failure mechanisms it may be
necessary to include this later

Table E.13: Live load models to be considered

Parameter Value Notes

Spread through ballast
(longitudinal)

150 4:1 from UIC 774-2R / EN 1991-2

Spread through ballast (transverse) 150
4:1 from UIC 774-2R / EN 1991-2
(not used)

Spread through fill (transverse) 300 (not used)

Fill dispersion model (longitudinal)
Boussinesq
(with 300

cutoff)

Table E.14: Live load dispersion parameters

Parameter Value Notes

Masonry strength 2.5

Masonry friction 1.0

Masonry unit weight 1.35 (A) Also check with 0.95 (B)

Fill unit weight 1.2 (A) Also check with 0.95 (B)

Ballast unit weight 1.2 (A) Also check with 0.95 (B)

Track load 1.2 (A) Also check with 0.95 (B)

Axle load 1.0

Dynamic load 1.0

Table E.15: Partial factors

E.2.3 Analysis results

Analysis 1: Partial factors ‘A’, reducing dead load effects

Computed ULS adequacy factor = 3.84 (axles spaced between 21200 and 26000mm from the far left
springing). The associated failure mechanism involves both spans but not the intermediate pier:
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Figure E.4: Example 2: two span failure mechanism

Analysis 2: Partial factors ‘B’, reducing dead load effects and including separated rings

Computed ULS adequacy factor = 1.11 (axles spaced between 3364 and 8164mm from the far left
springing). The associated failure mechanism involves both spans (note the smooth deformed shapes
of the two arches). The intermediate pier is not involved in the mechanism:

Figure E.5: Example 2: two span failure mechanism (multi-ring)

E.2.4 Next steps

• Clearly there is a very large gap between the computed failure loads arising from Analysis
1 and Analysis 2. Whilst the real failure load is likely to lie somewhere in between, this is,
in practice, difficult to accurately determine (the assessment engineer may wish also to try
including different amounts of ring separation in the analysis).

• Consideration should be given to including backing (or stronger fill material) in the analysis; this
may help to compensate for the damaging effects of ring separation. The presence or otherwise
of this backing material should preferably be later verified by carrying out appropriate intrusive
investigations.

• Additionally:

– Dynamic factors can be applied to the computed adequacy factor as deemed appropriate.
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– Checks can be undertaken to ensure that different partial factors (increasing dead load
effects) are not more onerous.

– LM71 should be applied with the addition of a user-specified length of distributed load.

– For simplicity, the adequacy factor has been calculated using the loading position found to
be critical in the previous (single-ring) analysis. Additional analyses should be performed
to ensure the critical loading position has not changed.
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Appendix F

Worked examples - Reinforcement

(Note that in these examples, the hand-calculated values are very slightly different to those obtained
using the software due to the requirement in the software to include a very small (1mm) camber.)

F.1 Case 1 - All reinforcement in full tension

In this example, the depth of concrete crushing remains entirely in the area above the top reinforce-
ment, therefore both top and bottom reinforcement are in full tension at failure.

The beam properties are in Table F.1:

Property Value
Block size 250mm x 1000mm (bridge width)

Beam span 5000mm - 100mm (block width) = 4900mm

Applied force 1kN @ span/2

Top reinforcement 100kN @ 50mm from top surface

Bottom reinforcement 100kN @ 50mm from bottom surface

Concrete crushing strength 5 × 10−3kN/mm2

Table F.1: Reinforced beam worked example ‘Case 1’ properties

Figure F.1: Reinforced beam dimensions - Case 1
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Applied moment

Applied Moment = Applied force x Span
4 = 1 x 4900

4 = 1225kNmm

Initial assumed concrete force

Concrete force = 2 x 100 = 200kN

Concrete crushing depth

Concrete crushing depth = Concrete force / Bridge width / Concrete crushing strength

Concrete crushing depth = (200 / 1000) / (5 × 10−3) = 40mm

Hence, the assumption that both the top and bottom reinforcement steel are in full tension is correct.

Moment capacity

Figure F.2: Reinforced beam stress block - Case 1

Taking moments about centre of compression block (@ depth = 20mm):

Moment capacity = (30 x 100) + (180 x 100) = 21000kNmm

Adequacy factor

AF = Moment capacity / Applied moment = 21000 / 1225 = 17.1429

LimitState:RING 4.0 calculated adequacy factor

AF = 17.1 (to 3 significant figures)
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F.2 Case 2 - Bottom reinforcement in full tension, top reinforcement
in partial tension

In this example, the bottom reinforcement is in full tension and the top reinforcement carries a tensile
force that must be determined.

The beam properties are shown in Table F.2:

Property Value
Block size 250mm x 1000mm (bridge width)

Beam span 5000mm - 100mm (block width) = 4900mm

Applied force 1kN @ span/2

Top reinforcement 200kN @ 50mm from top surface

Bottom reinforcement 200kN @ 50mm from bottom surface

Concrete crushing strength 5 × 10−3kN/mm2

Table F.2: Reinforced beam worked example ‘Case 2’ properties

Figure F.3: Reinforced beam dimensions - Case 2

Applied moment

Applied Moment = Applied force x Span
4 = 1 x 4900

4 = 1225kNmm

Initial assumed concrete force

Concrete force = 2 x 200 = 400kN

Concrete crushing depth

Concrete crushing depth = Concrete force / Bridge width / Concrete crushing strength

Concrete crushing depth = (400 / 1000) / (5 × 10−3) = 80mm

Hence, the crushing depth is apparently greater than the depth to the top reinforcement bar, which
is clearly incorrect. To determine the force in the top bar and calculate the moment capacity of the
section, the force in the concrete and the steel must be calculated:

Revised assumed concrete force
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Concrete force = 50 x 1000 x 5 × 10−3 = 250kN

Top steel reinforcement force

Top steel force = 250 - 200 = 50kN

Hence both reinforcement bars are in tension, but the top bar is not fully yielding.

Moment capacity

Figure F.4: Reinforced beam stress block - Case 2

Taking moments about centre of compression block (@ depth = 25mm):

Moment capacity = (25 x 50) + (175 x 200) = 36250kNmm

Adequacy factor

AF = Moment capacity / Applied moment = 36250 / 1225 = 29.5918

LimitState:RING 4.0 calculated adequacy factor

AF = 29.6 (to 3 significant figures)
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F.3 Case 3 - Bottom reinforcement in full tension, top reinforcement
in full compression

In this example, the concrete crushes to a depth below the top reinforcement, with both bars fully
stressed (the top bar being in full compression and the bottom bar in full tension). The beam
properties are given in Table F.3:

Property Value
Block size 250mm x 1000mm (bridge width)

Beam span 5000mm - 100mm (block width) = 4900mm

Applied force 1kN @ span/2

Top reinforcement 100kN @ 50mm from top surface

Bottom reinforcement 400kN @ 50mm from bottom surface

Concrete crushing strength 5 × 10−3kN/mm2

Table F.3: Reinforced beam worked example ‘Case 2’ properties

Figure F.5: Reinforced beam dimensions - Case 3

Applied moment

Applied Moment = Applied force x Span
4 = 1 x 4900

4 = 1225kNmm

Initial assumed concrete force

Concrete force = 400 - 100 = 300kN

Concrete crushing depth

Concrete crushing depth = Concrete force / Bridge width / Concrete crushing strength

Concrete crushing depth = (300 / 1000) / (5 × 10−3) = 60mm

Hence, the crushing depth is greater than the depth to the top reinforcement bar (i.e. bottom bar
in full tension and top bar in full compression).

Moment capacity
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Figure F.6: Reinforced beam stress block - Case 3

Taking moments about centre of compression block (@ depth =60mm):

Moment capacity = (170 x 400) + (20 x 100) = 66000kNmm

Adequacy factor

AF = Moment capacity / Applied moment = 66000 / 1225 = 53.8776

LimitState:RING 4.0 calculated adequacy factor

AF = 53.9 (to 3 significant figures)
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Validation against bridge test results

G.1 Bolton laboratory tests (full-scale)

At Bolton Institute, UK, in the early 1990s, a number of 3m and 5m span bridges were tested in the
laboratory. Two of the bridges tested are shown on Figure G.1, Figure G.2, Figure G.3, and Figure
G.4. A key advantage of these tests over those carried out in the field (e.g. see Section G.4) was
that the internal constructional details and material properties were known.

LimitState:RING was originally developed to assist with the interpretation of the results from these
laboratory tests. Since the original publication of the work in The Structural Engineer (Melbourne &
Gilbert 1995, Melbourne et al. 1997, Gilbert & Melbourne 1994) the program has been significantly
enhanced and, for example, now accounts for material crushing around hinges and includes more
realistic models of the dispersion of the applied load through the backfill.

Figure G.1: Bolton bridge 5-2 containing debonded rings approaching collapse (note the diffused
hinges under the load)
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Figure G.2: Bolton bridge ‘Multi-2’ built with detached spandrel walls awaiting testing

Figure G.3: Bolton bridge ‘Multi-2’ approaching collapse (note that the left and centre spans are
involved in the failure mechanism)

Figure G.4: Bolton bridge ‘Multi-2’ immediately following collapse (note that the right span has
remained fully intact)
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LimitState:RING 4.0 analysis (kN)

Bridge Description

E
xp

er
im

en
ta

l
co

lla
p

se
lo

a
d

(k
N

)

(A)
Default soil

properties except

using measured

unit weight

(B)
As (A) but using

measured angle of

soil friction (60◦)

RING (B) /
experiment

3-1
3m single

span
540 264 442 82%

5-1
5m single

span
1720a 1178 1915 111%a

5-2

5m single
span;

debonded
arch rings

500 253 400 80%

Multi-2
3m triple

span
320 202 320 100%

a The experimental collapse load of this bridge was reduced by the sudden onset of partial ring
separation

Table G.1: Sample comparison between Bolton laboratory and LimitState:RING 4.0 collapse loads

Table G.1 presents LimitState:RING 4.0 analysis results alongside experimental test results from
Bolton Institute (representative bridges with detached spandrel walls are included since these behave
demonstrably in a two dimensional manner). To obtain the LimitState:RING 4.0 results, measured
geometrical and unit weight properties were used together with a measured angle of friction of the
soil backfill of 60◦. (The backfill was purely frictional so zero cohesion was specified.) The computed
failure load was found to be relatively insensitive to crushing strength so a value of 20N/mm2 was
used in all cases (experimentally recorded values for the brickwork used to construct the bridges
ranged from 18.1 to 28.2N/mm2).

It is clear from Table G.1 that predictions are quite conservative when the default soil angle of friction
is used (column A), but become much more realistic when the measured value is used (column B1).

It should be noted that the over-prediction of the strength of bridge 5-1 results from the sudden
onset of partial ring separation in the experimental load test. This is a quasi-brittle and unpredictable
phenomenon2 that cannot be modelled directly using LimitState:RING, although the program can
be used to try to bound the load-carrying capacity from above (by modelling the barrel as a voussoir
arch) and from below (by modelling the barrel as a series of separate arch rings).

The LimitState:RING 4.0 data files corresponding to the aforementioned analyses are distributed
with the software. These are located in the ‘Example files’ subdirectory e.g.:

C:\Program Files\LimitState\RING4.0\Example files.

1Note that the predictions in column B differ from those given in the RING 1.5 Theory and Modelling Guide
principally because in the latter case a 45◦ cutoff angle for the Boussinesq load distribution model was specified,
whereas the default value of 30◦ was used here.

2In fact, a nominally identical bridge (bridge 5-3) tested subsequently failed at an even lower load of 1000kN, with
failure again initiated by the onset of ring separation.
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G.2 Sheffield laboratory tests (small-scale)

A series of small-scale tests were performed at the University of Sheffield to confirm the relative
importance of passive restraint effects (i.e. as parts of the arch barrel remote from the load sway
into the fill) and live load dispersion effects (i.e. as the live load spreads through the fill).

In these tests, the load could be either applied to the surface of the fill or optionally, directly onto
the arch barrel. Also, to allow fill to optionally be placed only on one side, a keystone of extended
height was used. Finally, the fill on the passive side could optionally be contained on either side of
the three-quarter point hinge so as to act as a vertical dead load only. Further details of the tests
are provided elsewhere (Callaway et al. 2012).

Experimental and LimitState:RING results are summarized in Table G.2. In the LimitState:RING
analyses, measured geometrical and unit weight properties were used. The measured angle of soil
friction was also used. Passive restraint, vertical dead weight over a half span and distribution of the
load were switched off in line with the circumstances of the particular test arch being modelled.

It is evident from Table G.2 that the LimitState:RING predictions are remarkably good (all within
10% of the experimental results). This verifies that the simplified LimitState:RING soil model is
capable of capturing the key effects of backfill.
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Table G.2: Results from load spread / passive restraint separation tests

G.3 Salford laboratory tests (full-scale)

To better establish the nature of the soil-arch interaction that takes place, a series of bridges have
recently been tested at the University of Salford, UK. The model bridges tested to date have been
3m in span and have been housed in a large, 8.3m long × 2.1m high extremely stiff test chamber,
incorporating large frictionless observation windows along one face to permit measurement of the
soil and arch movements. (Figure G.5 shows vectors of soil displacements in the case of Bridge 1.)
Further details are available elsewhere (Gilbert et al. 2007).
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LimitState:RING 4.0 analysis (kN)

Bridge Description

E
xp

er
im

en
ta

l
co

lla
p

se
lo

a
d

(k
N

)

(A)
Default soil

properties except

using measured

unit weight

(B)
As (A) but also

using measured

soil properties

RING (B) /
experiment

1

3m single
span -

limestone
fill

126 83.7 122 97%

2
3m single

span - clay
fill

92 95.5 95.5 104%

Table G.3: Sample comparison between Salford laboratory and LimitState:RING 4.0 collapse loads

Figure G.5: Bridge 1: arch and backfill remote from the load, also showing soil displacement vectors

For the LimitState:RING 4.0 analyses, measured geometry and unit weight properties were used
initially (for sake of simplicity, the soil unit weight for Bridge 2, which was clay filled with a limestone
capping layer, was taken as the mean of the limestone and clay unit weights). For Bridge 1, the angle
of friction of the soil was taken as 54.5◦ (the measured value). For Bridge 2, a cohesive strength of
78kPa was used (the measured value). Finally, the masonry crushing strength was taken as 25MPa,
which is representative of that found for the type of brickwork used. Experimental and analysis
results are provided in Table G.3. It is clear from Table G.3 that when the measured soil strength
parameters are used (column (B)), LimitState:RING 4.0 provides a close prediction of load-carrying
capacity.
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G.4 Field bridge tests

In the late 1980s and early 1990s, the Transport and Road Research Laboratory (TRRL, now TRL)
in the UK carried out a series of load tests to collapse on redundant arch bridges. Most bridges failed
in four hinge mechanisms, although some of the bridges were reported as failing by ‘three hinge
snap through’ or in ‘compression’ (material failure). It was likely that many of the bridges tested
were restrained considerably by their attached spandrel walls and / or masonry backing. Outline
information on these bridge tests has been provided by (Page 1993).

With the benefit of hindsight, significantly more pre- and post-test investigation work should have
been performed to better characterize the internal construction details and material properties. This
would have been useful in providing a more comprehensive data set for use by analysts who have
since attempted to model the behaviour of the bridges under load.

In 2001, TRL were commissioned to independently validate ‘RING’ (the predecessor to Limit-
State:RING 4.0) and other available masonry arch bridge analysis software. Despite the uncertainties
outlined above, as part of the validation process it was decided that the programs would be used to
predict the carrying capacities of 5 of the field bridges load tested more than a decade previously.
Details taken from the TRL report (Macfarlane & Ricketts 2001) relating to ‘RING’ are provided in
Table G.4:

Bridgea Theoretical / experimental collapse load

Torksey 81%

Bridgemill 100%

Barlae 92%

Preston 90%

a Strathmashie bridge was also modelled but was in poor condition,

and because ‘none of [the] defects were modelled during the anal-

ysis, all the programs returned non-conservative results’.

Table G.4: Correlation between TRL field bridge test and
RING collapse loads (independently produced by TRL)

It is evident that agreement between the RING predictions and the full-scale test results was found
to be reasonably good. The TRL report concluded that RING:

“gives good results”

and

“with some investment in an improved solver, [RING] would be a very effective tool for
most assessment engineers”

The concern about the speed of the solver was addressed following the release of newer versions of
RING that were up to 200x faster than RING 1.1, which was used in the 2001 TRL report.
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G.5 Validation of the reinforcement model

A variety of checks have been undertaken to verify output from LimitState:RING 4.0 in respect to
the reinforcement model:

• To demonstrate that the software provides the same solutions as would be calculated by hand,
a number of simple reinforced beam worked examples are included in Appendix F.

• The software has also been applied to a number of reinforced arch problems. Unfortunately,
much of the data available in the literature appears to be incomplete or coloured by indetermi-
nate factors, making accurate correlation difficult. Nevertheless, details of the validation work
that has been undertaken are provided below.

G.5.1 Bradford arches

(Chen 2004) and (Chen et al. 2007) describe details of four tests performed on 2m span arch ribs
(two reinforced and two unreinforced). Full details of the arches and reinforcement were available
and these were used in LimitState:RING 4.0 to predict load-carrying capacities (for simplicity, in all
cases the masonry crushing strength was taken as 4.2N/mm2, the value measured in the case of two
of the four tests).

Test load (kN) LimitState:RING 4.0 prediction (kN)

Unreinforced arches (x2) 1.4, 4.0 1.83

Reinforced arches (x2) 15.4, 18.4 21.1A, 13.5B

Table G.5: Validation of LimitState:RING 4.0 results against Bradford 2m arch tests (after Chen
2004).

It is evident from Table G.5 that the results of the arch tests were quite variable (despite the
two unreinforced and reinforced arches supposedly being identical). It is also clear that when full
continuity of reinforcement at the supports is assumed in the analysis, the LimitState:RING 4.0
predictions are non-conservative. However, it appears that the structure supporting these arches
may have been overly-flexible, potentially colouring the test results (e.g. no hinge crack was ever
identified at the springing remote from the load in the case of one of the two reinforced arches).
For this reason, a further analysis was performed assuming no continuity of reinforcement at the
supports; this successfully bounded from below the two reinforced arch test loads.

(Details of other Bradford arch bridges are available but these used mortar-bonded, multi-ring brick-
work arch barrels, which typically failed abruptly due to the onset of partial ring separation (a brittle
and highly unpredictable phenomenon). This makes them unsuitable for the present verification
study.)

G.5.2 TRL laboratory bridge tests

A number of reinforced brickwork arch bridges have been constructed and tested in the laboratory
by TRL (Sumon 2005). The first 5m span ‘benchmark’ bridge comprised three debonded brickwork
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rings and granular soil fill material. The bridge failed at a load of 200kN.

Unfortunately, some essential details of this bridge were either not made available, or are uncertain.
For example, the angle of friction of the soil fill material is quoted at 40◦, from ‘manufacturer
literature’, but in fact, this value will depend on the site compaction used. The strength of this
bridge is also likely to have been increased by test chamber side-wall friction, and by the confined
nature of the arch fill. For these reasons the values of two of the parameters controlling soil-arch
interaction were adjusted in order to give better agreement between the predicted and experimental
results (Table G.6). The remaining input parameters were taken from (Sumon 2005) or (Chen 2004)
(this includes the inter-ring friction value of 1.0 quoted by Chen, the origin of which is unclear and
which appears rather high).

Parameter Value Comments

Fill angle of friction 60◦ Measured value in Bolton arch bridge tests

Max angle of dispersion of live loads 45◦

Table G.6: Soil-arch interaction parameter values used in TRL tests (others taken from Chen 2004,
Sumon 2005)

The bridge was subsequently retro-reinforced using the ‘MARS’ proprietary system, which involves
inserting bars in slots formed in the intrados. The reinforcement comprised 622mm2 steel positioned
19mm from the surface and with a yield strength of 480N/mm2 (Yi, 2004). The bridge was then
re-tested, and reached an estimated failure load of 320kN (a failure load of 276kN is also quoted by
(Sumon 2005), this apparently being the load at which displacement gauges were removed).

The bridge was analysed both before and after retrofitting. The values of all parameters used in
the two analyses were identical, except that a steel rebar force of 149.3kN per metre width was
entered for the retrofitted analysis (149.3 = 622 x 480 / 2000). It is evident from Table G.7
that the enhancement to the arch strength provided by the steel appears to be well predicted by
LimitState:RING 4.0. The predicted failure mechanism of the reinforced arch is shown in Figure G.6:

(A number of other reinforced arch bridges were tested by TRL, but these contained radial pins,
which is beyond the scope of this study.)

Test load (kN) LimitState:RING 4.0 prediction (kN)

Arch 1 - Unreinforced benchmark 200 198

Arch 1 - Post-retro-reinforcement 320 325

Table G.7: Validation of LimitState:RING 4.0 results against TRL arch tests (after Chen 2004, Sumon
2005)
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Figure G.6: Predicted LimitState:RING 4.0 failure mechanism of retro-reinforced TRL arch bridge
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Appendix H

Comparison with previous versions

H.1 Version history

Table H.1 shows the main versions of the software that have existed since its original inception in
1992:

Version (Operating system)
Release
year

Publicly
avail-
able?

Comments

RING (DOS) 1992 No
Original research version, programmed in Quick-
BASIC. Output published in three papers ap-
pearing in The Structural Engineer, 1994-97.

RING 1.0 (Win32) 1999 No

Windows user interface added to original DOS
version (program converted to Visual Basic).
Boussinesq distribution model, multiple axle
loads & user-defined arch profile capabilities
added.

RING 1.1 (Win32) 2001 Yes Backfill elements added.

RING 1.5 (Win32) 2004 Yes

Limit analysis kernel re-programmed in C++ and
linked to existing Visual Basic user interface.
More efficient solution of multi-ring arch prob-
lems.

LimitState:RING 2.0 (Win32) 2007 Yes
Entire program re-written from scratch in C++.
Numerous features added.

LimitState:RING 3.0 (Win32) 2011 Yes

Arch profile entry updated to include new types,
including interpolated spline fit. Solver up-
graded. Improved user interface implemented.
Reinforcement and moment / force diagrams
made available.

LimitState:RING 3.1 (Win32/64) 2014 Yes
Up to 70 percent increase in solve speed when
solving multiple load case problems. Also re-
duced memory footprint.

LimitState:RING 3.2 (Win32/64) 2016 Yes
Auto-select solver feature added. Also allow user
to specify backing strength.

LimitState:RING 4.0 (Win64/Mac) 2023 Yes

Switch to using new codebase, adding many
new features, including PLS mode, CAD import,
bridge template file and command line function-
ality. Also adequacy factor plot and diagnostic
messaging. Mac version made available.

Table H.1: LimitState:RING version history
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H.2 Comparison of results between versions

As part of the validation process for LimitState:RING 4.0, solutions for a number of benchmark
problems have been compared with those from LimitState:RING 2.0 and RING 1.5. Sample results
are shown on Table H.2.

Results from LimitState:RING versions 2.0 - 4.0 are ostensibly identical, and are also mostly very
similar to results from RING 1.5. Where the difference in results exceeds 0.5%, the reason for this is
indicated.

The input files, which are used as validation tests, can be obtained from the LimitState website:
limitstate.com/files/ringInputFiles.zip.
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Table H.2: Benchmark problems: comparison of results using different versions of LimitState:RING
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‘Auto-compute’ function, 110
3D view

perspective view, 179

abort analysis, 198
abutments, 73, 114

default model, 114
modelling explicitly, 114

adequacy factor, 53, 93, 197, 199
adequacy factor chart, 93
analysis, 191

abort, 198
iterative, 196
normal, 196
results, 197

analysis methods, 50
arch shape, 69

interpolated, 117
multi segment, 117
pointed, 117
segmental, 117
three-centered, 117
user defined profile, 117

arch type, 117
attributes

modifying, 169
auto-solve, 195
axle lift-off, 87

backfill, 61, 73, 171
active pressure, 138, 233
adhesion multiplier, 138
advanced properties, 136
angle of friction, 135
auto-identify horizontal pressures, 141
boussinesq distribution, 61, 136, 231
cohesion, 135
friction multiplier, 137
horizontal pressure, 136
interface properties, 137
limiting horizontal stress, 232
load distribution, 135, 136

mpc factor, 140
passive pressure, 138, 171, 233
spandrel zones, 138
spandrels at PLS, 141
spandrels at ULS, 139, 140
standard properties, 134
uniform distribution, 61, 137
unit weight, 134

backing, 64, 73, 135
bending moment, 203
blocks, 172
boussinesq distribution, 61, 136, 231
braking forces, 85, 87
bridge

DXF geometry, 123
geometry, 113, 123

bridge defects, 75
bridge type, 110

centrifugal effects, 85, 87
chart, 199
collapse load factor, 197
command line interface

batch file, 207
contact select tool, 166
contacts, 173

reinforcement, 165
context menu, 186

explorer, 188
property editor, 187
toolbar, 187
viewer pane, 186

copy and paste, 175
cracking, 78
cracks, 89
crushing, 222

decompressing files, 215
defects, 75
deleting a span, 118
diagrams, 202
direction override, 213
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dispersion, see distribution
display

mouse, 177
options, 177
scrollbars, 177
scrolling wheels, 177

distribution
boussinesq, 136
longitudinal, 82
transverse, 83, 86
uniform, 137

DXF, 123
DXF geometry, 123, 124
dynamic axle override, 213
dynamic effects, 83, 87

effective width, 83, 86, 110
explorers, 174

block, 174
contact, 174
load case, 174
vehicle, 174

file output, 208
fill element, 171
fill force, 172
fill profile, 120
flooding, 79
forces

blocks, 156

general project settings, 29
geometry, 29, 113, 123

DXF, 123, 124
import, 123

geometry dialog, 113
abutments, 114
arch type, 117
default pier model, 119
deleting a span, 118
fill profile, 120
inserting a span, 118
masonry units, 117
piers, 118, 119
ring thickness, 118
spans, 116
uneven springing heights, 120

graphical interface, 99
menu bars, 100
output pane, 103
property editor, 102
title bar, 100

toolbars, 100
viewer pane, 101

highway
loading, 85

hinges, 173

infill, 73
inserting a span, 118
intermediate supports, 90
internal forces, 96
interpolated, 117

joint equilibrium formulation, 221
support movement, 222

language, 177
limiting force, 171
live load dispersion, 61
load

dispersion, 136
distribution, 136, 137

load cases
adding vehicles, 150

load factor, 197
load paths, 89
load spreading, 61, 81
load vehicles, 36
loading, 81, 85, 145

adding vehicles, 146
defining vehicles, 149
defining vehicles from file, 147
deleting vehicles, 150
dynamic, 152
editing vehicles, 149
exporting vehicles, 150
highway, 85
importing vehicles, 147
load cases, 150
mirror, 149
railway, 81
renaming vehicles, 150

loading models
highway, 247
railway, 259

longitudinal distribution, 82

masonry, 73
abutments, 132
crushing, 132, 222
offsets, 132
piers, 132
sliding, 133
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unit weight, 132
masonry crushing, 59
masonry strength, 59
masonry units, 117
material properties

backfill, 134, 136
backing, 135
masonry, 132
soil, 134
surface fill, 142

material properties override, 214
materials, 34

properties, 131
menu

analysis, 184
edit, 181
file, 180
help, 185
select, 181
tools, 183
view, 182

menus, 180
missing mortar, 75
mode of response, 95
mortar

missing, 75
mortar loss, 173
Mosek, 197
multi segment, 117
multi-span bridges, 72

new bridge wizard, 27
general project settings, 29
geometry, 29
load vehicles, 36
materials, 34
partial factors, 33
post-solve, 41
pre-solve, 39
solve, 40

no solution found, 197
normal force, 203
nosing, 85

object keys, 216
on-screen output, 208
options syntax, 210
output

bending moments, 202
normal forces, 202
shear forces, 202

output pane, 103

output: file, 208
output: on-screen, 208
override: direction, 213
override: dynamic axle, 213
override: material properties, 214
override: partial factors, 214
override: position, 212
override: vehicle, 211

parameters, 69
partial factors, 33, 69, 129
partial factors override, 214
passive pressure, 171
passive restraint, 62
piers, 118

default model, 119
modelling explicitly, 119
uneven springing heights, 120

plot, 199
PLS analysis, 157, 158
pointed, 117
position override, 212
post analysis, 199
post-solve, 41
pre-solve, 39
preliminary assessments, 67
profile, 117
project details, 109
project properties, 216
project settings, 170
project types, 105

DXF, 107
template, 106
wizard, 105

property editor, 45, 102, 169

railway
loading, 81

range of applicability, 55
3D effects, 56
block shape, 55
collapse modes, 56
fill depth, 56
reinforcement, 57
spans, 55
stress related failures, 55

reinforcement, 57, 165, 174, 224
adding, 166
properties, 165

report, 205
footer, 206
header, 206
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template, 206
required details, 109

bridge type, 110
effective width, 110

response mode, 95
results, 93, 197
ring separation, 76
rings

number of, 116
thickness, 118

rotate cursors, 179
rotate tool, 178

scenarios
adding, 154
deleting, 154
drag and solve, 155
viewing, 155

segmental, 117
service loads, 89
shape, 69
skew bridges, 72
sliding, 173
sliding failure, 60
soil, see backfill, see surface fill
solution file, 210
solve, 40, 157, 191
solver, 191, 197

checks, 191
diagnostics tool, 191

spalling, 75
span

deleting, 118
inserting, 118

spans, 116
standard analysis, 157
support movement, 89, 161, 172

background, 161
joint equilibrium formulation, 222
wizard, 162

support movements, 53
surface fill

basic properties, 142
properties, 142
track properties, 143
unit weight, 142

three-centered, 117
thrust, 96
thrust line, 201
toolbars, 185

default, 185

optional, 186
track, 81
traction forces, 85, 87
transverse distribution, 83, 86

ULS analysis, 157
uniform distribution, 61, 137
unit weight

backfill, 134
masonry, 132
surface fill, 142

user defined profile, 117

validation, 281
reinforcement, 288

vehicle override, 211
vehicles

adding, 146
adding to a scenario, 150
copies, 151
defining, 149
defining from file, 147
deleting, 150
direction, 149, 152
editing, 149
exporting, 150
impact, 152
importing, 147
load type, 151
renaming, 150
spacing, 151
x position, 151

viewer pane, 178
rotating, 178

Viewpoints, 179

water, 79
width

effective, 110
wizard, 27

support movement, 162
worked examples, 226, 263, 275

zone of thrust, 96
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